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1 Introduction 
S-PLUS is a powerful, extendible, environment for data analysis and graphics. The 
“Standard Version” of S-PLUS provides access to the S-PLUS functionality through a 
point-and-click GUI. The “Professional Version” of S-PLUS includes, in addition, access 
to the S-PLUS command line and the capability to develop extensions to S-PLUS. 
Extensions to S-PLUS may also include additions to the S-PLUS GUI (and this is the 
way that the SPLIDA GUI was developed).  

SPLIDA is a collection of S-PLUS extensions (both commands and GUI) for planning 
and analyzing the data from  some reliability studies (e.g., laboratory life tests, 
accelerated life tests, warranty repair data, and other field data). SPLIDA has capabilities 
for the analysis of censored life data, as well as repeated measures degradation data, 
destructive degradation data, and recurrence data. 

Most SPLIDA capabilities are available through the SPLIDA GUI (extensions to the S-
PLUS GUI).  Thus, SPLIDA can be used with either the Standard or the Professional 
versions of S-PLUS (but advanced users with the professional version have access to 
additional functionality and the ability to make further extensions to SPLIDA/S-PLUS).  

As an example, Figure 1 is a schematic diagram illustrating the steps that a user would 
follow in the analysis of a data set.  

 

Figure 1 Schematic diagram of the SPLIDA GUI 
An analysis starts with a data set, usually imported from an Excel file.  This is read into 
S-PLUS/SPLIDA, and used to create a data object. The data object can then be 
conveniently analyzed in many different ways to create various graphical and tabular 
outputs. There is an extensive set of user options to control the analyses and outputs. 
Whenever it is possible, these choices have sensible defaults to reduce the amount of 
effort that is needed to do a sequence of analyses. SPLIDA dialogs have been designed 
carefully to guide users through an analysis. 
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The main part of this document uses a sequence of examples to describe and illustrate the 
SPLIDA graphical user interface (GUI) for data analysis for many different kinds of data 
and statistical models. A similar sequence of examples is used to illustrate the 
corresponding test planning methods. The methods and analyses parallel closely the 
methods and examples used in Meeker and Escobar (1998). There are, however, new 
methods in SPLIDA, described here, that are not available in that book.  The items in the 
SPLIDA menu correspond approximately to the chapters in the Meeker and Escobar 
(1998) textbook.   

The Appendix contains an outline of the SPLIDA menu structure. 

There appears to be a non-serious bug in the S-PLUS GUI that causes the “white” part 
of a multi-select dialog from a back page of a dialog to appear sporadically when a 
dialog first appears. By paging across the different pages in the dialog, this will fix itself 
without further difficulty. 

2 Getting Started with SPLIDA 
All SPLIDA data analyses require a data object. Life data analyses use a SPLIDA “life 
data object.” A life data object contains, for a given data set, available information about 
failure times (e.g., failure times, running times, intervals in which failures are known to 
have occurred, etc.), time units (e.g., hours or days), explanatory variables (if any), and a 
data-set title. Having all of this information in a life data object makes it much easier to 
do various analyses on a particular data set. There are similar (but different) kinds of data 
objects for recurrence data analysis and for degradation data analysis, as described in 
subsequent sections of this document. 

2.1 Example data sets and a simple example  
For convenience of illustrating features of SPLIDA and for purposes of teaching courses, 
SPLIDA has a large number of built-in data objects. Data objects are included for most of 
the examples and many of the exercises in Meeker and Escobar (1998).  The appendix 
contains an index of and references for the original sources for these data sets. 

To see how easy it is to do an analysis with SPLIDA, click SPLIDA ► Single 
distribution analysis ► Probability plot with nonparametric confidence bands, to 
bring the dialog in Figure 2. Choose from the list of SPLIDA life data objects (e.g., 
BearingCage.ld, for the Bearing Cage data from Abernathy et al. 1983, also 
analyzed in Example 8.16 of Meeker and Escobar, 1998). Now choose a distribution 
(e.g., Weibull), click “Apply” and a probability plot, like that in Figure 3, will appear in 
the graphics window. 
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Figure 2 Dialog to request a probability plot of the bearing cage data. 

 

 

Figure 3 Weibull probability plot of the bearing cage data. 

2.2 Inputting data directly into S-PLUS:  Creating a data set 
In order to analyze your own data, you first have to enter the data into S-PLUS and 
then create a SPLIDA life data object. It is easy to import from an existing file (e.g., 
and Excel file or a text file), as described in Section 2.4.  For a small data set, 
however, one can simply enter data directly to make a S-PLUS data set and then 
create a SPLIDA data object.  
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Here we use the titanium crack initiation times described in Problem 6.7 of Meeker and 
Escobar (1998). A sample of 100 specimens was tested until failure or 100 thousand 
cycles, whichever came first. Among these, there were nine crack initiations (failures). 
Choose Data ► Select Data. Then choose the “New Data” option in the dialog, enter a 
name for the data set (e.g. Prob6p7 for Problem 6.7), and click “OK.” A blank 
spreadsheet will appear. Type the failure times “18, 32,…, 93” into the first column.  In 
the second column, type the word “Failure” in each row. Then add a last row with time 
100 and the word “Censored.” We also need a column of “Weights” to indicate 
observation multiplicity. Put “1” in all rows except the last, where you should put “91” 
for the 91 censored units. The S-PLUS default names on the columns are V1, V2, and 
V3. You can use these, but it is better to change them to something more meaningful. 
Right-click on a column, choose properties, change the name, and click “OK”.  Repeat 
for other columns. After doing this, your spreadsheet (actually an S-PLUS data set) 
should look something like Figure 4. 

 

 

Figure 4 Worksheet for inputting or editing data by hand. 
Users can also easily import a data set from an Excel worksheet or from a text file (as 
shown later). 

Before doing life data analyses (e.g., when the response is time to failure) with SPLIDA, 
one needs to make a SPLIDA life data object (in effect, defining the purpose of the 
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columns in the data and adding other important information like a title and time units). 
Once constructed, the life data object can be analyzed using different SPLIDA methods 
(without having to re-specify all of the detail for each analysis). 

 

Note the distinction between S-PLUS data sets (like the one just created) and SPLIDA 
data objects (to be created from the S-PLUS data set in the next section). 

 

2.3 Creating a life data object 
A SPLIDA data object is constructed by choosing an S-PLUS data set containing the 
raw data, specifying which column is the response and, as needed or desired, 
specifying a title for the data, units of the response, and making other choices. Once a 
data object is created, the corresponding data can be analyzed repeatedly without 
having to repeat the often-complicated characteristics of the data. 

From the S-PLUS menu bar, choose SPLIDA ► Make/summary/view/edit data 
object ► Make life data object to bring up the dialog shown in Figure 5.  

 

 

Figure 5 Blank (initial) dialog for making a SPLIDA life data object. 

Clicking on the “Choose an S-PLUS data set” pull-down arrow will show S-PLUS data 
sets in the SPLIDA database and in your working database. Data sets for most of the 
examples in Meeker and Escobar (1998) and many other examples from the reliability 
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data analysis literature are included on the SPLIDA database. ASCII text data sets are 
also given in one of the SPLIDA folders (SPLIDA_text_data). Choose the data set 
Prob6p7 from the list. After one chooses a data set, SPLIDA will use the column names 
in that data set to make lists of variables for other  dialog inputs. Choose the response 
column (named “kcycles” in the Prob6p7 titanium crack initiation data set). Then choose 
the response (kcycles), the censoring indicator (Type), and weights (Count). Then click 
“Apply” (or “OK”).  In the commands or report window, you will get a brief summary of 
the data. 

The default name for the life data object is Prob6p7.ld. The Prob6p7 data set also has a 
“Count” column indicating observation multiplicity. The Prob6p7 data has no failure 
mode column, explanatory variables, or truncation. A note can be added to the life data 
object. There is no limit to the length of this note; the note is printed when a summary of 
the data object is printed.  

In order to simplify use, SPLIDA chooses, when possible, sensible defaults for inputs, 
but allows the user to easily change these if desired. The final dialog for mapping the 
Prob6p7 data set into a life data object Prob6p7.ld is shown in Figure 6.   
 

 

Figure 6 Dialog to make a life data object. 

Now when you launch the analysis dialog by using SPLIDA ► Single distribution 
analysis ► Probability plot with nonparametric confidence intervals  (see Figure 7) 
Prob6p7.ld will appear in the list of life data objects (actually, if it was just created, 
SPLIDA will remember it and chooses it as the default in this list). Now choose a 
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distribution (e.g., Weibull), click “Apply” and the probability plot shown in Figure 8 will 
come up in the graphics window.  

 

 

Figure 7 Dialog to request a probability plot of the titanium crack initiation data. 
 

 
Figure 8 Weibull probability plot of the titanium crack initiation data. 

In this and the other SPLIDA dialoges, there are other options on the “back” pages of the 
dialog, but we do not need to use them at this time. Generally, the required and 
frequently-used options are on the front page, with less frequently needed options on the 
back pages. In this documentation, the focus will be on the required and other most 
important inputs for SPLIDA. Users are encouraged to experiment with the options on 
the back pages. These options are, for the most part, self explanatory and, as much as 
possible, their operation is consistent across different SPLIDA dialogs. 
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2.4 Importing data from Excel and text files 
S-PLUS has powerful tools for importing rectangular data sets (in which rows are cases 
and columns are variables) into a data set.  For example, to import data from an Excel 
worksheet, into a data set, use the following: 

(a) From the S-PLUS File menu, choose Import Data ► From File...  This will 
bring up the “Import Data” dialog. 

(b) Under “File format:,”  select “Excel Worksheet (xl?).” 
(c) Choose the desired file, using the Browse feature to switch folders, if needed.  
(d) The name of the data set can be changed from the default name (aaaa if the Excel file 

is aaaa.xls). 
(e) Click “Apply” to import the file into the S-PLUS data set object.   
Importing from a text (or ASCII) file is similar, except that one needs to specify “.txt” 
files (or “All Files”), choose the appropriate column delimiters, and specify whether the 
first line in the file contains column names. 

See the S-PLUS documentation for more details and other options.  

2.5 Graphics options and color schemes in SPLIDA 
S-PLUS allows the user to have control over various graphics options.  Although it is not 
necessary for the beginner, frequent users of  S-PLUS or SPLIDA will want to become 
familiar with the available options.  Some modifications of the default options have been 
implemented in the .Prefs file that comes with SPLIDA. 

The default color scheme in SPLIDA has been changed from “Standard” to “Cyan 
Magenta.” This option provides a much better (sharper and less washed-out looking) set 
of colors for SPLIDA graphics.  The standard or other build-in options can be chosen 
with Options ► Graph Style► Color and changing the color option box.  

Another useful option is to use Options ► Graph Options and change “Graph Style” 
to black and white. The SPLIDA default for the black and white graph style (which 
differs from the S-PLUS default) uses just black on white, with no grey scales. The S-
PLUS standard black and white Graph option can be restored with Options ► Graph 
Styles ► Black and White Style. And choosing Standard under User 
Colors. 

Under Options ► Graph Options, the SPLIDA default for Auto Pages is “Every 
Page” so that new pages automatically are added to a graphsheet as new plots are created. 
This makes it easy to compare plots from different analyses. Delete unwanted pages by 
right-clicking on the page number to be deleted. 
 

2.6 Controling and locking SPLIDA plot axes   
 

Many Splida dialogs have a Modify plot axes page like the one shown in Figure 9. 
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Figure 9 A typical Modify plot axes page of a SPLIDA dialog 

This dialog allows the user take choose one of the four limits on the axes or to change the 
axis labels.  
Another SPLIDA feature allows the user to lock the axes of a sequence of similar plots. 
The locking is turned on by clicking on the  (for Lock) icon on the tool bar. To turn off 
locking, click on the  (for Unlock) icon. “Similar plots” are defined as plots that have 
identical  x scale axes , identical y scale axes (e.g., linear, log, or other transformation), 
and the same titles on both the x-axis and the y-axis. This feature is useful when you want 
to make direct comparisons between two or more plots and is much easier to do than the 
method of specifying the axis limits directly in the a Modify plot axes page. 
 

3 Changing SPLIDA Default Options 
 

Under certain circumstances, users may want to change SPLIDA defaults. Many defaults 
can be changed in individual dialogs (e.g. confidence levels in analysis routines). In 
addition, there is a special dialog for making global changes to certain defaults and 
controlling defaults cannot be controlled in individual dialogs. 

3.1 Basic, plot, and print SPLIDA options 
 

Using SPLIDA ► Change SPLIDA default options will bring up the dialog 
shown in Figure 10, allowing one to make global changes to the several of the SPLIDA 
defaults options. Changes are effected immediately after chosen on the dialog pages (no 
need to click on “OK” or “Apply”). Changes made when the “Save changes across 
sessions” box is checked remain in effect in future SPLIDA sessions. To restore all of the 
original SPLIDA defaults, click on the “Restore defaults” box. 
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Figure 10 Basic page of the dialog for changing SPLIDA operation defaults. 

The “Plot” page of the  SPLIDA options dialog, illustrated in Figure 11, allows the user 
to choose whether to date-stamp each plot (the default) or not. The “label or name on 
plot” option allows some personalization in which the user can insert a company or 
personal name on the plot. 

Figure 12 shows the “Print” page of the dialog, which allows changing the default 
number of digits used in SPLIDA tabular output, the default list of quantiles to be 
estimated, and an option to print out the variance-covariance matrix of ML estimates 
when such estimation is performed. 
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Figure 11 Plot page of the dialog for changing SPLIDA default options. 

 

 
Figure 12 Print option page of the dialog for changing SPLIDA operation defaults. 

3.2 SPLIDA data-type aliases 
SPLIDA maintains internal lists of names or aliases that can be used to identify 
“exact failures” and three different kinds of censored observations: right censored, 
left censored, and interval censored. These lists are used in creating a data object 
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when there is a “Status” or “Censoring” identifer column (e.g., used to differentiate 
between failures and censored observations). The default aliases for different kinds of 
observations are: 

• Exact failures: Fail, Failed, Failure, Dead, Died, Exact, E, F, Report,  or the 
number 1. 

• Right censored: Alive, Censored, Censor, C, Noreport, R-Censored, Removed, 
Right, R, S, Survived, Survive, Suspend, Suspended, Saturated, or the  number 2. 

• Left censored: L-Censored, Left, L, L-censored, left, Miss, or the number 3. 
• Interval censored: Bin, Interval, I, or the number 4. 
 
These aliases are not case sensitive (i.e., you can use “fail” or “Fail”). 
 

 

 

Figure 13 Dialog page allowing changes in the default aliases for observation 
identification. 

It is possible to add to or modify the default alias lists by using the “Censor ID” page of 
the “Make life data object” dialog when creating a particular data object. Alternatively, it 
is possible to make a persistent change (either for the current session or across sessions) 
by using the SPLIDA ► Change SPLIDA default options (preferences) menu  
item and going to the “Censor ID” page. In either case, the dialog page looks like Figure 
13. To edit an entry, check the “Change any censor ID strings” box and then right-click 
on the list to be changed and choose zoom, to allow easy editing.  

3.3 Other SPLIDA options 
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Figure 14 Misc page of the dialog for changing SPLIDA operation defaults. 

The “Misc” page, shown in Figure 14, allows the user to choose other options. In 
particular 

• Whether to include the regression relationship(s) as part of the name of ML 
estimation results objects (the choices are: always, never, and multiple regression 
only).  

• “Create pointing data objects” for which the main part of the data object is a 
character string giving the name of the data set to use. By default, the main part of 
the data object is the data set itself. Usually, the character string version will use 
less memory, but require more execution time. 

• Recreate the SPLIDA GUI. This is most useful when a new version of SPLIDA 
has been installed on your system, and for some reason, the automatic update 
feature did not work. Clicking the Recreate button will modify the S-PLUS Prefs 
directory in the current working folder. 

• Change the units for Boltzmann’s constant (or gas constant) used in the Arrhenius 
relationship. 

• Choose the level of checking for data that are sufficient to provide unique ML 
estimates. The decision rules used here are not perfect and are set, by default, to 
“strong.” If you get a message that your data were not sufficient, you can try a 
lower level of checking, but should watch the results carefully to make sure that 
proper convergence was achieved. 

• Generally, the debug level should be set to “off.” Otherwise, SPLIDA will print 
some level of extra information that is used only in debugging. 
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4 Single Distribution Life Data Analyses  
Analysis of data for the purpose of estimating a single underlying failure-time 
distribution is the most common type of reliability data analysis. This chapter describes 
methods for such analyses. Even when there are several different identifiable groups, it is 
often desired to focus on one group or another or (when appropriate) to pool data from 
different groups for analysis. Choosing SPLIDA ► Single distribution life data 
analyses shows the SPLIDA single distribution analysis options. For this series of 
examples, we will use the turbin fan failure data (based on the diesel generator fan failure 
data described on page 133 of Nelson 1982 and reanalyzed in Example 7.12 of Meeker 
and Escobar 1998) , for which a life data object Fan.ld, is built into SPLIDA. 
 
Figure 15 is a snapshot of the SPLIDA ► Single distribution life data analyses  
part of the SPLIDA menu. The SPLIDA menu items (shown on the left) correspond to 
different tasks/analyses (e.g., plan a life test, analyze single-distribution life test data, 
compare two different populations, etc.). The SPLIDA submenu items (shown on the 
right) are organized according to the order in which a complete analysis would be done, 
typically starting with simple graphical methods and then progressing to model fitting, 
graphical display of model-fitting results, and sensitivity analyses. 
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Figure 15 View of the SPLIDA menu showing the options for single distribution 
analyses. 

4.1 Event plot 
For some data sets, an event plot provides a useful visualization of censoring patterns in 
the data. Using SPLIDA ► Single distribution life data analyses ► Life data 
event plot brings up the dialog shown in Figure 16. 
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Figure 16 Dialog requesting a life data event plot for the fan data. 

After choosing the Fan.ld life data object from the pull-down list, click “Apply” or “OK” 
to see the event plot shown in Figure 17. Lines in Figure 17 ending in an * indicate 
failures. Lines with a →  at the end are units that had not failed at the time that the data 
were analyzed. The numbers indicate the observation multiplicity for those observations 
that have counts greater than one. In the case of the fan data, there is a complicated 
pattern of reported failure times and right-censored observations resulting from the 
different amounts of operating time for the systems in which the fans had been used. 
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Figure 17 Life data event plot for the fan data. 

4.2 Nonparametric estimation of the failure-time cdf 
Using SPLIDA ► Single distribution life data analyses ► Plot 
nonparametric estimate of cdf and confidence bands brings up the dialog in 
Figure 18.  
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Figure 18 Dialog for requesting a plot and table of the estimated fraction failing as a 
function of time. 

Then choose life data object Fan.ld  (the only required input), put a check in “Print 
table” and click  “Apply.”  This will produce a plot like that in Figure 19 and a table of 
the nonparametric estimate and confidence intervals for the fraction failing as a function 
of time. The estimates are computed using the Kaplan-Meier estimator. When data have 
complicated censoring pattterns such as interval-censored observations with overalpping 
intervals, the Peto/Turnbull estimator (a generalizationof the Kaplan-Meier estimator), is 
used instead (as described in Section 3.10 of Meeker and Escobar 1998). Chapter 3 of 
Meeker and Escobar (1998) describes the methods for computing nonparametric 
estimates and corresponding confidence intervals/bands from censored data (including 
complicated arbitrary censoring) and provides references and examples corresponding to 
these SPLIDA capabilities. 
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Figure 19 Plot of estimated fraction failing as a function of time for the turbine fans. 

Table 1 provides a nonparametric estimate from the turbine fan data, along with standard 
errors and approximate 95% pointwise confidence intervals. 

Table 1 Kaplan-Meier nonparametric estimate of the fraction failing as a function 
of time for the turbine fans. 

Nonparametric estimates from  Fan Failure Data  
with approximate 95% pointwise confidence intervals  
   Hours-lower Hours-upper    Fhat SE_Fhat 95% Lower 95% Upper  
 1           0         450 0.00000 0.00000        NA        NA 
 2         450        1150 0.01429 0.01418  0.002009   0.09449 
 3        1150        1600 0.04328 0.02444  0.014024   0.12577 
 4        1600        2070 0.05800 0.02815  0.021934   0.14459 
 5        2070        2080 0.09225 0.03607  0.041857   0.19121 
 6        2080        3100 0.10938 0.03925  0.052811   0.21291 
 7        3100        3450 0.12833 0.04274  0.065085   0.23742 
 8        3450        4600 0.14770 0.04597  0.078091   0.26173 
 9        4600        6100 0.17277 0.05100  0.094016   0.29593 
10        6100        8750 0.20458 0.05812  0.113253   0.34122 
11        8750       11500 0.29296 0.09804  0.140791   0.51166 
 
When using SPLIDA, it is often better to click on “Apply” rather than on “OK” to 
request an analysis. Then minimize the dialog to better see the results. This allows one  to 
modify the analysis easily; restore the dialog, make desired changes, click “Apply,” and 
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again minimize the dialog. When completely done with the dialog, click “Cancel.” If one 
uses “OK” instead, it will be more difficult to modify previous analyses, as certain steps 
in the analysis specification would need to be retraced. S-PLUS allows one to choose a 
previous dialog state by clicking on the buttons at the bottom of the dialog. When doing 
this, however, S-PLUS does not properly restore whether entries in the dialog are active 
or inactive 

4.3 Probability plots and distribution assessment 
Probability plots are one of the most important tools for reliability data analysis. The 
ideas and concepts underlying probability plots, along with a large number of examples, 
is given in Chapter 6 of Meeker and Escobar (1998).  The basic idea is to plot a 
representation of a nonparametric estimate of the fraction failing as a function of time 
(traditionally,  this estimate has been a set of points) on special distribution-dependent 
nonlinear plotting axes on which the specified theoretical distribution would plot as a 
straight line. 

Use SPLIDA ► Single distribution life data analyses ► Probability plot 
with nonparametric confidence bands to bring up the basic probability plot 
dialog, illustrated in Figure 20. Again, choose the life data object Fan.ld, choose “6 
distributions,” click “Apply,” and  minimize the dialog. This will make a six-distribution 
probability plot like the one in Figure 21, from which one can visually compare several 
different distributions, including the popular Weibull and lognormal distributions. 

 

Figure 20 Dialog requesting the 6-distribution probability plots with (default) 
simultaneous confidence bands. 
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Figure 21 Six-distribution probability plots with simultaneous confidence bands. 

Now, restore the dialog in Figure 20, change to “Choose dist,” and choose a particular 
distribution (e.g., lognormal), and click “Apply.” This will create the probability plot, 
shown in Figure 22, that will allow one to focus the reasonableness of the specified 
distribution as a model for the data. By default, simultaneous confidence bands are also 
provided. See Sections 3.8 and 6.3 of Meeker and Escobar (1998) for technical details, 
references, and other examples of these simultaneous confidence bands. 
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Figure 22 Lognormal probability plot with simultaneous confidence bands. 

Chapter 6 of Meeker and Escobar (1998) provides theory and a detailed description of 
methods for interpreting these probability plots. If one can draw a straight line through 
the simultaneous confidence band, for the chosen distribution (lognormal in Figure 22), 
then there are lognormal distributions that are consistent with the data. Then it is not 
possible to rule out the possibility that the data were generated by a lognormal 
distribution. One should, of course, try other distributions and compare the results. 

 

4.4 Maximum likelihood estimation of the failure-time cdf 
Using SPLIDA ► Single distribution life data analyses ► Probability plot 
with parametric ML fit produces the dialog in Figure 23. This dialog allows the user 
to request a probability plot showing the ML estimate for the chosen distribution (plotted 
as a straight line) along with the data points usually plotted in the probability plot. 
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Figure 23 Dialog for getting a probability plot with an ML fit. 

By default, SPLIDA also plots a set of normal-approximation 95% pointwise confidence 
intervals. These intervals allow one to obtain a visualization of estimates of both failure 
probabilities and distribution quantiles and the associated statistical uncertainty due to 
limited sample size. The Hazard page of the dialog in Figure 23, shown in Figure 24, 
allows the user also to obtain a plot of the corresponding parametric ML estimate of the 
hazard function versus time. A table of the hazard function estimates and corresponding 
confidence intervals can also be requested. The resulting probability plot with ML 
estimates is shown in Figure 25 and the plot of the hazard function is given in Figure 26. 
Chapters 2, 7 and 8 of Meeker and Escobar (1998) give the theory and methods for 
understanding these functions and using the corresponding analyses.  
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Figure 24 The Hazard page of the probability plot with ML fit dialog, allows the 
user to request and customize a plot of the hazard function ML estimate. 

Table 2 gives tabular output from fitting the lognormal distribution to the fan data. The 
rows with the Greek letters mu ( µ ) and sigma (σ ) are, respectively, ML estimates for 
the mean and standard deviation of the distribution of logarithm of fan life. Standard 
errors and 95% normal-approximation confidence intervals are also given. 
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Table 2 Lognormal ML estimation results for the turbine fan data. 
Fan Failure Data   
Maximum likelihood estimation results: 
Response units: Hours 
Lognormal Distribution 
Log likelihood at maximum point: -134.5  
 
Parameter              Approx Conf. Interval 
        MLE Std.Err.  95% lower 95% upper  
   mu 10.14   0.5211     9.122    11.165 
sigma  1.68   0.3893     1.066     2.645 

 

 

Figure 25 Lognormal probability plots of the fan data showing the ML estimate and 
parametric pointwise confidence intervals. 
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Figure 26 Lognormal hazard function estimate and parametric pointwise confidence 
intervals for the fan data. 

4.5 Comparison of ML estimates from different distributions 

The dialog produced by Single distribution life data analyses ► Compare 
distribution ML fits on probability plot, shown in Figure 27, allows the 
comparison of ML estimates for a chosen baseline distribution with one or more other 
distributions. The required inputs are the life data object (for the following example we 
continue to use the Fan.ld life data object), the baseline distribution, and the comparison 
distribution(s). 
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Figure 27 Dialog requesting a comparison of the lognormal and Weibull ML 
estimates on lognormal probability paper. 

Suppose that the objective of the analysis of the fan data was to estimate life out to 
50,000 hours. In order to do this, select the “Choose cdf evaluation range” in the Plot 
Options page, shown in Figure 28, of the “Compare single distribution ML fits on 
probability plot” to request extrapolation outside of the range of the data .  Clicking on 
“OK” or “Apply” will then produce the desired comparison probability plot shown in 
Figure 29 (changing the range using the options in the Modify plot axes page of the 
dialog will change only the axis range and not the range of cdf evaluation). 
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Figure 28 Plot Options page of the compare ML fits dialog showing how to extend 
the range of cdf evaluation 
 

 

Figure 29 Lognormal probability plot comparing the lognormal and Weibull ML 
estimates for the fan data. 

There is little difference between the Weibull and lognormal probability estimates up to 
1000 hours. Note, however, the large difference between the estimates of fraction failing 
outside the range of the data. 
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4.6 Likelihood contour/perspective plot 
Using SPLIDA ► Single distribution life data analyses ► Likelihood 
contour/perspective plot produces the dialog shown in Figure 30. This dialog 
allows the user to request either a contour or a perspective plot of the relative likelihoood 
function or the corresponding joint confidence region (described and compared in 
Sections 8.2 and 8.3 of Meeker and Escobar, 1998) for a given set of data.  Alternatively, 
one can request a perspective (or wire-frame) plot of the relative likelihood function. The 
dialog has an option to indicate the position of the ML estimates, to request 
correcponding profile likelihood plots, as well as the usual options to control plot axes. 

The likelihood can be computed as a function of the underlying location and scale (scale 
and shape) parameters of the location-scale (log-location-scale) distributions. 
Alternatively one can the scale (shape) parameter and a specified quantile of the 
distribution. We will illustrate both. 

We illustrate the use of this dialog with the bearing cage data (life data object 
BearingCage.ld) from Abernathy et al. (1983).  This data object is built into 
SPLIDA. Figure 31 shows the perspective plot of the Weibull relative likelihood, 
followed by  the contour plot of the joint confidence region in Figure 32. 
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Figure 30 Dialog for requesting likelihood plots of the bearing cage likelihood 
function. 



 37

 

Figure 31 Perspective plot of the relative likelihood function for Weibull parameters 
based on the bearing cage data. 

Notice the “shark-fin” shape of the relative likelihood in Figure 31. This reflects the 
strong positive correlation between the ML estimators of the Weibull parameters; this 
correlation is the result of the heavy right censoring in this data set (the estimate of the 
fraction failing is less than .06 at the largest failure time). The contour plot of the joint 
confidence region for the Weibull parameters shown in Figure 32 is easier to interpret 
and shows (by option) the ML estimates. 
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Figure 32 Joint confidence region for Weibull parameters based on the relative 
likelihood function for the bearing cage data. 

Figure 33 shows a similar contour plot for the 0.1 quantile and σ  for the Bearing Cage 
data with the Weibull distribution and Figure 34 shows the corresponding profile 
likelihood for the 0.1 quantile. The upper endpoint of the confidence interval for the .1 
quantile is NA because the profile likelihood had not dropped far enough to cross the 
95% line in Figure 34. 

 

Table 3 Output From the profile likelihood for β and the 0.1 quantile of the Bearing Cage data. 

There were problems finding the confidence interval from the computed likelihood profile 

The approximate 95% likelihood confidence interval for 0.1 Quantile Hours is: 2082   NA  

The approximate 95% likelihood confidence interval for beta is: 0.9697 3.5713 
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Figure 33 Joint confidence region for the Weibull 0.1 quantile and β based on the 
relative likelihood function for the bearing cage data. 
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Figure 34 Profile likelihood for the Weibull 0.1 quantile from the bearing cage data.  
 
 

4.7 Bootstrap confidence intervals 
SPLIDA has some simple tools for doing parametric bootstrap for a single distribution 
(there are plans to extend these tools to more complicated models such as regression). To 
do such an analysis of the Bearing Cage data, choose use SPLIDA ► Single 
distribution life data analyses ► Bootstrap confidence intervals produces 
the dialog in Figure 35. Choose the Bearing Cage results object 
BearingCage.mlest.weibull.out and check both boxes under summary plots. 
Then clicking on Apply will result in summary plots like those in Figure 36 and Figure 
37. 
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Figure 35 Dialog to request the computation of bootstrap samples and summary 
plots. 
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Figure 36 Probability plot showing the ML estimates for 50 of the 2000 bootstrap 
samples for the Bearing Cage data. 
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Figure 37 Scatter plot showing the ML estimates of 500 of the 2000 bootstrap 
samples for the Bearing Cage data. 
 

Restore the bootstrap confidence interval dialog and under Option, choose “Conf 
interval.” On the right-hand side of the dialog, choose “Quantile” under “Confidence 
interval on” and enter 0.1 in the quantile box. Then click Apply. This will give the text 
output shown in Table 4, and the histogram of the bootstrap distribution of the t-like 
statistics in Figure 39. The text output also provides diagnostics about the number of 
troublesome bootstrap samples. In particular, some samples resulted on no failures.  
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Figure 38 Dialog requesting bootstrap confidence interval for the 0.1 quantile of the Bearing Cage 
life. 

 
Figure 39 Histogram of the bootstrap-t distribution for the log 0.1 quantile of the Bearing 
Cage data.  
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Table 4 Text output from the bootstrap confidence interval procedure. 

4.8 Fitting a log-location-scale (location-scale) distribution with a given shape 
(scale/slope) parameter 

In some applications, especially when the amount of data is limited, it may be useful to 
fit a distribution with a given shape parameter. Although it is rare that one would know 
such a shape parameter exactly, such evaluations are useful if one repeats the analysis 
using different values of the given parameter within given ranges, perhaps based on 
previous experience with a similar failure mode. More details are given in Section 8.5 of 
Meeker and Escobar (1998). 

Fitting a location scale or log location scale distribution with a fixed shape (slope) 
parameter is easy in SPLIDA. To illustrate this, we will continue with the bearing cage 
example. For the bearing cage data, the wide confidence intervals for ( )F t outside of the 
range of the data in Figure 29 are due, in large part, to the fact that the Weibull shape 
parameter is unknown and that there is only a small amount of data available. Important 
improvement in precision can be obtained by specifying a value for the shape parameter. 
Using SPLIDA ► Single distribution life data analyses ► Probability plot 
with parametric ML fit produces the dialog in Figure 40.  

 

There were  1999 unique bootstrap samples out of 
 2000 total bootstrap samples 
 
 A total of 5 of 2000 (0.25%) bad bootstrap samples 
 were removed because of convergence difficulties. 
 These were probably samples with 0 failures  
 or no variability in the response. 
 
Using the bootstrap t log transformation method, 
an approximate 95 percent confidence interval  
for t 0.1  is [2256.1,    146649] . 
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Figure 40 Dialog showing how to fit a Weibull distribution with a fixed shape (slope) 
parameter. 

The resulting probability plot is given in Figure 41. 
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Figure 41 Bearing cage Weibull probability plot with the fixed β=2 ML estimate line. 

Notice that the confidence interval lines in the Weibull probability plot are parallel. This 
implies that the intervals will be narrower outside of the range of the data. Of course, this 
would provide a false sense of precision if the Weibull shape parameter (not to mention 
the assumption of a Weibull distribution itself) does not provide an adequate 
approximation to the actual bearing cage distribution. 

 

5 Single Distribution Bayes Analysis 
This section describes some simple, but useful, procedures for Bayesian estimation with 
censored data for log-location-scale distributions. The procedures provide bayesian 
“crediability intervals” for quantities of interest such as distribution parameters, 
quantiles, and failure probabilities. Graphical outputs of the results from the procedures 
provide insight into how the Bayesian methods combine prior information (prior 
distribution) with the data (likelihood). 
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We will continue the use of the Bearing Cage data used in Section  4.8, where it was 
assumed that the Weibull shape parameter was given as β=2. The example in this chapter 
will assume that there is some information about β, described by a prior distribution. 

5.1 Specifying prior information 
 
The first step in the use of these procedures to do a Bayesian analysis is to specify the 
available prior information by creating a prior distribution object. This is done with the 
dialog obtained by using SPLIDA ► Single distribution Bayesian analyses ► 
Specify a prior distribution produces the dialog in Figure 42. In this dialog, the 
Model distribution referrs to the distribution of the response in the data object to be used 
in the analysis, Weibull in this case. In the “Prior for” parts of the dialog, one needs to 
specify a distribution for each of the Weibull “parameters.”  

 

Figure 42 Dialog to specify the prior distributions for the Weibull parameters for 
the Bearing Cage data. 

As described in Section 14.3 of Meeker and Escobar (1998), the quantile parameter 
should be chosen such that its prior distribution is approximately independent of the prior 
distribution for the shape/spread parameter. In the Bearing Cage example, the 0.1 
quantile was chosen because previous experience with such components had seen, 
ultimately, somewhat more than 10% failing while in service. The prior distribution is 
chosen as log-Uniform between 1000 and 20000 (i.e., a distribution that is uniform on the 
log scale  between log(1000) and log(20000)).  The prior distribution for this parameter 
has a very broad range, and was chosen to reflect the small amount of knowledge 
available for this quantity for this specific bearing cage. Such a prior is known as a 
“diffuse prior distribution.” 
More precise information is available for the Weibull shape parameter β. In this case, the 
prior distribution is specified to be lognormal with 99% of its probability between 1.5 
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and 3 (using such a range for a prior distribution is more convenient than using the 
traditional lognormal parameters that have little or no meaning for engineers from which 
such information is elicited). By default, the name of the resulting prior distribution 
object is last.distribution.prior, where distribution is automatically 
replaced by the chosen distribution. Often it is useful to specify the name of this object, 
so that it can be recognized later. BearingCage.weibull.prior was used in the 
example. Clicking on OK or Apply will create the prior object (with a summary being 
printed). 
 

5.2 Making a posterior distribution 
Using SPLIDA ► Single distribution Bayesian analyses ► Make a 
posterior distribution brings up the dialog in Figure 43. This simple dialog is used 
to make a posterior distribution (actually what is generated is a sample from the posterior 
using the simple method described in Section 14.4.2 of Meeker and Escobar 1998 and 
Smith and Gelfand and 1992). All that one needs to specify is the prior object and the life 
data object. The default number of points in the posterior is 6000, and this is sufficiently 
large for most purposes. There is an option to change the name of the resulting posterior 
object, but the default (obtained by pasting together the names of the input object names) 
is almost always adequate. 
 

 

Figure 43 Dialog to create a posterior distribution for the Bearing Cage data. 

Clicking on OK or Apply will generate the posterior distribution object (with progress in 
the generation and a summary being printed). 
 

5.3 Summarizing a posterior distribution 
A posterior distribution can be summarized in a number of different ways, depending on 
the interests of the analyst. Using SPLIDA ► Single distribution Bayesian 
analyses ► Summarize prior/posterior distribution brings up the dialog in 
Figure 44. From this dialog, the analyst can request plots of the prior distribution sample 
or the posterior distribution sample. The plots can be for the joint distribution of the 
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shape parameter and another quantity of interest (the scale parameter, a particular 
quantile, or a failure probability at a specified time). 
 

 
Figure 44 Dialog to request a summarization of a posterior distribution. 

Figure 44 is a dialog to request a plot of the joint distribution of the prior distribution, the 
result is shown in Figure 45.  

 

Figure 45 Sample from the Bearing Cage prior distribution (diffuse for 0.1 quantile 
and somewhat informative for β) and likelihood contours. 
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Changing “prior” to “posterior” in the dialog in Figure 44 and clicking on Apply will 
result in the plot shown in Figure 46. 
 

 

Figure 46 Sample from the Bearing Cage posterior distribution (based on a prior 
that is diffuse for 0.1 quantile and somewhat informative for ß) and likelihood 
contours. 

It is interesting to compare Figure 45 and Figure 46 to see the effect that the data has on 
the sample from the prior distribution, to create the sample from the posterior 
distribution. 
 
To focus on the posterior marginal distribution of a particular quantity of interest, ask for 
“Marginal only” under “Joint or Marginal.” Figure 47 shows the results of asking for the 
marginal posterior distribution of .1 quantile of the bearing cage life. The vertical lines 
represent 95% Bayesian credibility limits (obtained by eliminating 2.5% in each tail of 
the marginal posterior distribution). 
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Figure 47 Marginal posterior distribution for the .1 quantile for the Bearing Cage 
data, based on a prior that is diffuse for .1 quantile and somewhat informative for ß. 

6 Planning a Single Distribution Study 
 
This section describes tools for evaluating proposed lifetest plans. The tools presented 
here are based on theory and methods described in Chapter 10 of Meeker and Escobar 
(1998). 

SPLIDA single distribution life test evaluations are done in three stages.  SPLIDA 
provides three different dialoges to accomplish these tasks: 

1. In the first stage (see Section 6.1 and  6.2) the user specifies the testing situation by 
providing planning values (essentially, best guesses for the underlying model, 
including information on the life distribution, including the distribution’s parameters 
values) in the form of a plan value object. Given such planning information, it is 
possible to evaluate any specified test plan or plans.  

2. In the  second stage (see Section 6.3)  one can ask for a plot of approximate required 
sample size as a function of desired precision. This evaluation, based on large sample 
approximate variance computations, allows the test planner to see, at a glance, the 
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effect of sample size for a given test length (as specified by time for Type I censoring  
and number of test units for Type II censoring). 

3. In the third stage of evaluation (see Section 6.4), one can simulate a specified test 
plan a specified number of times. Plots of the samples from a few of the individual 
simulated experiments and a summary of ML estimates from all of the simulations 
(both presented on appropriate probability plots) provides a visualization of the 
possible results from a life test experiment and the reasons why estimates of certain 
quantiles might or might not be estimated precisely. 

6.1 Specifying test planning information (planning values) 
Using SPLIDA ► Plan Single Distribution Analyis ► Specify test 
planning information (planning values) brings up the dialog in Figure 
48, allowing the user to specify planning values needed to evaluate and compare 
different life test plans. The default name for the planning value object is 
last.xxx.pv where xxx is the chosen distribution. Generally it is a good idea to edit 
the suffix “last” to be something that describes the actual application  (in the 
example below we use DeviceP). This “planning values object” will be used in 
the simulation/evaluation stage of planning. To specify the required distribution-
parameter plannning values, start by choosing a method to specify (on probability 
plot) the failure time distribution: a) point and slope or b) two points. Either 
method can be used to specify a line on a  probability plot (with an underlying 
log-location assumed distribution).  

DeviceP is an electronic device tat will be tested at standard accelerated test 
conditions of 80 Degrees C and 80% RH. We will assume for now that estimate 
of life at thse conditions is of interest (in the actual applications, the engineers 
intended to multiple the final answer by an “acceleration factor” known to be 
approximately correct for the failure mechanism under study).  

For DeviceP, the engineers expect approximately 10% of the tested units to fail 
by 1000 hours and that the failure time distribution will be adequately described 
by a lognormal distribution with a shape parameter sigma (σ) in the neighborhood 
of 2. After specifing the needed information, click “Apply” and examine the 
resulting probability plot reflecting the inputted information, as illustrated in 
Figure 49. Some tabular information is also provided in Table 5. 
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Figure 48 Dialog for specifying life test planning information. 

 

 
Figure 49 Probability plot depicting life test planning information. 
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Table 5 Tabular output  from the dialog used to specify planning values. 
Distribution:  Lognormal   
Time units are:  Hours   
  
mu =  9.47   
sigma =  2   
 
 
Failure probabilities from the Lognormal distribution 
Hours fail.probs  
  1e+001   0.000169 
  1e+002   0.007490 
  1e+003   0.100000 
  1e+004   0.448181 
  1e+005   0.846381 
  1e+006   0.985084 
  1e+007   0.999556 

 
 
 

6.2 Plot test planning information (planning values) 
Using SPLIDA ► Plan Single Distribution Analysis ► Plot test 
planning information (planning values) allows the user obtain a plot and table, 
like those in Figure 49and Table 5, describing a previously created plan value 
object. 

6.3 Plot of approximate required sample size 
Using SPLIDA ► Plan Single Distribution Analyis ► Plot of required 
sample will produce the dialog in Figure 50.  
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Figure 50 Dialog for requesting a required sample size plot. 

Note that the most recently created plan value object (within the current session) is 
remembered and displayed as the default to be used. Alternatively, a different, previously 
created, plan values object can be chosen. Then one must choose a censoring type and 
either a censoring time or number of failures (for Type I and Type II censoring, 
respectively) and, if desired, a  quantile of interest of other than the default of .1. Clicking 
on “OK” or “Apply” will produce a plot like the one in Figure 51. It is useful to use the 
rectangle tool from the S-PLUS annotation toolbar (right click on a blank part of the 
toolbar section of the SPLUS GUI and choose annotation, then click on the rectangle) to 
help read off values from the plot. 

For log-location-scale distributions (Weibull, lognormal, loglogistic) the confidence 
interval precision is described in terms of a factor R  in that the normal-approximation 
confidence interval for a quantile has the form ˆ ˆ[ / , ]p pt R t R  where 1R >  and the interval is 
more precise for small values of R  (see Chapters 7 and 8 of Meeker and Escobar 1998). 
For location-scale distributions (smallest extreme value, normal, logistic) precision is 
given in terms of the half-width of the two-sided confidence interval. 
 

 

Figure 51 Plot giving sample size needed as a function of the target confidence 
interval precision factor. 

For example, Figure 51 shows that a sample size of approximately 70 is required to have 
a 95% confidence interval target precision factor of 2. The actual precision factor R, 
because it depends on the data, is random for any given life test, but should be no more 
than the target value with probability of approximatley .5. To get a sense of how much R 
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might vary from the target value, one can use the simulation tool described in Section 
6.4. 

6.4 Life test simulation 
Although the plot of required sample size versus precision factor is useful for 
determining the approximate sample size needed for a life test, simulating the life test 
avoids large sample approximations, provides more insight into the results that might be 
obtained, and gives one a better sense of the trade-off between sample size and test 
length. Using SPLIDA ► Plan single distribution analysis ► Simulate a life 
test  requests a dialog like that shown in Figure 52. This dialog allows one to specify the 
inputs needed to produce a simulation of a user-specified life test plan.  

 

Figure 52 Dialog to request a life test simulation. 

The user specifies the number of units to be tested (“Sample size”) and test length 
(“Censoring time” for time or Type I censoring) or number of units to fail (for failure or 
Type II censoring) and, perhaps some other optional inputs (e.g., which quantile of the 
distribution is of primary interest).  

One can (and in an unfamiliar situation, should) choose to look at the individual samples 
from some of the simulated samples by entering a small integer (usually 5 or 6 is 
sufficient)  into the box marked “View detail for how many samples?” If an integer k > 0 
is given in this cell, then after completion of the simulation, the graphsheet will contain k 
probability plots showing the planning value line (with a dark thick line) along with the 
observed failures and the ML estimate line (a thin line to contrast with the “true” 
planning value line) for each of the k samples. Figure 53 provides an example of such a 
plot. It is interesting to observe the variability in the failure times and corresponding ML 
estimate lines from sample to sample in a sequence of these plots.  

The final probability plot, illustrated in Figure 54, contains, in summary,  the ML 
estimates from all of the simulated samples. When a quantile (number between 0 and 1) 
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is given in the “Quantile line at” cell, a horizontal line is drawn at that level on the 
probability plot, allowing a visualization of the sampling variability in the estimates of 
that quantile, and the average precision factor for the confidence intervals for the 
corresponding confidence intervals is shown in the plot.  The average precision is 
computed as a geometric average of the individual precision factors for quantiles of log-
location distributions and an arithmetic average of the individual precision factors for 
quantiles of location distributions. 
 

 

Figure 53 Probability plot and ML estimate for the first simulated life test. 

Figure 53 shows the probability plot for the first simulated sample. Generally looking at 
five or six of these individual simulation results (we only show one here) is sufficient for 
getting a good idea how the samples in the proposed life test might behave (assuming that 
the inputted planning information is reasonably accurate). One can see clearly the 
potential effect that censoring will have on the information from samples and the effect 
of changing the sample size and censoring time. 
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Figure 54 Summary showing ML estimates for all 30 life test simulations. 

Figure 54 shows a summary of the ML estimates from 50 of the 3000 simulations (if 
more than 50 lines are plotted, it becomes difficult to judge the density of the lines in 
certain parts of the plot). The geometric average of the 3000 individual precision factors 
printed in this simulation-summary plot provides a useful measure of sampling variability 
and the corresponding precision that one can expect to see in the results of one’s life 
test.Unless the number of simulations is very large (e.g., 1000’s of simulated life tests) 
the value of this average vary somewhat from simulation to simulation. When the 
probability of 0 failures is relatively small (e.g. .005 or less) this numerical summary of 
the simulation will agree very well with the value predicted from the sample-size tool 
(e.g. Figure 51). 
 

6.5 Probability of successful demonstration 
 

After conducting a life test, a successful demonstration of reliability has occurred if the 
lower confidence bound on reliability exceeds the given standard 1 ( )q F t= −  [which is the 
same as the upper confidence bound on fraction failing being less than a standard 

( )p F t= ]. Equivalently, the demonstration is successful if lower confidence bound on the 
corresponding p quantile of the life distribution is larger than the corresponding standard 
(e.g., for demonstrating 95% reliability, the standard would be based on the .05 quantile 
of the life distribution). For a log-location-scale distribution, the probability of a 
successful demonstration for a Type II censored life test (test run until a specified number 
of units fail) is a function of the level of reliability to be demonstrated, the number of 
units to be tested, the number needed to fail, and the underlying true reliability.  

SPLIDA has a tool to allow one to compute and make plots of the probability of 
successful demonstration. The dialog in Figure 55 allows the user to specify the 
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necessary inputs.  In Figure 55, sample sizes n=20,30,40 with corresponding number 
failing r=10,15,20 (i.e., 50% failures) were chosen. In general, the number failing r must 
be at least 2 but no greater than n. The probabilities of successful demonstration are 
computed via simulation. The default number of simulations was increased from the 
default 300  (which allows quick but rough evaluations) to 3000, which is good enough 
for most practical purposes (although 10 thousand simulations might be used to make a 
publication-quality figure). The default reliability to be demonstrated was changed from 
the default 0.5 to 0.9. Completing the 3000 simulations requires less than a minute of 
computer time on a modern PC). 

 
 

Figure 55 Dialog for requesting the computation of probability of successful 
demonstration curves from q=0.9. 

Figure 56 is a plot of the probability of successful demonstration as a function of the 
actual (unknown) reliability. As expected, it is easier to make the demonstration  (i.e., the 
probability of success is higher) if the actual reliability is much larger than the standard 
to be demonstrated.  
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Figure 56 Weibull life test probability of successful demonstration curves for q=0.9. 

After completing a simulation to compute the probability of successful demonstration, 
SPLIDA will save the simulation results as an object, making it possible to reuse the 
results to make evaluations for other given values of reliability as the standard. Figure 57 
shows a dialog in which the results from the previous simulation will be used to compute 
another set of probability of successful demonstration curves with q=0.7. From this 
dialog, it is also possible to choose from among the combinations of sample size n  and 
the number of failures r  used in the previous simulation to limit the number of curves to 
appear on the plot. 
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Figure 57 Dialog using existing results (previously computed simulation) to compute 
probability of successful demonstration curves for q=0.7. 

The resulting plot appears quickly, because the simulations do not need to be run again 
and is shown in Figure 58. As expected, the required sample sizes in this plot are smaller 
because of the less demanding demonstration. 
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Figure 58 Weibull life test probability of successful demonstration curves for q=0.7. 

 

7 Analysis of Data with More Than One Cause of Failure 
Both laboratory life tests and field-failure reporting systems (e.g., warranty repair 
processes) result in data with more than one failure mode. For example, a system may 
have several components and the failure of any one of  these components could cause the 
system to fail. For many purposes, it is important to use failure mode information in the 
analysis and interpretation of one’s data. This is especially true when the purpose of the 
analysis is to identify opportunities for improving product reliability.  

One commonly used model for multiple failure modes supposes that each unit has a 
“potential” failure time for each of the possible “modes” of failure and that the 
distribution of these failure times can be described with a joint distribution. When it can 
be assumed that the different potential times to failure are approximately statistically 
independent, this modeling approach provides a simple method of modeling and analysis 
that allows estimation of the failure time distribution for any particular failure mode or 
for the entire system with any specified combination of failure modes active. See Chapter 
15 of Meeker and Escobar (1998) for technical details and other information about the 
analysis of such data. 

 

7.1 Summary analysis of individual failure modes 
Consider the Device-G data described in Section 15.4 of Meeker and Escobar (1998). 
The devices that failed during the study failed from either a surge or a wear out failure 
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mode. The underlying mechanisms causing these two failure modes were different and it 
would be reasonable to assume that the times to failure for these two different modes 
would be independent. In order to estimate the failure time distribution of the individual 
failure modes, under the assumption that the failure modes failure times are independent, 
use SPLIDA ► Multiple failure mode life data analysis ► Individual 
modes. Then choose the life data object (DeviceG.ld in this case) and distribution 
(Weibull for this example) in the dialog, as shown in Figure 59. 
 

 

Figure 59 Dialog requesting separate analyses of different failure modes for the 
Device-G data. 

Other options for graphical and tabular output are available in the back pages of the 
dialog. When done, click “OK” or “Apply,” producing the probability plot with estimated 
distributions for the two individual failure modes in Figure 60. Tabular output giving the 
Weibull parameter estimates is also provided, as shown in Table 6.  

In this application, management was interested in answering a number of different 
questions with these data. Among the requested outputs was the failure-time distribution 
for the wear out failure mode alone, which would be the failure time distribution for the 
device if the surge failure mode could be eliminated. A table of these estimates 
(requested with the “Tabular Output” page of the dialog) is shown in Table 6. 
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Figure 60 Analysis of the individual failure surge and wear out failure modes for the 
Device-G field data. 

Figure 60 shows immediately that the surge failures tend to occur anytime during life, 
from early to late. No wearour failures were seen until after 100 thousand cycles. Table 6 
provides a summary of separate ML estimations for both the Surge and the Wearout 
failure modes and some additional details for the Wearout failure mode 

Table 6 Summary of ML estimation for Surge and Wearout failure modes and 
details for the Wearout failure mode 
Response units: Kilocycles 
Weibull Distribution 
          Likelihood   eta  se_eta  beta se_beta 
1 Wearout     -47.16 340.4  36.14 4.337  1.4506 
2   Surge    -101.36 449.5 191.94 0.671  0.1578 
 
Total likelihood= -148.5 
Weibull Distribution Failure Probability Estimates 
From DeviceG Wearout Failure Mode Group Wearout 
with Weibull MLE and Pointwise 95% Confidence Intervals 
Kilocycles    Fhat    Std.Err. 95% Lower 95% Upper 
140           0.02098  0.02270  0.002453    0.1574 
160           0.03714  0.03330  0.006179    0.1931 
180           0.06113  0.04510  0.013764    0.2330 
200           0.09482  0.05712  0.027638    0.2785 
220           0.13983  0.06853  0.050521    0.3318 
240           0.19722  0.07932  0.084269    0.3961 
260           0.26718  0.09088  0.128000    0.4752 
280           0.34864  0.10569  0.176941    0.5713 
300           0.43911  0.12529  0.224124    0.6797 
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7.2 Combined modes (series system) analysis 
SPLIDA also computes estimates of the series-system failure-time distribution with all 
failure modes operating. To do this, use SPLIDA ► Multiple failure mode life 
data analysis ► Combined modes and again choose the life data object and 
distribution and click “OK” or “Apply,” producing the probability plot with estimated 
distribution for the system with both failure modes active and acting independently, 
shown in Figure 61. 

 

 
Figure 61 Series system competing risk analysis for the Device-G data. 

7.3 Creating life data objects for individual failure modes 
Using SPLIDA ► Multiple failure mode analysis ► Make life data objects 
for individual failure modes will bring up the dialog in Figure 62, allowing the 
user to create separate life data objects for each failure mode in the multiple failure mode 
life data object.  
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Figure 62 Dialog to ask that individual life data objects be made for individual 

failure modes. 

Names for the life data objects are chosen automatically by appending the failure mode 
name to the root of the failure mode life data object name (DeviceG.Surge.ld and 
DeviceG.Wearout.ld in the example). Once these individual life data objects have been 
created, all of the SPLIDA methods for single-distribution analyses can be applied to the 
analysis of the individual failure modes, under the (important) assumption that the 
individual failure modes are acting independently. 

 

8 Comparison of Two or More Distributions Using Life Data Analysis 
 
Experiments are commonly conducted for the purpose of comparing the life distributions 
of different or competing materials, formulations, designs, manufacturers, and so on. 
Similar data arise from warranty data and field tracking studies. The analysis methods 
presented here for such data generalize methods in classical statistical methods 
commonly known as two-sample comparison and one-way analysis of variance. SPLIDA 
generalizes these methods, allowing for censoring, non-normal distributions, and 
comparisons with non-constant shape (slope) in the distributions being compared. 

8.1 Comparison with different shape (slope) parameters 
Using SPLIDA ► Comparison of distributions life data analysis ► 
Probability plot and ML fit: different shapes (slopes)  brings up a dialog like 
that in Figure 63 asking for input of a comparison life data object and a distribution, as 
shown below. A comparison life data object is a life data object that contains at least one 
categorical explanatory variable (in S-PLUS, an explanatory variable is assumed to be 
categorical (a “factor” in  S-PLUS jargon) if it contains any alphabetic characters). The 
Life data object list will contain all of the “comparison life data objects” found in the 
SPLIDA data base or in the user’s local data base. As done for single distributions life 
data objects, comparison life data objects are created by using the SPLIDA ► 
Make/edit/summary/view data object ► Make life data object part to the 
SPLIDA menu. If there is more than one categorical explanatory variable in the 
comparison life data object, then one needs to choose which one to use in the 
comparison. The following example uses the Snubber data  (life data object Snubber.ld) 
from Nelson (1984, page 529) and reanalyzed in Examples 17.13 to 17.15 in Meeker and 
Escobar (1998), comparing two different Snubber designs (a snubber is a toaster 
component). Following these previous analyses, the normal distribution is fit to the data. 
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Figure 63 Dialog requesting comparison of the Snubber using  separate normal 
distributions. 

Using SPLIDA ► Comparison of  distributions life data analysis ► 
Probability plot and ML fit: different shapes (slopes) brings a dialog like that 
shown in Figure 63. After the needed and desired optional inputs have been given in the 
dialog, click on “Apply” to do the analysis.  

Figure 64 gives the resulting individual probability plots for each (in this case two) of the 
samples in the the data set. Table 7 gives a tabular summary of the results. Tests or 
confidence intervals to compare particular quantiles or other parameters are easy to 
construct, following the general approach given in Section 17.8 of Meeker and Escobar 
(1998). 
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Table 7 Normal distribution ML estimates for the Snubber data using separate 
normal distributions . 

 
Figure 64 Normal probability plot comparing the new and old snubber designs with 
separate normal distribution standard deviations. 

8.2 Comparison of likelihood contour plots 
Using SPLIDA ► Comparison of  distributions life data analysis ► 
Comparison likelihood contour plot brings up a dialog like the one in Figure 65, 
allowing one to specify a comparison life data object and distribution in order to produce 
corresponding two-parameter contour plots for each of the groups being compared. 

Maximum likelihood estimation results: 
 
Response units: Toaster Cycles 
 
Normal Distribution 
            Log likelihood     mu  se_mu sigma se_sigma  
1 NewDesign         -138.6 1126.6 123.21 546.0     99.5 
2 OldDesign         -146.8  908.1  76.19 362.4     63.4 
 
Total log likelihood= -285.4 
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Figure 66 shows a comparison contour plot of normal distribution joint confidence 
regions for µ and σ for the Snubber data.  

 

 

Figure 65 Dialog requesting contour plots to compare the new and old snubber 
designs assuming separate normal distributions. 
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Figure 66 Contour plot showing joint confidence regions for the normal distribution 
parameters for the two  snubber designs. 

The SW to NE orientation of the contours in Figure 66 is a result of the right censoring. 
The degree of overlap provides an alternative visualization of the statistical “closeness” 
of the parameters of the lifetime distributions for the two different snubber designs. 

The dialog in Figure 65 also produced the optional comparison profile likelihood plots 
(not shown here) comparing the distribution median and the lognormal shape parameters 
from the New and Old groups. 

8.3 Comparison with common shape (slope) parameters 
For some applications, it is reasonable to model the different populations or processes 
being compared as having the same shape (or slope) parameters, differing only with 
respect to scale (for a log-location-scale distribution) or location (for a location-scale 
distribution). This tends to simplify the analysis because the equality of any particular 
distribution quantile would imply the equality of other distribution quantiles (this can be 
seen by noting that, with this assumption, the probability plots of the individual fraction 
failing  are parallel).  



 72

Using SPLIDA ► Comparison of  distributions  life data analysis ► 
Probability plot and ML fit: common shapes (slopes) brings up a dialog like 
that shown in Figure 67. This dialog is similar to that used for the comparison with non-
common shapes (slopes).  

 

Figure 67 Dialog requesting a probability plot comparing the new and old snubber 
designs assuming normal distributions with a common standard deviation. 

As before, choose a “life data object” (by default SPLIDA puts in the list  only life data 
objects with a comparison or factor  explanatory variable) and a “distribution.” An 
estimate of the model parameters is given in the S-PLUS report window. The right-most 
back page of the dialog provides a dialog that allows one to obtain a plot of the estimated 
model (a “model plot” is sometimes called a “stress plot” when the explanatory variable 
is a stress variable). Tables of estimates of distribution quantiles and failure probabilities 
are also available among the options in the back pages of the dialog. These tabular and 
graphical outputs for the Snubber data common standard deviation analysis are given in 
Table 8 and Figure 68.  
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Figure 68 Normal probability plot comparing the data from the new and the old 
Snubber design assuming normal distributions with a common standard deviation. 

The probability plot  in Figure 68 shows nonparametric estimates of the life time 
distributions for both snubber designs along with ML estimates of the assumed normal 
distributions. The lines representing the ML estimates of the fraction failing  for the two 
designs are parallel because of assumption of common normal distribution standard 
deviations. For the normal distribution, the slope corresponds to an estimate of the 
reciprocal of the standard deviation of life ( the reciprocal of the scale parameter). 

Table 8 Normal distribution ML estimates for the Snubber data with a common 
normal distribution standard deviation.  
Snubber Failure Data   
Maximum likelihood estimation results: 
Response units: Toaster Cycles 
Normal Distribution 
Relationship  
1 : class      
Log likelihood at maximum point: -286.7  
 
Parameter                  Approx Conf. Interval 
           MLE      Std.Err. 95% lower 95% upper  
Intercept 974.63    89.11     800.0    1149.3 
DesignNew  86.67   114.21    -137.2     310.5 
    sigma 458.56    57.67     358.4     586.7 
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The table reproduced in Table 8 gives ML estimates and standard errors for an 
underlying dummy variable regression model used to distinguish between the two 
different designs (see Section 17.8 of Meeker and Escobar for a detailed description of 
this model). The Intercept row corresponds to the “baseline” category (old design in this 
case) giving the estimated parameter  for the corresponding distribution (mean of the 
normal distribution in this case). The DesignNew row in the table gives the ML 
estimate of the difference in mean life between the baseline and the new design.  The 
95% approximate confidence interval for the DesignNew coefficient is [ 137.5, 310.5]− . 
This interval is wide enough to contain 0, indicating that the observed difference between 
the two designs could well have been caused by the random variability in the snubber life 
distributions. The last row in the output gives the estimate of the normal distribution 
standard deviation, which, in the model, is the same for both designs. 

The “model plot,” shown in Figure 69, plots estimates of the normal distribution density 
functions and distribution quantiles. This figure shows clearly that the observed 
difference in the designs is dominated by the variability in snubber life. 
 

 

Figure 69 “Model plot” showing the estimated normal distribution densities for the 
new and the old snubber designs assuming normal distributions with a common 
standard deviation. 
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8.4 Make life data objects for individual groups  
After comparing different groups, it is often desired to select one or more of the groups 
for more focused analysis. It is possible, for example to choose a particular group or 
groups and do single-distribution analyses for them. We will illustrate this by making a 
separate life data object for the New snubber design. Using SPLIDA ► Comparison 
of distributions life data analysis ► Make life data objects for individual 
groups brings up the dialog in Figure 70. 

 

 

Figure 70 Dialog used to choose a data subset for a new life data object 

For the example, we choose the Snubber.ld comparison life data object. Design is the 
only explanatory variable in this life data objects, so it is automatically highlighted. Then 
choose “New” under the list of available levels (or in general combinations of levels). A 
name for the output data object is chosen automatically when the level(s) or 
combinations of levels are chosen, but it is possible to edit this name. Clicking on “OK” 
or “Apply” will execute the function to produce the new data object. For the example, the 
message “Saving subset data object Snubber.NewDesign.ld” is printed and this data 
object will appear subsequently in the lists of single-distribution life data objects. 

8.5 Probability of correct selection 
When planning a life test to compare two or more distributions, an important 
consideration is the sample size needed to make the comparison. For example, when 
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comparing two different designs (as in the snubber example) if one only tested two units 
from each design, it is unlikely that the experiment would indicate a statistically 
significant difference, even if there were a difference of practical importance. Thus we 
would not have the information needed to choose one design over the other. 
Correspondingly, if the experiment had used  10,000 units of each design, it would be 
highly likely that any difference of practical importance (or indeed, small differences that 
would not be important!) would be detected with high probability. Additionally, when 
comparing life distributions, one also needs to decide how long to run the test. Generally 
it will not be possible to wait until all units have failed. An important part of  planning 
the experiment is to determine how long to run the test or, alternatively, how many of the 
tested units need to fail before a decision should be made. 

Typically, in comparative experiments, with all other things being equal, a decision 
would be made to choose the design that gives the best results in the experiment. Such a 
decision rule would have the largest probability of making the correct decision. When 
planning such an experiment it is important to have some idea about the actual 
probability of making a correct decision. An assessment of this probability can be 
obtained by using SPLIDA ► Comparison of distributions ► Probability of 
correct selection for specified test plans. 

In the dialog in Figure 71, one specifies the assumed distribution, the number of 
populations to be compared, as well as the sample sizes (separated by commas) and the 
corresponding number to fail within each sample size. Then, as with other SPLIDA 
dialoges, click “Apply” and minimize dialog.  

 

 

Figure 71 Dialog requesting a probability of correct selection comparison of three 
different proposed comparison life tests. 



 77

Depending on how many simulations have been requested, the complete simulation may 
take a substantial amount of  time to run. Periodic messages will be printed in the report 
window however, to give an indication of the simulation’s progress. Separate simulations 
are required for each sample size/number of failures pair and the computational time is 
approximately proportional to the number of failures. Figure 72 illustrates the output, 
giving a Probability of Correct Selection curve for each combination of sample size and 
number of failures, as a function of the standardized difference d. See Escobar, Pascual, 
and Meeker (2000) for more information on how to choose d. 

 

Figure 72 Plot showing the probability of correct selection as a function of the 
standardized difference between the populations being compared. 

The jaggedness in the lines is due to the limited number of simulations that were done in 
this example, but such simulations are quick and adequate for most purposes. If smoother 
curves are desired, the simulation sample size can be increased to something like 10000. 
With a capable computer  the time needed for the computations for this example would 
be on the order of a minute. 
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9 Simple Regression and Single-Variable Accelerated Life Test (ALT) Data 
Analysis 

This Chapter describes methods for analyzing life data when there is a single explanatory 
variable. Technical background and further examples illustrating the statistical methods 
used here are given in Chapter 17 of Meeker and Escobar (1998). A common application 
of the methods in this chapter arises in accelerated testing where test units are, for 
example, tested at high temperature with the purpose of obtaining reliability information 
in a timely manner. Models and methods for accelerated testing are described in detail in 
Nelson (1990) and Chapters 18 and 19 of Meeker and Escobar (1998). Chapter 10 
extends the methods of this chapter, allowing for more than one explanatory variable. 

9.1 Scatter plot of censored data 
One should always look first at available data through graphical displays. For single-
variable accelerated test data, a scatter plot of the failure times will provide useful 
information. To illustrate the tools in this section, we use the Device-A data from Hooper 
and Amster (1990), reanalyzed in Section 19.2 of Meeker and Escobar (1998). In order to 
make a scatter plot of the Device-A data, use SPLIDA ► Simple regression (ALT) 
data analysis ► Censored data scatter plot to bring up the dialog shown in 
Figure 73. Then choose the one of the life data objects from the list. We use the Device-A 
life data object in this example (only those life data objects with explanatory variables 
appear in the list). There is only one explanatory variable in the Device-A data object, so 
it is chosen automatically. Then choose the axis scales for the response and the 
explanatory variable. Linear response and linear explanatory variable axes are the 
defaults, but log and Arrhenius axes are chosen for this example, corresponding to the 
physically-suggested lognormal-Arrhenius accelerated lifetime model, described and 
illustrated in Chapters 18 and 19 of Meeker and Escobar (1998). 

 

 

Figure 73 Dialog requesting a censored-data scatter plot of the Device-A data. 
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Finally, click on “Apply” to produce the Arrhenius plot of the data shown in Figure 74. 

 

Figure 74 A censored-data scatter plot of the Device-A data. 

Notice the nonlinear Arrhenius axis for temperature. The open upward-pointing triangles 
in the plot indicate right-censored observations For the Device-A data (as in most 
examples having heavy censoring), the censoring makes it difficult to assess the 
adequacy of the linear relationship between log time and transformed temperature. Still, 
however, there is nothing in the plot to suggest that the relationship does not provide a 
reasonable description of the relationship. 

9.2 Group individual probability plots 
After loooking at a scatter plot of data from a single-variable accelerated life tests, the 
next step in the analysis is usually to make an individual probability plot of the data at 
each level of the accelerating variable (e.g., at each temperature for the Device-A data). 
Such a plot can be made by using  SPLIDA ► Simple regression (ALT) life data 
analysis ► Probability plot and ML fit for individual conditions to request 
the dialog in Figure 75. Then one chooses the life data object and distribution 
(Lognormal was used in this example). Clicking “OK” or “Apply” produces ML 
estimates of the fraction failing at each individual level of temperature. 
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Figure 75 Dialog requesting a lognormal probability plot for the individual temperature levels in the 
Device-A accelerated test. 

 

Figure 76 Lognormal probability plot showing the individual nonparametric and 
parametric estimates of life at the different temperatures in the Device-A 
accelerated life test. 
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Figure 76 shows that the lognormal distribution fits well the data at each level of 
temperature. The slopes of the lines (corresponding to the reciprocal of the lognormal 
shape parameters) vary somewhat (as expected from variability in the data), but not 
systematically.Table 9 summarizes the lognormal distribution ML estimation at each 
individual level of temperature for the Device-A accelerated life test. At 10 degrees C, 
there were no failures so neither nonparametric nor ML estimates could be computed. 
 

Table 9 Tabular output summarizing lognormal distribution ML estimation at each 
individual level of temperature for the Device-A accelerated life test. 

9.3 Probability plot with common shape (slope) parameter 
Many accelerated life test models relate the scale parameter of the life-time distribution 
(location parameter of the log life distribution) to the accelerating variable but have the 
shape of the life-time distribution (scale parameter of the log-life-time distribution) 
constant over all levels of the accelerating variable. Some physical-failure models, such 
as the Arrhenius relationship, suggest such a statistical model. In order to check the 
adequacy of such a model, it is useful to fit the candidate distribution to the data with a 
common shape (slope on a probability plot) assumption. This analysis is similar to that in 
the comparison-of-distributions example in Section 8.3, with Temperature being used as 
a class variable. This analysis can be done with SPLIDA ► Simple regression 
(ALT) life data analysis ► Prob plot and ML fit for indiv cond: common 
shapes (slopes). This dialog, shown in Figure 77, is very similar to that in Figure 75. 
 

[1] “Skipping 10 because too few failures” 

Device A data  

Maximum likelihood estimation results: 

Response units: Hours 

Lognormal Distribution 
  Temp Likelihood    mu  se_mu  sigma se_sigma  
1   10         NA    NA     NA     NA       NA 
2   40    -115.46 9.815 0.4221 1.0083   0.2737 
3   60     -89.72 8.644 0.3474 1.1876   0.3167 
4   80    -115.58 7.084 0.2087 0.8046   0.1553 
 
Total likelihood = -320.8  
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Figure 77 Dialog requesting ML estimates at the different temperatures in the 
Device-A accelerated life test, with lognormal shape parameters constrained to be 
the same. 

Specify the life data object and the distribution and click “OK” or “Apply”  to obtain the 
multiple probability plot in Figure 78.  
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Figure 78 Lognormal probability plot showing ML estimates at the different 
temperatures in the Device-A accelerated life test, with lognormal shape parameters 
constrained to be the same. 

Note the parallel lines in Figure 78, due to the common σ  (standard deviation of log life) 
assumption in the fitted model. 

The tabular output in Table 10 summarizes the lognormal distribution ML estimation for 
the Device-A accelerated life test. The estimate 0b  is the estimate of 40µ  the median of 
log life for the baseline of 40 degrees C (there were no failures at 10 degrees C, so these 
data are not used in the present analysis). The estimates corresponding to Temp60 and 
Temp80 give estimates for the differences  40 60µ µ−  and 40 80µ µ− . As expected, these 
latter two estimates are negative because of shorter life times at the higher temperatures. 
The tabular output in Table 10 can be used to compare this model fit with the 
unconstrained model fit to see if there is strong evidence for a departure from the 
constant-slope assumption. Figure 78 provides a visual assessment of this assumption. 

Table 10 Tabular output summarizing lognormal distribution ML estimation for 
the Device-A accelerated life test.  
Device A data   

Maximum likelihood estimation results: 

Response units: Hours 

Lognormal Distribution 

Relationship  

1 : class      
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Log likelihood at maximum point: -321.5  
Parameter               Approx Conf. Interval 

             MLE            Std.Err.           95% Lower      95% Upper  
    b0  9.7543   0.2465    9.2711   10.2374 
Temp60 -1.2330   0.3119   -1.8443   -0.6217 
Temp80 -2.6634   0.3484   -3.3463   -1.9806 
 sigma  0.9656   0.1320    0.7386    1.2623 

 

 

One can compare the loglikelihoods from fitting the previous two models in order to see 
if the differences among the shape parameters at the three different temperature levels 
could be explained by random variability. In a formal maner we compute 

2[( 320.8 321.5)] 1.4,− − − =    which is small relative to 5.99, the .95 quantile of a chi-square 
distribution with 2 degrees of freedom (the unconstrained model had six parameters 
while the constrained model had four and thus the difference in dimension is two). This 
numerical result suggests that there is not strong evidence of differing slopes. 

In addition to the table of ML estimates of the distribution parameters, one can also 
request a table of failure probabilities or quantiles for any of the levels of the explanatory 
variable in the data by using the options on the Tabular Output of the dialog in Figure 77.  

9.4 Fitting simple regression and accelerated life test models 
Accelerated life tests are often conducted for the purpose of using data at higher-than-
usual levels of some explanatory variable to make predictions of life at lower typical or 
use levels of that variable. A model is used to describe the effect that the explanatory 
variable will have on life. For example, when temperatutre is used to accelerate a failure 
mechanism related to a chemical reaction, the Arrhenius relationship is often suggested 
as a model to describe the effect that temperature will have on life. The data can be used 
to estimate the parameters of this model, as described in Section 19.2 of Meeker and 
Escobar (1998). Use SPLIDA ► Simple regression (ALT) life data ► 
Probability plot and ML fit of a regression (acceleration) model to bring 
up the dialog in Figure 79.  
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Figure 79 Dialog used to request a probability plot showing the ML fit of the 
lognormal/Arrhenius acceleration model to the Device-A data. 

For many single-variable accelerated life tests, the model to be used is initially suggested 
by previous experience or physical theory.  For the Device-A example, the well-known 
Arrhenius relationship will be used to describe the relationship between life and 
temperature, as shown on the dialog. One can also specify additional levels of 
temperature at which to compute and plot estimates of life and associated confidence 
intervals. As with other dialoges, various options for customizing the plots and for 
requesting tabular output are available in the back pages of the dialog.  

Options on the “Model plot” page of the dialog, shown in Figure 80, allows one to 
request and customize a plot of the life versus stress along with the other analyses (hours 
to failure as a function of temperature on log/Arrhenius scales for the Device-A 
example). 
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Figure 80 Dialog showing the options on the “model plot” dialog page. 

To add confidence limits to the plot, visit the Plot options page, ask for “pointwise” 
confidence bands, and highlight the level or levels for which the bands should be plotted 
(generally the use conditions, 10 in this case). 

When all of the requested options have been selected, click on “Apply.” This will 
produce the multiple probability plot in Figure 81, showing the lognormal/Arrhenius 
model estimates of fraction failing as a function of time at the diferent levels of 
temperature in the original  (including 10 Degrees C, where there were no failures) and 
the Model plot in Figure 82.  
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Figure 81 Lognormal probability plot showing the lognormal/Arrhenius model fit to 
the Device-A data with an extrapolation to the use conditions of 10 degrees C, 
including approximate pointwise 95% confidence intervals. 

Table 11 gives a summary of the ML regression output, similar to what one would obtain 
from a standard least squares regression output. 

Table 11 Maximum likelihood estimation results for the lognormal/Arrhenius model 
fit to the Device-A data 

 

Device-A ALT Results   

Maximum likelihood estimation results: 

Response units: Hours 

Lognormal Distribution 

Relationship  

1 : Arrhenius  
Log likelihood at maximum point: -321.7  

Parameter                  Approx Conf. Interval 

MLE Std.Err. 95% Lower 95% Upper  
Intercept -13.4686  2.88719  -19.1274   -7.8098 
     Temp   0.6279  0.08284    0.4655    0.7902 
    sigma   0.9778  0.13265    0.7495    1.2756 
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Figure 82 Model plot on Arrhenius paper for the Device-A accelerated life test data 
and accelerated failure-time densities as a function of temperature. 

There is nothing in either of these plots to indicate any serious departure form the fitted 
model. Of course it should be emphasized that just because the data fits the model well 
within the range of the data this does not imply that one can safely extrapolate out side of 
the range of the data (10 degrees C for the Device-A example). The justification for the 
extrapolation comes from the Arrhenius rate-reaction model from physical chemistry. If 
this model does not adequately describe the effect of temperature on the underlying 
degradation mechanism, then seriously incorrect extrapolations could result. 

9.5 Make life subset data objects for individual groups  
In many applications, under certain circumstances, it will be desired to select one or more 
of the groups of regression data set for more focused analysis. It is possible, for example 
to choose a particular level  or levels of an accelerating variable and do single-
distribution analyses for them. Alternativley, one may want to delete one or more subsets 
from a data set either as a form of sensitivity analysis or because the subset data are 
incorrect.  We will illustrate this by making a subset life data object for the Mylarpoly.ld 
life data object. As described in Section 19.3.1 of Meeker and Escobar (1998), the 
specimens tested at 361.4 kV/mm failed from a failure mode different than those at other 
levels of voltage stress because the voltage stress of 361.4 kV/mm was too high. It is thus 
appropriate to drop these data from the analysis. Using SPLIDA ► Simple 
regression (ALT) life data ► Make life data objects for individual 
groups brings up the dialog like that shown in Figure 83. 
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Figure 83 Dialog requesting the creation of a subset data object for the mylarploy 
data, omitting the 361.4 kV data. 

For the example, we choose the mylarpoly.ld comparison life data object. The voltage 
stress variable kV.per.mm is the only explanatory variable in this life data object, so it is 
automatically highlighted. Then choose the desired levels (all except 361.4 in this case) 
under the list of available levels (or in general combinations of levels). A name for the 
output data object is chosen automatically when the level(s) or combinations of levels are 
chosen, but it is possible to edit this name. In this example, because so many levels were 
chosen, the automatic name is long, so it was edited to read mylarpoly.subset.ld. After 
clicking on “OK” or “Apply” the new life data object is created, in the commands 
window, we get the message “Saving subset data object mylarsub.ld,” and this life 
data object will appear in subsequent lists of accelerated life test or regression life data 
objects. 

 

 

10 Multiple Regression (ALT) Life Data Analysis 
The methods illustrated in Section 9 are easily extended to allow one to fit failure time 
regression models with two or more explanatory variables. The methods presented here 
provide useful extensions to the multiple regression methods covered in a standard course 
in the subject of multiple regression analysis, allowing for non-normal distributions and 
censoring. To illustrate the methods for failure-time regression, we will use the New 
Spring life data (data object NewSpring.ld) from Meeker, Escobar, and Zayac (2003). 
The data came from a factorial experiment to evaluate the life of a new processing 
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method for manufacturing a spring as well as to assess the effect of a processing 
temperature and spring displacement (stroke) on spring life. Spring displacement was 
also to be an accelerating variable (using high values to speed up the test). The tabular 
summary of these data in Table 12 was obtained by using SPLIDA ► 
Make/summary/view/edit data object ► Summary/view data object. 

 

Table 12 Summary of the NewSpring life data object 

10.1 Censored data pairs plot 
As described earlier, data analysis should begin with exploration using graphical tools. 
The dialog in Figure 84, obtained from SPLIDA ► Multiple regression (ALT) life 
data ► Censored data pairs plot, allows the user to plot all pairs of variables in one 
“matrix plot” (also known as a “pairs plot” in S-PLUS).  

 

Number of rows in data matrix= 80  
Response units:  kCycles  
Response minimum:  89  
Response maximum:  5000  
Number of cases in data set= 108  
Number of exact failures in data set= 73  
Number of right censored observations in data set= 35  
No truncation information 
 
Summary of numeric columns in X matrix:   
       min  max   mean      sd    cv  
Stroke  50   70  62.38   7.671 0.123 
  Temp 500 1000 775.00 250.316 0.323 
 
List of unique X values (or combinations)  
   Stroke Temp Method min-Resp max-Resp #Exact #R-cen Total  
 1     50  500    New     5000     5000      0      9     9 
 2     60  500    New     1016     5000      3      6     9 
 3     70  500    New      752     5000      7      2     9 
 4     50  500    Old      997     5000      4      5     9 
 5     60  500    Old      551     4006      9      0     9 
 6     70  500    Old      211     2029      9      0     9 
 7     50 1000    New     1715     5000      2      7     9 
 8     60 1000    New     1595     5000      6      3     9 
 9     70 1000    New      808     4563      9      0     9 
10     50 1000    Old      489     5000      6      3     9 
11     60 1000    Old      371     2630      9      0     9 
12     70 1000    Old       89     1301      9      0     9 
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Figure 84 Dialog to request a censored data pairs plot. 

Figure 85 shows a pairs plot for the NewSpring data. As shown in the simple regression 
example with the Device-A data, the censoring makes it more difficult to interpret a 
scatter plot. The pair-wise plots between Method, Temp, and Stroke show the factorial 
arrangement of the experiment. 

 
Figure 85 Censored data pairs plot showing the NewSpring life versus Stroke, 
Temperature, and Method. 

 

10.2 Censored data scatter plot 
The censored data scatter plot dialog obtained with SPLIDA ► Multiple regression 
(ALT) life data ► Censored data scatter plot is exactly the same as that shown in 
Figure 73, obtained with  SPLIDA ► Simple regression (ALT) data analysis ► 
Censored data scatter plot. As before the dialog allows one to request a single scatter 
plot of the response versus one explanatory variable, with an option to transform either or 
both of the data axes. 

10.3 Probability plot and ML fit for individual conditions 
The dialog obtained from SPLIDA ► Multiple regression (ALT) life data ► 
Probability plot and ML fit for individual conditions, shown in Figure 86 allows one 
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to request separate analyses for all combinations of experimental variable levels in one’s 
data set, with all of the results plotted on one probability plot. 
 

 
Figure 86 Dialog requesting a probability plot showing individual nonparametric 
estimates for each experimental factor level combination on lognormal paper. 

After the dialog appears, choose the life data object (only life data objects with 
explanatory variables appear in the list), a distribution, and all or some of the explanatory 
variables. Then click “Apply” or “OK,” producing a probability plot like that in Figure 
87. 
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Figure 87 Probability plot showing individual nonparametric estimates for each 
experimental factor level combination of the NewSpring data on Weibull paper. 

By using the Plot Options page of the dialog in Figure 86, it is possible to suppress the 
printing of the legend or have it print on a separate page. There is a considerable amount 
of variation among the slopes of the ML estimate lines in Figure 87. This is due to the 
small number of failures at some combinations of voltage and temperature. 
Corresponding numerical results are given in Table 13. NAs are shown for the test 
conditions for which there were not enough failures to compute ML estimates. 
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Table 13 Individual ML estimates for the different NewSpring life test conditions 

10.4 Probability plot and ML fit for individual conditions: common shapes (slopes) 
The methods described in this section are similar to those described in Sections 8.3 and 
9.3 except that more than one explanatory variable can be specified for the analysis. 
Using  SPLIDA ► Multiple regression (ALT) life data ► Prob plot and ML fit for 
indiv cond: common shapes (slopes) brings up a dialog like that in Figure 88. This 
dialog is very much like that obtained with SPLIDA ► Simple regression (ALT) life 
data analysis ► Prob plot and ML fit for indiv cond: common shapes (slopes), 
except that one is allowed to choose more than one explanatory variable (including 
categorical variables, known as “factors” in S-PLUS). Using maximum likelihood, a 
model is fitted that allows the scale parameter of log-location-scale distributions (location 
parameters of location-scale distributions) at the different combinations of experimental 
conditions to vary, but constrains the shape (slope) parameter of the log-location 
distributions (scale parameters of location-scale distributions) to be the same in the 
model. 

 

Maximum likelihood estimation results: 
 
Response units: kCycles 
 
Weibull Distribution 
                               Log likelihood     eta se_eta  beta se_beta  
 1  50Stroke;500Temp;NewMethod             NA      NA     NA    NA      NA 
 2  50Stroke;500Temp;OldMethod         -39.85  6639.6 2122.7 1.868  0.8845 
 3 50Stroke;1000Temp;NewMethod         -21.59 11104.8 7802.5 1.723  1.1772 
 4 50Stroke;1000Temp;OldMethod         -56.45  4430.4 1446.9 1.265  0.4536 
 5  60Stroke;500Temp;NewMethod         -31.17 10101.2 6480.1 1.236  0.6723 
 6  60Stroke;500Temp;OldMethod         -74.39  2193.1  372.5 2.067  0.5406 
 7 60Stroke;1000Temp;NewMethod         -55.10  4781.6  677.9 2.920  1.0591 
 8 60Stroke;1000Temp;OldMethod         -70.45  1606.2  228.4 2.466  0.6460 
 9  70Stroke;500Temp;NewMethod         -63.58  4169.5  700.5 2.250  0.7468 
10  70Stroke;500Temp;OldMethod         -67.43   835.9  194.1 1.521  0.3799 
11 70Stroke;1000Temp;NewMethod         -74.49  2108.8  408.3 1.831  0.4420 
12 70Stroke;1000Temp;OldMethod         -66.08   665.7  169.7 1.378  0.3730 
 
Total log likelihood= -620.6 
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Figure 88 Dialog to request, for the NewSpring ALT data, a probability plot and 
maximum likelihood estimation for individual combinations of the NewSpring 
experimental conditions, but with a common Weibull shape parameter. 

As with previous similar dialoges, choose the life data object, a distribution, the 
explanatory variables to be used, and then click “Apply” or OK, giving the probability 
plot shown in Figure 89. 
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Figure 89 NewSpring ALT data probability plot and maximum likelihood 
estimation for individual combinations of the NewSpring experimental conditions, 
but with a common lognormal shape parameter. 

10.5 Probability plot and ML fit of a regression (acceleration) model  
This section describes the fitting a multiple regression model. The dialog for doing this, 
while similar to the dialog for fitting a one-variable relationship, differs  significantly. 
First, the model specification is more complex because more than one 
variable/relationship combination has to be specified. Relatedly, it is also more 
complicated to specify additional conditions (“new data” in S-PLUS jargon) at which to 
do evaluations of distribution properties like failure probabilities and quantiles. 
Additionally, there is no option on the dialog for a “model plot.” Instead, after a model is 
fit, the user can make a “conditional model plot,” as described in Section 10.6. 

Using SPLIDA ► Multiple regression (ALT) life data ► Probability plot and ML fit 
of a regression (acceleration) model brings up a dialog like the one in Figure 90. In this 
box, one chooses the life data object, a distribution (or the “6 distribution” option) and 
which explanatory variables to use. Then one moves to the model page of the dialog to 
specify the model (i.e., life-explanatory variable relationships). To illustrate these 
features, we continue with the NewSpring example.  
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After the NewSpring.ld life data object has been chosen, one chooses the distribution and 
explanatory variables. The Plot Option and Tabular Output pages of the dialog will show 
(when output options are actually selected) lists of explanatory variable combinations 
from which one can choose one or more combinations for particular focus. For example, 
as with simple regression analyses, one can ask for confidence intervals for ML estimates 
of the cdf (fraction failing as a function of time) on probability plots and for tables of 
distribution quantiles or failure probabilities at specified explanatory variable 
combinations. It is also possible to input user-specified combinations of levels of  the 
explanatory variables (“new data” in S-PLUS jargon) other than those implied by  the 
levels in the input data. This can be done either by the “Direct method”  of entering 
numbers in the “Additional levels for evaluation” box or by specifying an Splus data set 
containing the information with appropriate column headings corresponding to the 
variable names in the lifedata object. The first method is illustrated in the dialog shown in 
Figure 90 where the string of characters 30;600;New,20;600;New is used to specify two 
new conditions for evaluation. Note that semicolons are used to separate the levels within 
a condition and that a comma is used to separate the two conditions. When entering these 
numbers it is sometimes convenient to use the S-PLUS right-click Zoom option. The 
“Save results in:” box gets filled and becomes editable after a the life-explanatory 
variable relationships are chosen on the Model page. 

 

 
Figure 90 Basic page of the multiple regression dialog requesting a probability plot 
and a fitted regression model for the NewSpring data. 
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On the Model page of the dialog (shown in Figure 91), the user first chooses the 
relationships for each of the variables (except that categorical variables-like Method---
factors in S-PLUS jargon---are automatically chosen to be class variables). This choosing 
process is initiated by clicking on the “relationships” button. For the example below, the 
standard log (equivalent to inverse power rule) was chosen for Stroke, a linear (i.e., no 
transformation) for Temperature variables, respectively. By default, the fitted model will 
include only main effects for each of the variables chosen to be in the model (note the 
default equation). It is, however, possible to specify a more complicated model involving 
interactions and polynomial terms, if desired. This is done by specifying a model 
equation, using standard S-PLUS modeling formula. The easiest way to specify such a 
model is by using the Create Formula button, specify main effects and other terms, as 
desired. Then, after dismissing the equation-specification dialog, edit the resulting 
equation (e.g. to remove unwanted interactions). The right-click zoom option for editing 
the equation is useful. 

As with previous dialogs for requesting ML estimation, a Tabular Output page allows the 
user to request tables of distribution quantiles or failure probabilities for specified levels 
or combinations of levels of the explanatory variables. 
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Figure 91 Model-specification page of the multiple regression dialog requesting a 
probability plot showing a fitted regression model for the NewSpring data. 

The Tabular Output page of the dialog in Figure 90, shown in Figure 92, lists the 
available levels of the explanatory variables (this list is full only if the explanatory 
variables have been chosen on the basic page and if one of the boxes for Quantiles 
Estimates or CDF estimates are checked). The user-inputted values appear at the bottom 
of the list. In this case, only the two user-inputted values have been chosen for generating 
the output tables. 
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Figure 92 Tabular Output page of the multiple regression dialog requesting  tables 
of quantile and failure probability estimates at particular levels of the experimental 
variables for the NewSpring data. 

Clicking on “OK” or “Apply” produces the probability plot in Figure 93 and the S-PLUS 
tabular output  shown in Table 14 and Table 15. Table 14 gives the usual regression 
output.  Table 15 shows ML estimates for the (Stroke; Temp; Method) conditions of (30; 
600; New).  The estimates for the conditions (20; 600; New) are not displayed here to 
save some space.. 

Figure 93 shows the probability plot for this example with lines also drawn for the user-
specified combinations of 30 Volts and 5 Degrees C and 30 Volts and 10 Degrees C. The 
legend is covering some of the plotted information, so one might want to exercise the 
Plot Option to suppress or move the legend to a new page. Note that when the model is 
fit, the results are saved in a “results object” 
namedNewSpring.groupm.weibull.StrkLog.TempLinr.MthdClss.out.  Note that the name 
of the results object contains the life data object prefix, distribution name, and 
explanatory variable/relationship combinations, relieving the user from the chore of 
specifying such names and making it easier to distinguish among different results objects 
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when requesting subsequent analyses (e.g., residual plots, conditional model plots, and 
sensitivity analyses). 

 
Table 14 ML estimates for the Weibull distribution acceleration model fit to the NewSpring 
accelerated life test data 

 

 

 
Figure 93 Probability plot showing a fitted Weibull regression model to the NewSpring data.  

NewSpring data   
Maximum likelihood estimation results: 
Response units: kCycles 
Weibull Distribution 
Variable: Relationship (g) 
1 Stroke: Log    
2 Temp: Linear   
3 Method: Class 
 
S-PLUS dummy variable coding method used for Class 
variable(s): contr.treatment,contr.poly  
Model formula: 
Location ~ g(Stroke) + Temp + Method 
Log likelihood at maximum point: -625.8  
 
  Parameter                       Approx Conf. Interval 
                    MLE  Std.Err.  95% Lower   95% Upper  
 (Intercept)  32.026955 2.4843573  27.157704  36.8962056 
   g(Stroke)  -5.509575 0.5872085  -6.660482  -4.3586674 
        Temp  -0.000883 0.0002709  -0.001414  -0.0003521 
      Method  -1.272388 0.1475136  -1.561510  -0.9832671 
       sigma   0.569491 0.0539010   0.473067   0.6855692 
weibull.beta   1.755953 0.1661969   1.458642   2.1138649 
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Table 15 Maximum likelihood estimates of Failure probabilities and distribution quantiles. 

10.6  Conditional model plot 
When a fitted regeression model has more than one explanatory variable, it is still 
possible to make a “model plot” showing time as a function of stress (or other 
explanatory variable). In order to do this, however, it is necessary to specify fixed values 
of the other explanatory variables. Using SPLIDA ► Multiple regression (ALT) 
life data ► Conditional model plot brings up the dialog in Figure 94. When the 
dialog appears, it will remember the most recent results object (if the analysis was done 
in the current session). In this case the remembered name is 
NewSpring.groupm.weibull.StrkLog.TempLinr.MthdClss.out. Suppose now that design 
engineers want to estimate the life distribution of the spring manufactured with the new 
method with a processing temperature of 600 degrees F for different levels of stroke 
ranging between 10 and 80 mils.  After specifying this information and clicking on 
“Apply” or “OK,” produces a plot like that in Figure 96. 

 

Failure Probability Estimates 
 
Using NewSpring data at  Stroke30;Temp600;MethodNew 
Parametric ML CDF Estimates  
Pointwise Approximate 95% Confidence Intervals 
 
 Weibull Distribution 
 
  kCycles        Fhat    Std.Err.   95% Lower   95% Upper  
       50 1.7949e-007 2.5544e-007 1.1031e-008 2.9204e-006 
      100 6.0622e-007 8.0559e-007 4.4822e-008 8.1990e-006 
      200 2.0475e-006 2.5350e-006 1.8087e-007 2.3178e-005 
      500 1.0233e-005 1.1511e-005 1.1282e-006 9.2798e-005 
     1000 3.4560e-005 3.6150e-005 4.4482e-006 2.6846e-004 
     2000 1.1672e-004 1.1372e-004 1.7290e-005 7.8753e-004 
     5000 5.8320e-004 5.2102e-004 1.0119e-004 3.3535e-003 
 
Quantile Estimates 
 
Using NewSpring data at  Stroke30;Temp600;MethodNew 
Parametric ML Quantile Estimates  
Pointwise Approximate 95% Confidence Intervals 
 
 Weibull Distribution 
 
     p Quanhat Std.Err. 95% Lower 95% Upper  
  0.01   25293    11573     10316     62011 
  0.05   63992    28770     26512    154459 
  0.10   96419    43532     39797    233600 
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Figure 94 Dialog for a conditional model plot. 
 

 

Figure 95 Plot options page for a conditional model plot. 

 
 



 104

 
Figure 96 Conditional model plot showing estimated NewSpring life versus stroke 
for the new processing method and temperature fixed at 600 degrees F. 

10.7   Sensitivity analysis plot 
Generally when fitting several alternative models to data, among the models that fit the 
data well, there is usually relatively little difference in the results from the fitted models, 
as long as one is working within the range of one’s data. SPLIDA has a powerful tool 
that allows one to compare directly alternative analyses with different underlying model 
assumptions. Using SPLIDA ► Multiple regression (ALT) life data analysis 
► Sensitivity analysis plot brings up the  dialog in Figure 97. Similar to the 
“Conditional model plot dialog”, the name of the last results structure used in the current 
session is remembered, but any of the other existing results structures could be selected 
instead. The primary model purturbation used in the sensitivity analysis is the 
relationship assumption relating a continuous explanatory variable to life. This is done by 
fitting separate models using several different choices for the  parameter in the Box-Cox 
family of transformations on the chosen numerical explanatory variable. The default 
values are from –1 to 2, in steps of .5, but this was changed to run from –4 to 3 in steps 0f 
.25. The output is a plot of the ML estimate of a selected quantile (or quantiles) as a 
function of the Box-Cox parameter (1 is the same as a linear transformation, .5 is the 
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same as a square root relationship, 0 corresponds to a log relationship, and –1 
corresponds to a reciprocal relationship).  

 

 
Figure 97 Dialog requesting sensitivity analysis for the assumed relationship 
between spring life manufactured with the new method at 600 degrees F and 
operated with a stroke of 30 mils. 

 
If only one quantile and one distribution are used in the comparison (the default), 
pointwise confidence intervals for the quantile are also plotted, as shown in Figure 98  
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Figure 98 Sensitivity analysis plot showing the effect on spring life of the assumed 
relationship between life and stroke for a spring manufactured using the new 
method at 600 degrees F and operated with a stroke of 30 mils. 

Also provided is a plot, like that shown in Figure 99, of the profile likelihood function for 
the Box-Cox parameter. This plot allows an assessment of the statistical power to 
discriminate among the different relationship parameters. Note that if there are only two 
levels of the transformed explanatory variable, the profile likelihood will be constant 
because there is no information in the data to discriminate among different 
transformations on that explanatory variable. 
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Figure 99 Profile plot showing the relative likelihood (probability) of the NewSpring   
data as a function of the stroke relationship Box-Cox parameter. 

In this case, the profile likelihood suggests that a transformation with the Box-Cox 
parameter between –4 and 3 are  consistent with the data.. Based on previous, 
transformations used typically used for similar products have been 0 (corresponding to a 
log transformation). To be conservative, however, values between 1 and  3 might be used 
in reporting a plausible range of results. 

 

10.8 Make life data objects for individual groups  
It may, under certain  circunstances be desired to select one or more of the groups of 
regression data for more focused analysis. It is possible, for example to choose a 
particular combination of levels of explanatory variables and do separate analyses for 
them. We will illustrate this by making a separate life data object for the new design 
within the NewSpring life data object. Using SPLIDA ► Simple regression (ALT) 
life data ► Make subset life data object brings up the dialog in Figure 100. 
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Figure 100 Dialog requesting the creation of a life data object using only the New 
Design data from the NewSpring lifedata object. 

After clicking on “OK” or “Apply” the new life data object is created, we get the 
message “Saving subset data object NewSpring.NewMethod.ld,” and this life data 
object will appear in subsequent lists of single distribution life data object.  

 

 

11 Regression Residual Plots 
In any kind of statistical modeling, it is important to look for departures from models 
being fitted to data. This is especially true for regression models in which explanatory 
variables like temperature and humidity are used to describe the characteristics of a 
response variable like life time. Because it is possible to specify most model assumptions 
in terms of characteristics of model residuals (deviations between the response and some 
definition of expected or typical response), a useful method of diagnostic checking is to 
examine a model’s residuals, usually with various graphical displays. Examples 
illustrating the use of and some technical details concerning the definition of residuals for 
censored data are given in Section 17.6 of Meeker and Escobar (1998). We will illustrate 
the use of the SPLIDA’s residual plotting capabilities with the mylar-polyurethane 
insulating structure accelerated life test data, analyzed in Section 19.3.1 of Meeker and 
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Escobar (1998). The ML analysis results object is 
(NewSpring.groupm.weibull.StrkLog.TempLinr.MthdClss.out). 

 

Using SPLIDA ► Multiple regression (ALT) analysis ► Residual analysis 
brings up the dialog in Figure 101. By default, all of the possible residual plots are 
selected, but it is easy to select one or a few of the possible plots. The Modify plot 
axes page becomes active and can be used to control the plot axes if there is just one 
plot chosen. 

 

Figure 101 Dialog requesting residuals plots for the NewSpring regression model 

 

11.1 Residuals versus fitted values 
It is common practice to plot residuals versus fitted values. Such a plot is useful for 
detecting departures from the structural model as well as model departures like 
nonconstant spread. Figure 102 shows a plot of the residuals versus the fitted values for 
NewSpring regression model. Notice that many of the residuals are right censored and 
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that this limits the amount of information in the plot. 

 

Figure 102 Plot of the regression residuals for the laminate panel data versus fitted 
values. 

11.2  Residuals versus possible explanatory variables 
The residual from a regression model should not have a strong relationship with any 
other external variable. If such a relationship is discovered, it suggests that the variable 
should have been included into the model. To illustrate this we return to the NewSpring 
data used in Section 10.5, but using a model in which life is related to Stroke and Method 
only, omitting the temperature variable (this will be referred to as the reduced model).   

 

 

  

The results object for the reduced model is chosen (actually it is remembered as the 
default choice if the model was fit just before bringing up the dialog). Then DegreesC is 
chosen as the variable against which to plot.  Clicking on “Apply” or “OK”  gives the 
plot shown in Figure 103. 
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Figure 103 Residuals for the Weibull/inverse power relationship model for the 
NewSpring  data plotted against the omitted variable Temperature. 

The plot suggests some relationship between the residuals and Temperature, although the 
relationship does not seem to be strong. 

11.3  Residuals versus observation number 
In some studies, data are obtained over time and the order of the cases in the resulting 
data set may have some importance. For example, if units are tested sequentially, one at a 
time, on a machine to do fatigue cycling, it is possible that some underlying “lurking 
factor”  has an effect on the response. For example, there may be gradual drift of machine 
settings or  an effect due to changes in ambient temperature or other environmental 
conditions. An analyst can check for such underlying time-dependent changes in a 
process by plotting residuals versus time order of the observations. Of course, in order for 
such a plot to be meaningful, it is necessary that the case ordering in the data set 
correspond to the actual time ordering that units were tested. If (as is often the case) 
available data are ordered according to observed failure time (which might be the natural 
ordering for commonly-used simultaneous testing) or according to explanatory variable 
levels, the potentially important time-sequence information is lost and plots made versus 
time order would probably have no meaning. 

  

11.4  Residual probability plot 
As described in Section 17.6 of Meeker and Escobar (1998), residuals from a regression 
model, even with censoring, can be examined with the use of standard probability 
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plotting methods. Residual probability plots are useful for assessing the reasonableness of 
particular distribution choice for a regression model. The multiple probability plots used 
in Sections 9 and 10 are useful for making this assessment at individual conditions. After 
fitting an overall model, however, plotting the residuals provides more information on the 
adequacy of the overall distribution.  

  

Figure 104 is a residual  probability plot for the laminate panel data. 
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Figure 104 Probability plot of the regression residuals for the laminate panel data. 

12 Planning an Acccelerated Life Test (ALT) 
Accelerated life tests (ALTs) are complicated and expensive experiments. Careful 
planning of such experiments is important. SPLIDA provides tools for generating, 
modifying, and evaluating accelerated life test plans. To use the evaluation tools, on must 
first specify model information (or planning information) and the proposed test plan(s).  

12.1 Specification of ALT plan values 
The first step in the development and evaluation of ALT plans is specification of  a 
model and planning values for the model parameters. Generally such informatioin is 
obtained from previous experience with similar materials  or products or engineering 
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analysis and judgement. Using SPLIDA ► Plan an accelerated life test ► 
Specify ALT model information (planning values)  brings up a dialog like the 
one shown in  Figure 105.  

 

Figure 105  Dialog for specifying ALT-planning values. 

As an example, we will specify the planning values corresponding to the adhesive bond 
used in Example 20.1 on page 535 of Meeker and Escobar (1998). On the Basic page of 
the dialog, change “last.ALTpv” to the more descriptive AdhesiveBond.ALTpv, choose a 
distribution (Weibull in this case), and edit the time units cell to the more descriptive 
“Days,” as shown in Figure 105. Note that the distribution name was automatically 
inserted into the “Save results in” cell (the alt planning values object name is too large to 
see completely without using the right-click-Zoom option in the cell). Although it is not 
required to enter the use conditions, it is convenient to do so (because the use conditions 
will not have to be specified later, although there is opportunity to modify the use 
conditions at any time). For the adhesive bond example, the use condition is 50 degrees 
C. 

 

Then click  the Relationships button to launch pop-ups for each accelerating variable. 
You must choose the relationship (transformation) for each accelerating variable. For the 
AdhesiveBond example, there is only one explanatory variable; choose Arrhenius. Then, 
if you visit the Relationship(s) page, you can see the chosen relationship(s). 

 

Now, visit the Parameters page. In order to specify the ALT model parameters, on this 
page you must specify: 
 

• The failure probability or quantile at a specific set of operating conditions 
 

• The regression (or accelerating variable) model coefficients, and 
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• The distribution shape (spread) parameter. 
 

For the adhesive bond example, the responsible engineers in the past had used a Weibull 
distribution to model the life of adhesives and the Weibull shape parameter was typically 
in the neighborhood of 1.667. In addition, for purposes of planning, the .001 quantile of 
the life distribution at 50 degrees C is specified as 183 days (or equivalently, the failure 
probability at 50 degrees and 183 days is specified to be .001). Additionally, the slope 
parameter in the life-temperature relationship is the effective activation energy (.7265 in 
eV). The completed dialog is shown in Figure 106. Click on “Apply” to create the ALT 
planning value object. 

 

 

Figure 106 Completed parameter page of the accelerated life test planning values 
dialog. 

12.2 Specification of an ALT test plan 
In order to specify an ALT plan, use SPLIDA ► Plan an accelerated life test ► 
Specify ALT test plan to bring up a dialog like that shown in Figure 107. There are 
two different methods for specifying an ALT test plan. For the “Direct method” the plan 
characteristics for a test plan are entered directly into the dialog. For test plans with more 
than one explanatory variable, a factorial experiment is produced (and if a fraction of this 
factorial is desired, this is accomplished by modifying the test plan, as described in 
Section 12.4. In the “Frame” method, a test plan is first entered into an S-PLUS data set 
specified in the dialog.  

Figure 107 illustrates the direct method. Specify the number of accelerating variable 
levels; and change the default accelerating variable name(s). At this point, click  the 
Choose levels button. There will be a popup window for each of the accelerating 
variables. In each popup window, you will need to specify the levels of the experimental 
variable. In this case the levels for DegreesC are: 78, 98, 120.  Next, specify the number 
of units to be allocated to each subexperiment (only a single number is allowed here; if 
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you want to have a different number allocated to different subexperiments, this is 
accomplished by editing the test plan, as shown in Section 12.4). Then, enter the type of 
censoring, and the censoring time (again, if you want to have different censoring times at 
different subexperiments, this will be accomplished by editing the plan later). You may 
also want to specify a particular prefix for the test plan object name (AdhesiveBond1 in 
the example). The default suffix last.ALTplan is provided automatically. Then provide 
the actual plan information. 

 
 

Figure 107 Completed dialog specifying an ALT plan. 

After the plan is specified, click on “OK” or “Apply” (in case that you want to make 
more than one related plan). To specify a second or third test plan, edit the dialog and the 
suffix of the plan object name (e.g., use AhhesiveBond2 so that the previously specified 
plan(s) will not be overwritten) and again press “OK” or “Apply”. 

 

12.3 Generating special ALT test plans 
When planning an ALT with a single accelerating variable, SPLIDA can be used to 
generate some special plans such as the following:  
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• Traditional plans that use equally spaced levels of the accelerating variable and 
equal allocation of test units to each level of the accelerating variable.   

• Optimum test plans that minimize the large sample variance of a particular 
quantile of interest. Such plans may not be practical (e.g., because they test units 
at only two levels of the explanatory variables) but they provide a baseline for the 
best that one can do and insight into what is needed to develop a plan that is 
statistically efficient. 

• Constrained optimum (or compromise) test plans that have three distinct levels of 
the accelerating variable with something like 15% or 20% of the test units 
constrained to be tested at the middle level of the accelerating variable. 

• Equal expected number failing test plans which are constrained to have three 
distinct levels of the explanatory variable with the expected number failing the 
same at each of the levels. 

Figure 108 shows the dialog to request the optimum test plan for the Adhesive Bond 
example, this plan and its evaluation are given in Table 16.  

More information about plans like these can be found in Chapter 20 of Meeker and 
Escobar (1998). 

 

 

Figure 108 Dialog to generate an optimum ALT plan 
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 Optimum test plan based on AdhesiveBond.Weibull.altpv 
 
Test plan summary: 
  DegreesC   n ctime  zeta       p efail  
1   94.652 212   183 -1.63 0.17838 37.82 
3  120.000  88   183  0.84 0.90054 79.25 
 
Evaluation at use conditions 50 DegreesC  
 Quantile   Days    Ase R-Factor  
      0.1 2990.1 1133.3   2.1019 

Table 16 Output from the generation of the AdhesiveBond optimum ALT plan 

 

12.4 Modify an ALT test plan 
Suppose that we want to modify the plan that we specified in Section 12.2 so that the 
allocations are 155, 60, and 84 specimens tested at 78, 98, and 120 degrees C, 
respectively. Use SPLIDA ► Plan an accelerated life test ► Modify ALT plan to 
bring up the dialog in Figure 109. Choose the AdhesiveBond1.altplan  test plan object, 
and then click on the Edit plan button to bring up the plan’s edit worksheet. 

 

 

Figure 109 Dialog and edit worksheet for modifying the AhesiveBond1.ALTplan ALT test plan 
object 

Edit the number.units column and click on Apply. This will create the new test plan with 
the same name. If a new test plan with a new name had been desired, one can choose the 
New name  Option and then edit the Save results in box. 
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12.5 Sample size for an ALT test plan 
Using SPLIDA ► Plan an accelerated life test ► Sample size for an ALT test plan 
will bring up the dialog in Figure 110. After choosing the plan values and the test plan 
objects, enter the use conditions, and click on Apply. This will generate the plot in Figure 
111. This plot is used in the same way as the sample size plot for a single distribution, 
described in Section 6.3. For example, the rectangle tool in the S-PLUS annotate toolbar 
can be used to draw in a rectangle to show that the predicted precision factor for an 
approximate 95% confidence interval for the .1 quantile for this ALT plan is R=2.3. 

 

 

Figure 110 Dialog for the SPLIDA sample size tool 
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Figure 111 Plot of required sample size as a function of the precision factor R for 
the AdhesiveBond accelerated life test example. 

12.6 Summarization and approximate evaluation of a specified ALT test plan 
Using SPLIDA ► Plan an accelerated life test ► Summarize, evaluate, and plot an 
ALT test plan will bring up the dialog shown in Figure 112. In this box, one specifies 
the ALT plan values object (AdhesiveBond.Weibull.altpv in this case), the ALT test plan 
object (AdhesiveBond1.altplan) to be evaluated, and the use conditions (50 Degrees C for 
the adhesive bond). By default, the output produced includes a tabular summary and a 
plot summary of the specified ALT test plan. Figure 113 shows an Arrhenius plot for the 
adhesive bond test plan specified in Figure 107, using the planning values that were 
specified in Figure 106.  
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Figure 112 Dialog asking for a summary evaluation and plot of a proposed 
accelerated life test plan for the adhesive bond example. 

The  output in Table 17 provides a printed summary of the planning values and the test 
plan, followed by a listing of the large-sample approximate standard deviation and 
confidence interval precision factor for confidence intervals corresponding to each of the 
quantiles listed in the  “Plot, summarize/evaluate ALT Plan” dialog shown in Figure 112. 

Table 17 ALT planning information and test plan specification for the adhesive 
bond example. 
Accelerated test planning values  
Distribution:  Weibull   
Relationship:  Arrhenius   
Time units:  Days   
  
For a censoring time of 183 Days   

the failure probability at 50 Degrees C  is:  0.001   

Intercept is:  -16.7     
slope =  0.726   
  
weibull.beta =  1.67   
sigma =  0.6   
 
Accelerated Test Plan 

  level number censor.time     xi    pi    prfail Efail  
1    78    155         183 0.4478 0.518 0.0315772  4.89 
2    98     60         183 0.7264 0.201 0.242189  14.5  
3   120     84         183 1      0.281 0.900543  75.6  
 
Use condition is 50 Degrees C  
Total number of test units= 299  
The large sample approximate standard deviation 
of the 0.1 log quantile at 50 Degrees C  = 0.4378  
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corresponding to a 95% confidence precision factor or R= 2.358  
The large sample approximate standard deviation 
of the 0.5 log quantile at 50 Degrees C  = 0.4911  
corresponding to a 95% confidence precision factor or R= 2.619  
The large sample approximate standard deviation 
of the 0.9 log quantile at 50 Degrees C  = 0.532  
corresponding to a 95% confidence precision factor or R= 2.837  
 
Note that the 95% confidence precision factor for the .1 quantile is 2.358, which agrees 
closely with the factor read from Figure 111. 
 

 
Figure 113 Arrhenius plot showing a proposed test plan for the Adhesive Bond 
example. 

12.7 Simulation of an ALT test plan 
Although the approximate evaluation given above is useful, doing a simulation of a 
proposed ALT test plan avoids the use of large-sample approximations (which may not 
be adequate when some of the test conditions have expected numbers of failures that are 
small) and will provide insight into the limitations of a proposed test plan. Using 
SPLIDA ► Plan an accelerated life test ► Simulate an ALT test plan 
brings up the dialog in  Figure 114, allowing the user to request a simulation of a 
proposed ALT test plan. 
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Figure 114 Dialog requesting a simulation to evaluate a proposed accelerated life 
test plan for the adhesive bond example. 

Then specify the previously created ALT plan values (e.g., 
AdhesiveBond.Weibull.altpv), the ALT test plan object (e.g., 
AdhesiveBond1.Weibull.ALTplan). If they were specified in the planning 
values object, the Use condition level will use that value (those values) as the default 
entry, but the box is editable. There is also an option to see some details of the analyses 
of the individual simulated samples. Looking at four or five such samples in a new 
situation can be useful.  

After completing the dialog, click on “Apply.” The simulation will then begin to run, 
giving an indication of progress in the output window (completing the simulation will 
take from a few seconds to a few minutes depending on the number of simulations 
requested and processor speed (500 simulations is sufficient for most purposes). When 
completed, five new multiple probability plots, summarizing the first five simulated data 
objects, will have been created. For the adhesive bond example, one of these is shown in 
Figure 115. Note the deviation from a straight line is the lower tails of the distributions at 
98 and 120 degrees C. For an experienced analyst, this behavior is expected, as the 
observations in the lower tail of a normal distribution have the most variability (the same 
is true of the largest observations from a normal distribution, but these observations have 
been censored). 
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Figure 115 Multiple probability plot for one of the simulated adhesive bond ALT experiments 
 

In addition, a summary of the results is depicted in a quantile-life versus accelerating 
variable plot for each of the accelerating variables (an Arrhenius plot for the example), as 
shown in Figure 116. The results of the simulation are saved in a file (by default, the 
name of this file is obtained by pasting together the names of the planning values object 
and the test plan object (AdhesiveBond1.altplan.AdhesiveBond.Weibull.altpv.alt.sim.out 
for the example). By using this file, one can produce other summaries of the simulation 
results, as described in Section 12.8. 

Note also that SPLIDA saves the last simulated ALT life data object as last.sim.ALT.ld. 
One can use all of the SPLIDA ALT data analysis tools to analyze these data to gain 
experience in analyzing such data and to get a sense of the information that can be 
expected from the experiment. 
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Figure 116 Arrhenius plot showing a summary of the simulation of the proposed 
accelerated life test for the Adhesive Bond. 

  

 

12.8 Evaluation of ALT test plan simulation results 
 
Although SPLIDA automatically presents the summary of the simulated results shown in 
Figure 116, an analyst may be interested in other summaries of the simulation results. To 
produce such summaries, use SPLIDA ► Plan an accelerated life test ► 
Summarize an ALT simulation to bring up the dialog in Figure 117. This dialog 
allows the user to request some or all of three different kinds of simulation summaries. 
The first page, shown in Figure 117, requires specification of the ALT simulation results 
object (SPLIDA will remember the most recent results object if it was created in the 
current session). This page also allows the user to choose one or both of two overall 
summary plots:  
 

• A plot of a specified quantile versus the accelerating variable 
• A plot of the fraction failing as a function of time at a specified level(s) of the 

accelerating variable(s) 
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For the time versus the accelerating variable plot, the user can choose the quantile to plot. 
For the fraction failing as a function of time plot, the user can choose the level of the 
accelerating variable, as shown in Figure 117. 
 

 
Figure 117 Dialog used to request  summarizations of an ALT simulation 

 
In addition to these summary plots, one can also choose to make summary plots of two 
specified “focus quantities.” A focus quantity is a quantity of interest: a parameter, a 
specified quantile, or a failure probability at a given level (or levels) of the accelerating 
variable(s). Specification of the focus quantities is from the Focus quantities page 
of the Summarize ALT simulation results Dialog shown in Figure 118. Two 
different focus quantities should be chosen. Then one can choose to look at the joint 
distribution of the simulated estimates, the marginal distribution, or both at the same 
time.  
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Figure 118 Dialog to specify details of summarization of ALT focus quantities 

 
After completing the dialog, click on “Apply” to generate the summary graphics. First, 
another plot like that in Figure 116 is generated (although a different quantile of a 
different level of temperature could have been used). Figure 119 is a plot of the ML 
estimates of the fraction failing at 50 Degrees C, as a function of time. Figure 120 shows 
the joint distribution of the ML estimates of β1 (the effective activation energy) and 
F(1830), the fraction failing at 1830 days (about 5 years), at the nominal use conditions 
of 50 Degrees C. This type of plot provides important insights and explanations for the 
results from ALT experiments. For example, the negative association between of β1 and 
F(1830) suggests that larger estimates of β1 will lead to smaller estimates of failure 
probabilities. 
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Figure 119 ALT simulation summary plot of ML estimates of fraction failing as a function of time 

 
 

 

Figure 120 ALT simulation summary plots of ML estimates F(1830) and 1β  (effective activation 
energy) 
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SPLIDA chooses default values for the ranges of the axes of these plots. It is possible for 
the user to control these if the dialog is requesting only one of the three kinds of plots. In 
order to do this, the dialog must be set so that only one of the three different kinds of lots 
is being requested. In this case, the controls on the Modify plot axes page will 
become active. 

12.9 Compute acceleration factors 
SPLIDA provides a tool for computing acceleration factors for the simple acceleration 
models. Use SPLIDA ► Plan an accelerated life test ► Compute 
acceleration factor to bring up the dialog illustrated in Figure 121. Specify the range 
of accelerating variable levels of interest (the smallest being the use cnditions and the 
highest being the highest testing level), the acceleration model. Also, provide the 
acceleration model regression coefficient (effective activation energy for the Arrhenius 
model and power for the inverse power relationship). Several values can be provided at 
one time, as shown in Figure 121. Then click on Apply to get a plot of the acceleration 
factor across the specified range of the accelerating variable, as shown in Figure 122. 

 
Figure 121 Dialog to compute acceleration factors and make a plot of acceleration 
factor versus temperature. 
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Figure 122 Plot of acceleration factors with different assumed activations energies 
(in units of eV). 

 
 

13 Recurrence (point process) data analysis 
Recurrence data (also known as point process data) arise when events are tracked on a 
collection (or sample) of units over time. Such data arise in many different applications. 
For example, in field tracking, a group of units is monitored over time and a record is 
kept of repairs for individual units, perhaps consisting of data, type of repair, and the cost 
of the repair. Interest, for example, may center on the recurrence rate or on the average 
cumulative cost of system maintenance as a function of time.  

13.1 Structure of recurrence data 
In its detailed form (used in this chapter), recurrence data consists of information on the 
times and nature of events on a collection of units under observation. An event can be a 
recurrence (“Fail” or “Repair” or some other name of the recurrence), the beginning of an 
observation period (“Start”) or the end of an observation period (“End”).  
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Usually, units are under continuous observation for some specified period of time. 
During that time, there may be one or more “recurrences” or “events.” In other 
applications, recurrences for a unit may be observed only during “windows of 
opportunity” (outside of these windows events that occur are not observed). Each event 
may have an associated “cost” or other value (if not, the default value is 1.0, indicating a 
counting process).  
 
To illustrate the structure of the data needed by SPLIDA, we will present three simple 
“toy” examples, but point to corresponding real examples available among the example 
SPLIDA data sets. 
 
 
Example 13.1 Three vehicles observed continuously over time with events for all 
vehicles. 
 
Vehicle Weeks Event Cost 
V1  0 Start 0 
V1  39 Fail 234 
V1  44 Fail 441 
V1  50 Fail 120 
V1  80 Fail 233 
V1  81 Fail 671 
V1  92 End 0 
V2  0 Start 0 
V2  31 Fail 211 
V2  73 Fail 432 
V2  98 Fail 654 
V2  102 Fail 112 
V2  112 Fail 256 
V2  118 Fail 115 
V2  119 End 0 
V3  0 Start 0 
V3  225 Fail 187 
V3  340 End 0 
 
Example 13.1 illustrates the simplest and most common structure where units begin 
observation at time 0 and are monitored continuously (more or less) until observation 
terminates for some reason (e.g., the unit is taken out of service, fails catastrophically, or 
it is still in service at the time of data analysis). The Start lines are optional if there is 
only one per unit and the time of start is 0. The End line is optional if the end of the 
observation period is the time of the last recurrence. Examples of data set like this in the 
SPLIDA collection include MachineH.txt, Cylinder.txt, and ValveSeat.txt. 
 
Example 13.2 Same three vehicles from Example 13.1, but observed in windows of 
opportunity with observed events for two of the three vehicles. 
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Vehicle Weeks Event Cost 
V1  0 Start 0 
V1  39 Fail 234 
V1  40 End 0 
V1  75 Start 0 
V1  80 Fail 233 
V1  81 Fail 671 
V1  90 End 0 
V2  0 Start 0 
V2  31 Fail 211 
V2  40 End 0  
V2  100 Start 0 
V2  102 Fail 112 
V2  112 Fail 256  
V2  115 End 0  
V3  0 Start 0  
V3  55 End 0  
V3  120 Start 0  
V3  205 End 0   
V3  300 Start 0 
V3  340 End 0 
 
 
In Example 13.2, there are (required) Start/End pairs for each unit and these define the 
observation windows of opportunity. Examples of data set like this in the SPLIDA 
collection include AMSAAWindow1.xls, and AMSAAWindow2.xls. 
 
 
Example 13.3 Fifty vehicles observed continuously over time with events for only 
four vehicles. 
 
Vehicle Weeks Event Cost 
V1  0 Start 0 
V1  55 Fail 234 
V1  150 End 0 
V2  0 Start 0 
V2  57 Fail 211 
V2  78 Fail 432  
V2  150 End 0 
V3  0 Start 0 
V3  112 Fail 187 
V3  198 End 0  
V4  0 Start 0 
V4  225 Fail 187 
V4  340 End 0 
VG1  0 Mstart 14  
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VG1  230 Mend 14  
VG1  0 Mstart 32  
VG1  200 Mend 32 
 
 
Example 13.3 contains Mstart/Mend pairs for groups of units that had no recurrences. 
Such data arise frequently in warranty data in which some units are returned, but large 
numbers of units are not returned. Using Mstart/Mend pairs for groups of units relieves 
us of having to specify large numbers of Start/End pairs. An example of a data set like 
this in the SPLIDA collection is R4490.txt. 
 
 

13.2 Creating a recurrence data object 
As with life data, to do a SPLIDA analysis of recurrence data, one first has to construct a 
recurrence data object. Because the structure of recurrence data is different from that of 
life data, there is a different dialog to making a recurrence data object. SPLIDA ► 
Make/edit/summary/view data object ► Make a recurrence (point 
process) data object to bring up the dialog in Figure 123.  

 

 
Figure 123  Dialog used to make a  recurrence data object. 

Clicking on the Choose data set arrow in the dialog illustrated in Figure 123 will show 
all of the data sets in the SPLIDA database and in the user’s working database. Only 
some of these will be appropriate for making a repeated measures data object. SPLIDA 
has no way to distinguish among different generic data sets (as it attempts to do with data 
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objects when it decides which to put into a list available for use), so all data sets appear 
in the list.  

After choosing a data set corresponding to a recurrence data set, one must choose the 
time, unit identifier, and the status/event columns from the frame (all are required for 
recurrence data). The dialog in Figure 123 uses the earth-moving machine maintenance 
data (MachineH is the frame name) from Chapter 16 of Meeker and Escobar (1998). For 
the earth-moving machine data there is also a cost variable giving the cost of each 
reported maintenance action. Because cost was of primary interest in this application, this 
variable is also specified in the dialog. When the needed inputs have been specified, click 
on “OK” or “Apply” to create the data object. In addition to creating the recurrence data 
object, a short summary of the data in the object is provided (as shown in Table 18) and, 
if desired a printout of the data can be requested by using the Output Options page of 
the dialog. 

 

Table 18 Summary of: Earth-Moving Machine Maintenance Data in MachineH.rdu 

 

13.3 Recurrence data event plot 
As with the analysis of other types of data, one should start with simple graphical 
methods that provide insight into the nature of the data. Using SPLIDA ► 
Recurrence data analysis ► Recurrence event plot will produce the dialog in 
Figure 124. In this dialog one specifies the name of a recurrence data. There are options 
to print the events for a subset of the data. This option is useful when there are a large 
number of units in a data set. 

 

Summary of   Earth-Moving Machine Repair Labor Hours data 
Number of rows in data matrix= 573  
Number of units in the recurrence data object:  23  
Number of event times = 550  
Total cost/weight of events in the recurrence data set= 1958.7  
Response units:  Hours  
Response minimum:  52  
Response maximum:  9249.5 
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Figure 124 Dialog requesting an event plot for the earth-moving machine (Machine 
H) maintenance data. 

Then, clicking “Apply” produces the event plot in Figure 125, allowing one to visualize 
the events (maintenance actions in this example) as they unfolded in time (measured in 
hours of operation for this example). 

 
Figure 125 Event plot for the earth-moving machine  (Machine H) maintenance 

data. 
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13.4 Recurrence data mean cumulative function 
Using SPLIDA ► Recurrence data analysis ► Mean cumulative function 
plot will generate a dialog from like that shown in Figure 126, from which one can 
request a plot of the mean cumulative function (MCF) and corresponding pointwise 
confidence intervals for a recurrence data set. There is an option to request a table giving 
the same information. Clicking on Apply will give a plot like that in Figure 127. . 

 

 
Figure 126 Dialog requesting a mean cumulative function (MCF) plot for the earth-
moving machine (Machine H) maintenance data. 

Figure 127shows the MCF for the earth-moving machine data. As described in Example 
16.6 of Meeker and Escobar (1998), some of the irregular behavior in this function in the 
early part of life can be traced to the regularly scheduled maintenance of the machines in 
the fleet. 
 



 136

 
Figure 127  Mean cumulative function (MCF) plot for the earth-moving machine (Machine 
H) maintenance data. 

 
In some applications, there is a need to compare recurrence data from two fleets, 
manufacturers, methods, etc.  The dialog obtained from SPLIDA ► Recurrence 
data analysis ► Compare two mean cumulative functions plot, shown in 
Figure 128, allows one to request a plot making such a comparison.  As an example, we 
use data from Doganaksoy and Nelson (1991) on the lifetime of breaking grids used in 
locomotives. This example was also used in Section 16.3 of Meeker and Escobar (1998). 
The plot in Figure 129 shows an estimate of the difference between the MCF functions 
for two different production batches of breaking grids along with corresponding 
pointwise confidence intervals. Because the zero line falls outside of the pointwise 
confidence interval, the plot suggests that there is a statistically important difference 
between the two batches. 

 



 137

 
Figure 128 Dialog requesting a plot comparing two mean cumulative function (MCF) plots. 

 

 
Figure 129 Plot comparing two mean cumulative function (MCF) plots. 

13.5 Convert renewal recurrence data to life data (not yet available) 
Using SPLIDA ► Recurrence data analysis ► Convert renewal 
recurrence data to life data will allow the user to convert certain kinds of 
recurrence data into life data. The underlying assumption that is needed for the output of 
the conversion to provide data that will not be misleading is that the randomness in times 
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between events (perhaps conditioned on some explanatory variables) in the recurrence 
data process can be modeled adequately as a sequence of identically distributed 
independent observations.  
 

14 Repeated Measures Degradation Data Analysis 
 

SPLIDA provides convenient tools for doing the “simple degradation analysis” described 
in Chapters 13 and 21 of Meeker and Escobar (1998) and elsewhere (as indicated in their 
end-of-chapter bibliographic notes). In this simple method for degradation analysis, 
separate regression analyses are run on each individual degradation path to predict failure 
times (which we call pseudo failure times) for those units that have not failed. The idea is 
to squeeze a little more information out of one’s data. This approach to degradation 
analysis (indeed any method of degradation analysis that will require any extrapolation) 
needs to have a solid basis for the underlying degradation path model. Ideally, this will 
be a model based on well-developed physical-chemical theory (e.g., some simple wear 
processes are known to be approximately linear after a break-in period). When such a 
physical model is not available, extrapolation may not be justified. 

We do not recommend the use of model fitting and experimentation with different 
variable transformation in order to find, in a simple way, the relationship of “best fit” 
when there will ultimately be more than just a little extrapolation in time. In any case, 
when extrapolation is required, analyses should be accompanied by careful, systematic 
sensitivity analysis among a collection of models that are plausible. This sensitivity 
analysis is critical to obtaining an understanding of the magnitude of model uncertainty 
(which when extrapolating can dominate the statistical uncertainty quantified in our 
confidence intervals). 

 

14.1 Make a degradation (repeated measures) data object 
As with life data and recurrence data, one first has to construct a degradation data object. 
Because the structure of different data is different from that of life data, there is a 
different dialog to making a recurrence data object. Using SPLIDA ► 
Make/summary/view data object ► Make a degradation (repeated 
measures) data object will bring up a dialog like that shown in Figure 130. 
Clicking on the Choose data set arrow will show all of the data sets in the SPLIDA 
database and in your working database. After choosing an appropriate repeated measures 
data set, one must choose the response, time, and unit identifier (all are required for 
degradation data), and explanatory variables, if any. There are a number of other optional 
inputs to change the defaults. By default, the name of the response is inserted into the 
name of the resulting repeated measures data object. This is especially useful in 
applications in which there are multiple degradation responses measured on each unit. 
The example in Figure 130 uses the GaAs Laser (GaAsLaser is the data set name) 
degradation data from Chapter 13 of Meeker and Escobar (1998).  
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When the needed inputs have been specified, click on “OK” or “Apply” to create the 
repeated measures data object. In addition to creating the degradation data object, a short 
summary of the data in the object is provided and, if desired a printout of the data can be 
requested by using the “Output Options” back page of the dialog. 

 

 
Figure 130 Dialog used to make a repeated measures degradation data object. 

 

14.2 Degradation data plot 
Using SPLIDA ► Degradation data analysis ► Degradation data plot 
brings up a dialog, like that shown in Figure 131, which can be used to request a plot of 
degradation paths. If there are explanatory variables, there is an option to group paths by 
explanatory variable levels, instead of plotting all paths on a single graph. It is possible to 
request special axes transforms (e.g., linear, log, or square root axes) to plot either time or 
the response. The Modify Plot Options page allows one to control the ranges of the plot 
axes. 
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Figure 131 Dialog to request a plot of degradation data for the GaAs Laser data. 

Figure 132 shows a simple degradation plot for the GaAs laser data. 

 
Figure 132 Plot of degradation data for the GaAs Laser data. 

14.3 Degradation data trellis plot 
Using SPLIDA ► Degradation data analysis ► Degradation data trellis 
plot brings up a dialog like that shown in Figure 133. This dialog is used to request a 
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trellis plot of degradation paths. If there are explanatory variables, there is an option to 
group paths by explanatory variable levels, although the individual plots, as illustrated in 
Figure 134, are recommended because they can be importantly revealing.  

 

 
Figure 133 Dialog to request a trellis plot of the GaAs laser degradation paths. 
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Figure 134 Trellis plot of the GaAs laser degradation paths. 

14.4 Convert/extrapolate data to pseudo failure-time data 
The so-called “simple degradation analysis” method mentioned at the beginning of this 
section fits a specified model to each of the sample paths in an effort to “squeeze” a little 
more information out of such data by exptrapolating the paths (or some of the paths) to 
predict the time of failure. Then the “pseudo failure times” are analyzed using the 
standard methods for failure-time data. The conversion of degradation path data to 
failure-time data can be done easily with the SPLIDA ► Degradation data 
analysis ►  Convert/extrapolate data to failure-time data dialog. It is 
necessary to specify the repeated measures (degradation) data object and the degradation 
level defining failure. For the GaAs lasers, failure was defined as the time at which 10 
mA of current was needed to provide a specified  (constant) amount of light output. It is 
also possible to specify a maximum time (a pseudo censoring time), beyond which no 
failures are extrapolated. For the GaAs lasers, focus was on the lower quantiles of the 
failure-time distribution and thus the paths were extrapolated only to 5000 hours, where 6 
out of 15 lasers had failed (i.e., had predicted current greater than 10 mA). As in the 
dialog for plotting degradation paths, on has a choice of axis scales (e.g., linear, square 
root, or log). These same transformations are also used to determine the scale in which to 
fit the linear regression lines used to extrapolate the degradation paths to the compute the 
pseudo failure times. The effect of this choice can be quite pronounced (especially in the 
dangerous and discouraged practice where one is extrapolating far in time) and in the 
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absence of strong physical motivation for one or the other, sensitivity analysis is strongly 
recommended. 

 

 
Figure 135 Dialog requesting that the GaAs laser degradation date be mapped into 
pseudo failure time data using 10 mA as the definition of failure and a censoring 
time of 5000 hours. 

After clicking on “OK” or “Apply,” SPLIDA produces the plot in Figure 136 showing 
the degradation paths and extrapolations to the failure level of censoring time (which 
ever comes first) and the life data object GaAsLaserF10C5000.XLinear.YLinear.ld is 
available for doing failure-time analysis. Note that the default name (which could have 
been edited) reflects the failure definition level, pseudo censoring time, and the 
transformation/axes used in generating the pseudo faulure times. Such descriptive names 
are useful because analysts will often want to experiment with different choices for some 
or all of these and the automatic coding makes it easy to do such experiments and to 
compare the results of different analyses using all of the previously described tools for 
such data. 
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Figure 136 Plot showing the GaAs laser degradation data being mapped into pseudo 
failure time data using 10 percent as the definition of failure and a censoring time of 
5000 hours. 

Figure 137 is an event plot showing the six pseudo failure times and the nine units 
censored at 5000 hours in GaAsLaserF10C5000.XLinear.YLinear.ld. In this 
example, the amount of extrapolation is small (especially because no extrapolation was 
done beyond 5000 hours) and the degradation paths are well behaved. Thus, the pseudo 
failure times should provide reasonably good predictions for the actual failure times. 
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Figure 137 Event plot showing the predicted failure times for the GaAs laser 
degradation experiment. 

14.5 Degradation residual trellis plot 
We have emphasized the importance of having a solid basis for any model used in 
extrapolation of sample degradation paths. Whether or not such a model is available, it is 
important to assess the adequacy of the fitted models to the degradation paths. If the 
model does not even fit the data within the range of the data, careful consideration should 
be given to the usefulness of the data for purposes of predicting a failure-time 
distribution. Of course, one should always remember that just because the model 
provides a good fit to the data and may be adequate for making predictions within the 
range of the data, there is no guarantee that the degradation process will continue to 
follow the fitted model outside of the range of the available data. 

The dialog in Figure 138 allows the user to request a trellis plot of residuals for the 
straight lines fit to (possibly transformed) degradation data. Such plots help one to detect 
systematic departures from the fitted model. Figure 139 shows the residual trellis plot for 
the GaAs laser data. Although there were 15 tested lasers, Figure 139 shows residual 
paths for only 12 units. This is because three of the units had crossed the failure 
boundary, and thus required no extrapolation to obtain the failure time (simple linear 
interpolation was used instead). For this example, there appears not to be any systematic 
departures from the fitted straight-line model. 
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Figure 138 Dialog to request a residual trellis plot for each of the GaAs laser data 
regression lines. 

 

 
Figure 139 Trellis plot of residuals for each degradation path for the GaAs laser data. 

15 Accelerated Test Repeated Measures Degradation Data 
Analysis 

15.1 Creating an accelerated degradation data object 
Many degradation experiments are run at accelerated conditions (e.g., high temperature) 
in order to accelerate the degradation process. A useful plot for such data is a cell-
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average plot giving the average degradation as a function of time for the different level(s) 
of an explanatory variable.  
 
The methods used in Chapter 14 can also be used for data with explanatory (or 
accelerating) variables. The primary difference is that one needs to specify the 
explanatory (accelerating) variable when creating the data object. Use SPLIDA ► 
Degradation data analysis ► Degradation data trellis plot to brings up a 
dialog like that shown in Figure 140  This is used to create a repeated measures data 
object with an accelerating (explanatory) variable.  The resistor example are repeated 
measures data on the resistance of carbon-film resistors, tested at different levels of 
temperature 

 

Figure 140 Dialog to make a repeated measures degradation data object for a test with acceleration 

 

15.2 Accelerated degradation cell-average plot 
When an experiment is conducted with units at several levels of one or more explanatory 
variables, it is useful to compute averages across all units at the different combinations of 
the explanatory variables. The following example illustrates this with the resistor data in 
which three levels of temperature were used. The plot gives a good visual indication of 
the effect of temperature on degradation rate. Using SPLIDA ►  Degradation data 
analysis ► Accelerated degradation cell-average plot brings up the dialog in 
Figure 141. In this case, the names of the most trecently created repeated measures data 
object (Resistor.PercentIncrease.rmd) was remembered by SPLIDA because 
it had been created in the same session. 
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Figure 141 Dialog requesting a plot of the average reading of all units at the 
different temperatures for the carbon-film resistor degradation data. 

Figure 142 shows the resulting cell-average plot for the resistor degradation data. 

 

 
Figure 142 Plot of the average reading of all units at the different temperatures for 
the carbon-film resistor degradation data. 
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15.3 Other graphical analysis of the accelerated repeated measures 
degradation data  

 
Use SPLIDA ►  Degradation data analysis ► Plot degradation (repeated 
measures) data to obtain a dialog like that shown in Figure 143  that can be used to 
plot accelerated repeated measures degradation data  
 
 

 

Figure 143 Dialog to request a plot of the resistor accelerated repeated measures degradation data 
 

15.4 Other steps in the analysis of the accelerated repeated measures 
degradation data  

 

Although the details are not presented here, the next steps in the analysis of the resistor 
data would be to convert the degradation paths into pseudo failure times and then to 
analyze these with the tools described in Chapter 9. 

16  Accelerated Destructive Degradation Test Data Analysis 
Accelerated tests are used widely in manufacturing industries to obtain timely 
information about the durability and reliability of components and subsystems. In a 
reliability test, a sample of units is put on test and either monitored over time or inspected 
at particular points in time. Acceleration is accomplished by testing at increased levels of 
accelerating variables like temperature, voltage, or stress. In accelerated life testing, one 
measures the time to failure. In accelerated degradation testing, one measures the amount 
of degradation or the degree of progression toward failure. In some applications, actual 
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physical degradation measurements are available (e.g., crack size or remaining strength). 
In other applications, performance or a surrogate response, such as power output, light 
output, or speed might be used instead. Generally, for purposes of physical modeling, it is 
better to have a response that is closely related to the degradation mechanism itself. 

This section describes and illustrates SPLIDA’s data analysis methods for accelerated 
destructive degradation test (ADDT) data. Figure 144 shows the SPLIDA menu along 
with the sub-menu for ADDT data analysis.  

 
 

Figure 144 View of the SPLIDA menu for ADDT data analysis. 

16.1  Making an accelerated destructive degradation data object 
The first step in the analysis of ADDT data is to import  the data into S-PLUS (usually 
from an Excel spreadsheet or a text file). As usual, the data set should consist of one row 
for each observation. The variables, corresponding to columns in the data set would 
include the measured degradation response (e.g., strength or size of a crack), the time of 
the measurement, and values of any explanatory variables.  Optional columns could 
contain censoring information or case weights. The order of the columns is not important. 
Table 19 shows the variable names and ten rows of the AdhesiveBondB data set (this 
data set is one of SPLIDA’s built-in examples). 
     DegreesC Weeks Newtons  
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         50     0    70.1  

         50     0    76.7  

         50     0    84.5  

         50     0    88.0  

         50     0    88.9  

         50     0    90.4  

         50     0    91.9  

         50     0    98.1  

         50     2    77.8  

         50     2    78.4  

Table 19 The first ten rows of the AdhesiveBondB data set. 

 

 
 

Figure 145 SPLIDA menu entry for making an ADDT data object. 

As with other types of data, after the degradation data set has been imported into S-
PLUS, it is necessary to use SPLIDA to create a destructive degradation data (.ddd) 
object. A data object contains the information about a data set. In particular, a data object 
defines the purpose of each variable and captures other information about the data set 
(e.g., units of time and the response, as well as a title for the data). This data object 
allows the analysis of the data set in various different ways without having to re-specify 
this information.  

To make the destructive degradation data object, use SPLIDA ► 
Make/summary/view data object ► Make destructive degradation 
data object (see Figure 145) to bring up the dialog box in Figure 146. Select the 
required inputs (S-PLUS data set name, the response, and the time column). Then choose 
other possible variables, as needed, including the explanatory variables and the censoring 
variable (Status). For the AdhesiveBondB data, there is no weight variable. The names 
of the response and time columns serve as defaults for the units of these variables, so in 
this case these inputs need not be specified (SPLIDA tries to use available information as 
defaults whenever possible). After the input is entered into the dialog box, click the 
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Apply button to create the data object. A brief summary of the data object will be printed 
in the command window. 

 

 

 

Figure 146 Dialog used to create a destructive degradation data object for the 
AdhesiveBondB data. 

16.2  Degradation data scatter plot  
 
After the data set has been created, it can be used as input to various data analysis 
procedures. Generally, data analyses begin with graphical analyses. For destructive 
degradation data, we start by plotting degradation versus time, using different symbols to 
represent the data at different levels of the explanatory variable(s). To do this, use 
SPLIDA ► Accelerated destructive degradation test (ADDT) analysis 
► Scatter plot ADDT data to bring up the dialog box in Figure 147. Choose the 
AdhesiveBondB.ddd destructive degradation data object (SPLIDA will remember the 
most recently created .ddd object if it was created in the current S-PLUS session). Then 
clicking on Apply will produce a scatter plot. Different transformations for the response 
and time can be tried in an attempt to find a combination that provides approximately 
linear behavior in degradation over time. Generally, however, it would be preferable if 
this part of the model could be determined by physical knowledge of the degradation 
mechanism, and checked against data, as described in examples in Chapters 13 and 21 of 
Meeker and Escobar (1998).  
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Figure 147 Dialog requesting a scatter plot of the AdhesiveBondB destructive 
degradation data. 

For the AdhesiveBondB data, a log transformation for the response and a square root 
transformation for time resulted in an approximately linear relationship between 
degradation and time. The plot is shown in Figure 148 (also see Figure 150). 
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Figure 148 Scatter plot of the AdhesiveBondB destructive degradation data. 

16.3  Individual scatter plot and ML fits for different accelerating variable 
levels 

 
Extending the scatter plots described in Section 2.2, we now show how to plot fitted 
regression lines to the data at individual conditions (e.g., different levels of temperature). 
In general (to allow for censoring), the lines are fit by using maximum likelihood. Use 
SPLIDA ► Accelerated destructive degradation test (ADDT) analysis 
► Scatter plot and ML fit for individual conditions to bring up the dialog 
box in Figure 149. Choose the transformations identified previously (or experiment with 
others). In this dialog, it is also necessary to specify a degradation distribution to describe 
the shape of the spread of the scatter of the response about the regression line (in the 
transformed scale). We choose to use the normal distribution because it provides a better 
description for the variability than the other distributions. There are also a number of 
optional inputs. For example, we have requested that ML lines be plotted and have 
entered 40 (Newtons) as the failure definition for the strength of the adhesive bond.  
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Figure 149 Dialog for individual scatter plots for the different levels of the 
explanatory variables. 

After clicking on Apply, the plot in Figure 150 and the results in Table 20 are produced. 
The slopes in Table 20 are degradation rates that represent the change in log(Newtons) 
for a unit change in the square root of time for each of the temperatures.  Figure 150 
shows degradation versus time at each of the three different temperature conditions (on 
the transformed axes), along with the fitted regression lines (there is an option in the 
dialog to suppress plotting of the fitted lines). The horizontal failure-definition lines are 
also shown at 40 Newtons. 
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 AdhesiveBondB data  
Individual estimates and  95% confidence intervals for the slope at each 
condition. 

Normal distribution. 

 DegreesC sample.size intercept   slope se.slope slope.lower slope.upper  

       50          39     4.490 -0.1088  0.01494     -0.1424    -.08309 

       60          32     4.489 -0.2089  0.02214     -0.2571    -.16969 

       70          33     4.400 -0.3626  0.01944     -0.4028    -.32643 

Table 20 Estimates, standard errors, and confidence intervals for the estimated 
slopes (degradation rates) for the individual levels of temperature. 

 
Figure 150 Individual scatter plots for the AdhesiveBondB destructive degradation 
data. 

The default for the dialog in Figure 149 is to make a figure with a separate plot for each 
level (or combination of levels) of the explanatory variable(s). The check box in the 
upper right-hand side of the dialog allows the user to put all of the data and fitted lines on 
a single plot. The resulting plot is shown in Figure 151. 
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Figure 151 Scatter plot of the AdhesiveBondB data with individual ML lines. 

The fitted regression lines in Figure 150 and Figure 151 were estimated individually for 
each level of temperature. For purposes of making inferences at other levels of 
temperature, (usually estimates of degradation rate or characteristics of the failure-time 
distribution at lower levels of temperature), it is necessary to fit a model relating 
degradation rate to temperature. As a first step in identifying such a model, the dialog in 
the Relationship plot page in the dialog box shown in Figure 149 allows one to request 
and control of some options  for the “relationship model plot” of degradation rate versus 
the explanatory variable(s) (temperature for the AdhesiveBondB example). The 
underlying regression model assumes that the logarithm of degradation rate is linearly 
related to some transformation of the explanatory variable. When temperature is believed 
to affect the rate of a chemical reaction, the Arrhenius rate reaction model is commonly 
used to describe the relationship. 

Figure 152 is a relationship model plot showing degradation rate (on a log axis) as a 
function of temperature (on a Arrhenius axis). 
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Figure 152 Relationship model plot showing degradation rate (log axis) as a function 
of temperature (Arrhenius axis) for the AdhesiveBondB destructive degradation 
data. 

As shown in Meeker and Escobar (2002a), an Arrhenius relationship will plot as a 
straight line on Figure 152 (log axis for the rate or slope and an Arrhenius axis for 
temperature). The 95% (pointwise) confidence intervals (error bounds) for degradation 
rate in Figure 152 allow an assessment of statistical uncertainty.  The line in Figure 152 
was drawn using the line tool in the S-PLUS annotation tool bar. Although the points do 
not fall exactly on the straight line, the width of the error bounds, relative to the 
deviations from the straight line, suggest that the Arrhenius model could not be ruled out 
as a descriptor of the available data. Strictly speaking, one should use simultaneous 
confidence intervals to make this comparison, and these would be wider than the 
pointwise intervals displayed in Figure 152). The curvature exhibited in the three points 
suggests, however, that extrapolation to lower temperatures (like 25 degrees C) may not 
be justified. Generally, the justification for such extrapolation is not a statistical issue, but 
rather requires input from understanding of the physical/chemical aspects of the 
degradation-causing mechanism. 

16.4  Scatter plot and ML fit of a regression (acceleration) model   
 



 159

To fit an ADDT model that includes the relationship between degradation rate and 
explanatory variables like temperature, use SPLIDA ► Accelerated destructive 
degradation test (ADDT) analysis ► Scatter plot and ML fit of a 
regression (acceleration) model to bring up the dialog box shown in Figure 153. 
In addition to the inputs required for the individual analyses described in Section 16.3, 
the user must now also specify the failure-definition level and the acceleration 
relationship (these were optional in previous dialogs). In addition, there are a number of 
optional inputs, as shown in Figure 153. For the AdhesiveBondB example, the product 
engineers wanted an assessment of degradation rate and the failure-time distribution at 25 
degrees C. The results of the analysis will be saved, by default, in an object with the 
name AdhesiveBondB.groupm.ADDT.DegrArrh.normal.out (although it is generally 
not necessary, the user may edit and change this name). It is also necessary to visit the 
Relationship page (not shown here) to specify the relationship between log rate and the 
explanatory variable(s). For the AdhesiveBondB example the Arrhenius relationship was 
used. 
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Figure 153 Dialog box used to fit an acceleration model to the ADDT data. 

As shown in Nelson (1990) and Meeker and Escobar (2002a), for a given failure-
definition level, the degradation model induces a failure-time distribution. The properties 
of this distribution are usually of primary interest to product engineers. The Tabular 
output page allows the user to request tables of failure probabilities or quantiles of the 
induced failure-time distribution. 
The Model plot page of the dialog allows the user to request a plot of the quantiles of the 
failure-time distribution versus the accelerating variable (temperature for the 
AdhesiveBondB example). This page of the dialog is shown in Figure 154. 
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Figure 154 Model plot page of the ADDT acceleration model-fitting dialog box. 

After pressing the Apply button, SPLIDA will estimate the parameters of the degradation 
model and produce the plots in Figure 155 and Figure 156 as well as the information in 
Table 21. 
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Figure 155 Plot of the ADDT normal-Arrhenius model for the AdhesiveBondB 
destructive degradation data. 

In Figure 155, we see the fitted lines corresponding to the different levels of temperature, 
including the line for the specified use conditions 25 degrees C (obtained by 
extrapolation from the fitted Arrhenius model that relates degradation rate to 
temperature). Unlike the individual analyses displayed in Figure 151, all of the lines for 
the acceleration model cross at the intercept exp(β0)=exp(4.471) =  87.44. The horizontal 
line at 40 Newtons allows one to visualize the failure-time distribution, at least at 70 
Degrees C (the axes could be extended on the plot by using controls on the Modify plot 
axes page of the dialog box in Figure 153). 

The model plot in Figure 154 shows estimates of the quantiles of the induced failure-time 
distribution as a function of temperature. As shown in Meeker and Escobar (2002a), a 
given quantile of the failure-time distribution is linear in the Arrhenius transformation of 
temperature. The .05, .5, and .95 quantile lines have been drawn (by default .10, .50, and 
.90 are used, but this was changed in the Figure 154 dialog) along with densities at the 
given levels of temperature (all levels of temperature in the data set plus additional levels 
entered on the Basic page of the dialog in Figure 153).  
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Figure 156 Model plot of failure-time distribution quantiles versus temperature for 
the AdhesiveBondB destructive degradation data. 

Although the underlying degradation distribution is assumed to be a particular location-
scale distribution, the form of the failure-time distribution is not simple. The form of the 
failure-time distribution depends on the assumed transformations on the response and on 
time. Also, as shown in Meeker and Escobar (2002a), the failure-time distribution 
induced by our degradation model has an “atom” of probability at time zero, 
corresponding to the probability that the degradation level is beyond the failure threshold 
at time 0. In Figure 154, the Probability spike at time zero = 0.011418 gives the ML 
estimate of the probability that a unit of AdhesiveBondB has a strength less than 40 
Newtons at time 0 (note that this probability does not depend on temperature level). 

The horizontal line at 84 hours is the time of the last inspection. Inferences beyond this 
point involve extrapolation in time. Figure 154 shows that the amount of extrapolation in 
time for this application is substantial (in both temperature and time). 

Table 21 provides a summary of the ML estimation for the normal-Arrhenius model fit to 
the AdhesiveBondB destructive degradation data. Table 22 is a table of ML estimates and 
confidence intervals for several quantiles of the failure-time distribution at 25 degrees C, 
with a failure definition of 40 Newtons (obtained with the controls on the Tabular output 
page of the dialog in Figure 154. 
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Table 21 Summary of ML estimation for normal-Arrhenius model fit to the 
AdhesiveBondB destructive degradation data. 

 

Table 22 Table of ML estimates of quantiles of the AdhesiveBondB failure-time 
distribution 

16.5 ADDT model residual analysis 
After fitting an ADDT model, it is important to assess the adequacy of the fit of the 
model by plotting the residuals in various ways. To do this in SPLIDA for ADDT data, 
use SPLIDA ► Accelerated destructive degradation test (ADDT) 
analysis ► Residual analysis to bring up the dialog box in Figure 157. The 
dialog will recall the most recent ADDT model output that was created in the current S-
PLUS session (if any). The default for this dialog is to get all possible residual plots. It is 
easy, however, to request one or some of the available plots. 
 

Degradation 
 
Response units: Newtons 
Time units: Weeks 
Normal Distribution 
 
Relationship: Resp:Log,Time:Square root,DegreesC:Arrhenius  
 
Maximum likelihood estimation results 
Appears to have converged; relative function convergence 
Log likelihood at maximum point: 34.97  
  

MLE Std.Err. 95% Lower 95% Upper

 
Parametric ML Failure-time Quantile Estimates  
at 25. DegreesC for failure defined at a level of 40 Newtons 
Pointwise Approximate 95% Confidence Intervals 
 
 Dead-on-Arrival-Normal Distribution 
 
     p   Weeks Std.Err. 95% Lower 95% Upper  
  0.01  757.42   370.37    290.48    1975.0 
  0.05 1201.38   596.53    453.97    3179.3 
  0.10 1479.71   742.95    553.09    3958.8 
  0.50 2692.88  1402.10    970.56    7471.5 
  0.95 4778.27  2572.08   1663.72   13723. 
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Figure 157 ADDT residual analysis dialog 

Figure 158 is a plot of the residuals versus fitted values for the normal-Arrhenius plot fit 
to the AdhesiveBondB data. This plot suggests that the amount of variability does not 
differ importantly as a function of temperature. 



 166

Figure 158 Plot of the residuals versus fitted values for the Arrhenius plot fit to the 
AdhesiveBondB data. 

Figure 159 is a probability plot of the residuals for the normal-Arrhenius plot fit to the 
AdhesiveBondB data. This plot suggests that the normal distribution provides a 
reasonably good fit to the residuals. This is in contrast with the smallest extreme value  
probability plot in Figure 160 (based on fitting a model in which the residuals were 
assumed to have a smallest extreme value distribution) where there is some deviation in 
the lower tail of the distribution. 
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Figure 159 Normal distribution probability plot for the Arrhenius model fit to the 
AdhesiveBondB data. 
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Figure 160 Normal distribution probability plot of the residuals for the Arrhenius 

model fit to the AdhesiveBondB data. 

16.6 Analysis of destructive degradation data with two accelerating 
variables    

ADDT Data Object 
This section shows how to use SPLIDA to analyze a set of ADDT data with two (or 
more) experimental factors (or accelerating variables).  Because of the similarities with 
the one variable analysis methods described in Sections 16.1 to 16.5, this section presents 
an example and focuses particularly on concepts and tools that differ from those used in 
the single-variable analysis.  

In this section, we use the AdhesiveBondD destructive degradation data from an 
experiment on the strength of an adhesive bond tested at different levels of temperature 
and humidity.  The data   available in the SPLIDA destructive degradation data object 
AdhesiveBondD.ddd.  To look at the data, use SPLIDA ► 
Make/edit/summary/view data object ► Summary/view a data object 
to bring up the dialog box.  Select destructive degradation objects for type of dataset 
objects, choose the AdhesiveBondD.ddd data object.  The default optional output is to 
print a summary of the data but you can also check “Print data” to view all the data.  
Then click Apply.  This produces the data summary; see Table 23 for the first few lines 
of the summary for the AdhesiveBondD data.  In addition to information about each of 
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the experimental factor (Weeks, DegreesC, RH), the summary displays information about 
the response and number of observations at each of the unique experimental factor level 
combinations. 

The experiment design has a 3x2x8 factorial arrangement with three levels of 
temperature   (50, 60, 70 DegreesC), two levels of relative humidity   (20 and 80 percent 
RH), and eight levels of time (0, 1, 2, 4, 6, 8, 12, 16 weeks).  The response is strength of 
the adhesive measured in Newtons; an adhesive strength below 25 Newtons is considered 
a failure.     There are 288 observations with 6 observations for each combination of 
temperature, relative humidity, and time.  Note that, as in the single-accelerating variable 
example, the time factor is treated in a special manner. In particular, one objective of the 
experiment is to assess the life distribution of the adhesive at use conditions of 25 
DegreesC and 50% RH. 
 

Number of rows in data matrix= 288  
Time units:  Weeks  
Response units:  Newtons  
Response minimum:  11  
Response maximum:  56.8  
Number of cases in data set= 288  
Number of exact failures in data set= 288  
 
Summary of numeric columns in X matrix:   
         min max     mean      sd      cv  
   Weeks   0  16    6.125   5.264  0.8594 
DegreesC  50  70   60.000   8.179  0.1363 
      RH  20  80   50.000  30.052  0.6010 
 
 
unique X values (or combinations) 
List of unique X values (or combinations)  
   Weeks DegreesC RH min-Resp max-Resp #exact  
 1     0       50 20     31.5     50.1      6 
 2     1       50 20     33.1     45.7      6 
 3     2       50 20     29.8     48.6      6 
 4     4       50 20     28.6     47.8      6 
 5     6       50 20     27.6     43.2      6 
 6     8       50 20     28.6     42.6      6 
 

Table 23 Summary of the AdhesiveBondD data set. 
 
Scatter Plot 
To get a scatter plot of the response versus time, use SPLIDA ► Accelerated 
destructive degradation test (ADDT) analysis ► Scatter plot and ML fit 
for individual conditions to bring up the dialog box similar to the one in Figure 
149.  Specify the AdhesiveBondB.ddd as the “destructive degradation data object.”  For 
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this example, choose the log transformation for the response and the square root 
transformation for time.  Specify normal for the degradation distribution and enter 25 
(Newtons) as the failure definition for the strength of the adhesive bond.  In the 
“Relationship plot page,” verify that DegreesC is the Focus variable and that the 
Relationship is Arrhenius (these are the defaults).  Then click on Apply. This generates 
the scatter plots in Figure 161, the relationship model plot Figure 162, and a summary of 
the individual ML fits, as shown in Table 24. 
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Figure 161 Individual scatter plots for the AdhesiveBondD destructive degradation 
data. 

Figure 161 is similar to Figure 150, showing strength versus time at the distinct 
experimental factor level combinations of DegreesC and RH. The fitted lines are 
individual fits using the normal distribution.  Table 24 provides information on the 
regression lines fitted to each factor combination. The sample size in the table 
corresponds to the six units at each of the eight time points. One can get a single plot 
with an overlay of all the scatter plots by deselecting the “Make separate plots” in the 
“Plot options” of the dialog box. 
 
Adhesive Bond Humidity/Temperature Test  
Individual estimates and  95% confidence intervals  
for the slope at each condition. 
 Normal degradation distribution. 
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  DegreesC   RH sample.size    intercept    slope  se.slope slope.lower slope.upper  
        50   20          48        3.658  -0.02242  0.01982     -0.1267   -0.003966 
        50   80          48        3.646  -0.05104  0.02035     -0.1115   -0.023361 
        60   20          48        3.597  -0.03124  0.01937     -0.1053   -0.009271 
        60   80          48        3.667  -0.10221  0.02292     -0.1586   -0.065864 
        70   20          48        3.645  -0.10885  0.01960     -0.1549   -0.076486 
        70   80          48        3.604  -0.17038  0.02249     -0.2207   -0.131549 

 
 
Table 24 Estimated slopes (degradation rates) for the individual combinations of 
DegreesC and RH for the AdhesiveBondD data. 
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Figure 162 Relationship model plot showing degradation rate (log axis) as a function 
of temperature (Arrhenius axis) for each level of RH for the AdhesiveBondD data. 
 
Relationship plots like the one in Figure 162 are used to assess relationship between the 
degradation rate (degradation versus time slope) and a chosen accelerating variable 
(focus variable). The crosses in Figure 162 indicate the degradation rate estimates for 
different levels of temperature (the chosen focus variable) when RH is 80%.  Similarly, 
the open circles indicate the degradation rate estimates for different levels of temperature   
when RH is 20%.  The horizontal segments depict approximate 95% pointwise 
confidence intervals for the degradation rates.  As shown in Meeker and Escobar (2002a) 
for a model without interaction, for each fixed level of RH, the degradation rate estimates 
should fall approximately along a straight line and the lines for different values of RH 
should be approximately parallel.  The lines in Figure 162 were drawn using the line tool 
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in S-PLUS annotation tool bar.  The estimates for 20% RH show some curvature and 
extrapolations to low levels of temperature and RH may be seriously incorrect.  To make 
a definite assessment of the apparent departure from linearity one would need a more 
elaborate statistical procedure.  A similar relationship plot for RH is obtained by 
choosing RH as the focus variable and Humidity for the relationship in the dialog box.  
This plot (not shown here) shows degradation rate estimates as a function of RH for each 
fixed value of temperature.  Because, for these data, there are only two levels of RH for 
each fixed level of temperature, the model plot for RH is only informative to assess the 
parallelism of the lines for different levels of temperature. 
 

 

Fitting an Acceleration Model 
To fit an ADDT model that includes the relationship between degradation rate and the 
accelerating factors DegreesC and RH, use SPLIDA ► Accelerated destructive 
degradation test (ADDT) analysis ► Scatter plot and ML fit of a 
regression (acceleration) model to bring up the dialog box shown in Figure 163. 
In addition to the inputs required for the individual analyses described above, specify the 
use conditions 25;50 for “Additional conditions for evaluation,” then go to the 
“Relationship page” (see Figure 164) click on “Relationships” and choose Arrhenius for 
DegreesC  and Humidity  for RH.  Then go to the “Model plot” page and check the 
“Make a model plot” option.  Click on “Choose” to specify the fixed value of 50 for RH 
and then click on “Apply.”  SPLIDA generates Figure 165 and Figure 166, and the ML 
estimates for the model parameters. Table 25 shows part of the output generated by 
SPLIDA. 
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Figure 163 Dialog box used to fit a two variables acceleration model. 
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Figure 164 Model plot page of the dialog box used to fit a two variables acceleration 
model. 

 
Figure 165 shows the strength versus time data in a scatter plot as well as the fitted lines 
corresponding to different combinations of DegreesC and RH, including the extrapolated 
line for 20 DegreesC and 50% RH.  Figure 166 shows estimates of the quantiles of the 
induced failure-time distribution as a function of temperature when RH is fixed to 50%.  
One can get a similar plot in which the focus variable is RH, where DegreesC is fixed to 
a given value.  To generate such a plot, go back to the “Model plot page” in Figure 164 
and pick RH as the variable to vary on the plot at the same time specify the fixed value of 
DegreesC to use in the plot. 
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Figure 165 Plot of the ADDT normal-Arrhenius-Humidity model for the 
AdhesiveBondD. 
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Figure 166 Model Plot of failure-time distribution quantiles versus temperature 
when RH=50% for the AdhesiveBondD data. 
 
 
Response units: Newtons 
 
Time units: Weeks 
 
Normal DistributionRelationship: Resp:Log,Time:Square 
root,DegreesC:Arrhenius,RH:Humidity  
 
Maximum likelihood estimation results 
 
Log likelihood at maximum point: 86.92  
  
 Interpretation parameter MLEs  
 beta0       beta1  beta2  beta3  sigma  
 3.641 -2024525684 0.6921 0.2105 0.1789 

Table 25 ML estimates of the normal-Arrhenius-RH model for the AdhesiveBondD 
data. 
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Residual analyses provide checks on model adequacy.   To get the residual plots for the 
fitted normal-Arrhenius-RH model use SPLIDA ► Accelerated destructive 
degradation test (ADDT) analysis ► Residual analysis to bring up the 
residual dialog box and request the plots.    SPLIDA remembers the name of the most 
recent ADDT model output object that was created during the current S_PLUS session.  
Otherwise you need to choose the output from the available list in the dialog box. The 
default  output object name corresponding to the output in Figure 163 for the normal-
Arrhenius-RH analysis is 
AdhesiveBondD.groupm.ADDT.DgrCArrh.RHHmdt.normal.out, but the name is 
editable in the analysis dialog (shown in Figure 163) allowing one to choose a shorter 
and more convenient name. 

 
 

17 Planning an Accelerated Destructive Degradation Test 
This section describes methods for planning accelerated destructive degradation tests 
(ADDTs). Figure 167 shows the menu for SPLIDA’s ADDT planning capabilities. As 
with other SPLIDA sub-menus, one generally starts at the top item and progresses 
through the ordered sequence of steps. To provide an example for test planning we will 
revisit the AdhesiveBondB example, and explore the possibility of using a test plan that 
is different from the one in the original example. 
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Figure 167 View of the SPLIDA menu for ADDT planning. 

17.1  Specifying ADDT test planning information (planning values)  
The first step in planning an ADDT is to elicit information about the testing situation. 
The needed planning information consists of the model and the model parameters. Such 
information is usually obtained from previous experience with similar materials or 
products, pilot tests, or engineering judgment. In the example presented here, we will use 
the parameter estimates from the analysis in Section 16.4 as our planning values.  

The planning information is provided to SPLIDA using the dialog box obtained with 
SPLIDA ► Plan a destructive degradation test (ADDT) ► Specify ADDT 
test planning information (planning values). This will bring up the dialog box 
in Figure 168. As usual, the required inputs are at the top/left in the dialog. When making 
the test planning values object, it is generally useful to provide most of the optional 
inputs (e.g., time and response units), to make the planning output easier to understand. 
The degradation level defining failure and the use conditions need not be specified here, 
but it is generally convenient to do so. Otherwise, these values will have to be specified 
in various places later in the planning process (it is, of course, possible to alter these 
values in subsequent dialogs).  The default name for the planning values object is 
last.Distribution.ADDTpv, where “Distribution” is replaced by the chosen distribution. 
Generally, however, it is a good idea to edit this to something more meaningful. For the 
example, we use AdhesiveBondB.Normal.ADDTpv. 
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Figure 168  Basic information page of the dialog box for providing ADDT planning 
values. 

Figure 169 shows the Parameter page of the dialog box for providing ADDT planning 
values. There are two options in this page. One can specify the basic parameters β0, β1, 
β2, and σ, as defined in Meeker and Escobar (2002b). A problem with this approach is 
that β1 has no practical interpretation and it generally has a rather large magnitude (e.g., 
on the order of 1011). The alternative is to specify the slope of the regression line at a 
given level of the accelerating variable (e.g., slope at 50 degrees C) in place of β1.  This 
can be done because of the relationship 2υ  = β exp(β )x1

W W W  where υW is the slope at 
transformed temperature x = -11605/(degrees C + 273.15). For the example, the planning 
value for the slope at 50 degrees C is 2υ  = β exp(β )x1

W W W  = -8.641e+008*exp(-
.6364*35.912) = -0.10257. 

 
Figure 169 Parameter page of the dialog box for providing ADDT planning values. 

After clicking on Apply, a small summary table of the planning information is given. 
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17.2  Generating an ADDT test plan 
 
SPLIDA has a tool to generate a simple ADDT test plan. Subsequently the plan can be 
modified to have a more complicated structure, if needed. Use SPLIDA ► Plan a 
destructive degradation (ADDT) test ► Generate an ADDT test plan to 
generate the dialog box in Figure 170. Fill the accelerating variable name and then push 
the Choose levels button to choose the levels of the accelerating variable (50,60,70 for 
temperature in this case). The time units given here should agree with what is given in 
the planning values object. Then enter a list of times (integers separated by commas) at 
which inspections are to be conducted. Finally, enter the number of units per time/level 
combination. Usually this number would be somewhat greater than the default of one. It 
is generally a good idea to provide a meaningful name for the test plan object to be 
created. The default is last.ADDTplan, but we will use AdhesiveBondB.ADDTplan. 
After providing the required and the desired inputs, click on Apply. The plan shown in 
Table 26 will be printed. 

 

 
Figure 170 Dialog box to generate a simple ADDT plan. 

 
 

      Weeks0 Weeks2 Weeks4 Weeks6 Weeks12 Weeks16 Weeks32 

50Temp     8      8      8      8      8       8       8 
60Temp     8      8      8      8      8       8       8 
70Temp     8      8      8      8      8       8       8 

Table 26 Simple test plan generated from the dialog in Figure 170. 

17.3  Modifying an ADDT test plan 
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The test plan generated in Section 17.2 (shown in Table 26) provides a convenient 
starting point for creating other test plans. The dialog box launched by using SPLIDA 
► Plan a destructive degradation (ADDT) test ► Modify an ADDT test 
plan, shown in Figure 171, allows the user to choose subsets of the rows or columns in 
the original plan and to change the allocations in the individual cells. First, one chooses 
an existing test plan object from those on the database. One option is to replace the 
original plan. Alternatively, the original plan can be left intact by specifying a new name 
for the modified plan. One can then choose a desired subset of the times and levels of the 
explanatory variables. 

 

Figure 171 Screen shot showing the modify ADDT plan dialog and the pop-up 
spreadsheet for editing allocations. 

As an alternative to the original plan, the allocations for cells on the extremes of the 
matrix (NW and SE corners) were set to zero (by editing the spreadsheet). It was thought 
that very little degradation would be observed early in the experiment at low 
temperatures and that too much degradation would have occurred by the end of the test at 
high levels of temperature.  Note that it is possible to add rows to the test plan matrix by 
editing the spreadsheet, but that to add a new column (time point) one must return to the 
dialog in Figure 170. It will also be of interest to add the inspection point at 32 weeks 
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(with 16 units at 50 degrees C) to see if this will improve estimation precision. Then, for 
comparison, the inspection at 32 weeks was de-selected on the dialog, so that the range of 
times would be the same as the original plan. 

17.4  Sample size for an ADDT test plan 
 
SPLIDA has a tool that allows the user to determine the sample size needed to produce a 
desired degree of estimation precision for a particular quantity of interest. The sample 
size depends on the specified planning values and corresponds to a given experimental 
layout, as defined by an ADDT plan object.  To use the sample use tool, use SPLIDA 
► Plan a destructive degradation (ADDT) test ► Sample size for an 
ADDT test plan to launch the sample size tool dialog shown in Figure 172. Choose the 
desired plan values object and test plan object (as in other dialogs, SPLIDA will 
remember and use as defaults the most recently created objects if they were created in the 
current session). Clicking on Apply will produce the plot in Figure 173.  

 

 
Figure 172 Dialog box for the ADDT sample size tool. 

We quantify the precision in terms of the “precision factor” R. When a confidence 
interval is computed for a positive quantity θ using the normal-approximation, it has the 
form ˆ ˆ ˆ[θ R,     θ/R] where θ× is the ML estimate of θ and R>1. Thus the upper endpoint of the 
confidence interval is 100(R-1)% larger than the estimate of θ and the lower endpoint is   
100(R-1)/R% smaller than the estimate of θ.  

The plot in Figure 173 gives the needed sample size as a function of the precision factor 
R for the test plan that includes the 32 Weeks inspection point. The precision factor 
reflects the width of the confidence interval that one can expect to achieve approximately 
50% of the times in repeated tests like the one being planned. The rectangle tool from the 
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annotate tool bar was used to mark the sample size needed to obtain a precision factor of 
R=1.5. The total required sample size is approximately 220. The computation assumes 
that the 220 units would be allocated in approximately the same proportion as the units in 
the  test plan matrix. The sample size is considerably larger than the original plan because 
of the desire for more precision (From Table 22, the original plan had an R factor of 
about 3179.3/1201.38=2.64 for the .05 quantile of the failure time distribution at 25 
degrees C). 

The sample size tool was also used for the test plan without the 32 Week inspection and a 
total sample size closer to 250 units would be required to achieve the same degree of 
precision. The needed sample size is, in general, highly dependent on the range of time 
and temperature, but not too dependent on the allocation within that range.  

 
 

 

 
Figure 173 Output for the ADDT sample size tool for the modified plan. 

17.5  Summarizing and evaluating an ADDT test plan 
 
To get a quick evaluation of the precision for a given test plan, use SPLIDA ► Plan 
a destructive degradation (ADDT) test ► Summarize, plot, and 
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evaluate an ADDT test plan to request the dialog box in Figure 174. By default, 
SPLIDA will evaluate the properties of the estimates of the .10, .50, and .90 quantiles of 
the failure-time distribution, but we have asked for .05, .5, and .95. As with the sample 
size tool, SPLIDA will remember the most recently created ADDT test plan and planning 
value objects, if they were created in the current S-PLUS session. Then clicking on Apply 
will produce the results in Table 27. 

 

 
Figure 174 Dialog box to obtain a summary and evaluation of a given ADDT plan 
for a given set of planning values. 
 
With a failure definition of 40 Newtons,  
the large sample approximate standard deviation 
of the 0.1  quantile at 25. DegreesC  = 442.3 Weeks and the  
corresponding 95% confidence precision factor of R= 1.8  
 
With a failure definition of 40 Newtons,  
the large sample approximate standard deviation 
of the 0.5  quantile at 25. DegreesC  = 851.3 Weeks and the  
corresponding 95% confidence precision factor of R= 1.861  
 
With a failure definition of 40 Newtons,  
the large sample approximate standard deviation 
of the 0.9  quantile at 25. DegreesC  = 1396 Weeks and the  
corresponding 95% confidence precision factor of R= 1.902  
 
 
Quantile ML estimate precision information 
 Quantile  Weeks     Ase R-Factor  
      0.1 1474.9  442.31   1.8000 
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      0.5 2685.4  851.28   1.8614 
      0.9 4255.8 1396.23   1.9022 

Table 27 Summary of the large-sample approximate standard errors and 
approximate precision factors for the modified test plan. 

17.6  Simulating an ADDT test plan 
The sample size and evaluation tools described in Sections 17.4 and 17.5, respectively, 
are useful for doing initial specification and evaluation of a proposed ADDT plan. It is 
useful, however, to supplement these tools by further evaluation of a test plan with 
simulation. 

Using SPLIDA ► Plan a destructive degradation (ADDT) test ► 
Simulate an ADDT test plan will bring up the dialog box in Figure 175. In this 
case, because SPLIDA remembered the most recent planning values object and test plan 
object, and because we entered the degradation-defining level and the use conditions into 
the planning values object, there is no addition required information that needs to be 
specified. In the Output options part of the dialog, one can choose the number of 
simulations to run. Because the simulations are computationally intensive, the number of 
simulations used in an initial evaluation should usually be small (20 is the default). For 
an accurate evaluation of test plan properties, at least 200 to 400 simulations should be 
used. It is also possible to request to see the results of the analyses for some of the 
individual simulated samples, and looking at four or five of these is useful.  

 

 
Figure 175 Dialog box to request a simulation of an ADDT plan. 

After clicking on Apply, the simulations will begin, with information being printed to 
indicate progress, including the amount of memory being used by S-PLUS (some 
versions of S-PLUS will require additional memory for each iteration and it is useful to 
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monitor this “buildup”). Figure 176 is an example of the graphical output for the analysis 
of one of the simulated samples. In some cases, after viewing several of the plots like 
Figure 176, it is useful to use the Modify plot axes page of the dialog in Figure 175 to 
“lock in” the minimum and maximum values of the y-axis of these plots. This makes it 
easier to compare visually the sample-to-sample variability in the estimates of the 
degradation model. 

 
Figure 176 Detailed view of one of the simulated ADDT data sets and ML estimates. 

After the final simulation, SPLIDA will make a simple summary plot like the one in 
Figure 177 of the ML estimates of the .05 quantile of the failure-time distribution as a 
function of temperature. The longer dark solid line is the .05 quantile line implied by the 
model and the planning values. The first quantile listed in the Figure 175 dialog is used 
as the quantile to be plotted in this summary plot. The shorter, lighter lines are the sample 
estimates of this quantile line. This plot provides an initial evaluation of the precision of 
estimates from the proposed ADDT plan and allows one to visualize the approximate 
width of confidence intervals for this quantile as a function of the explanatory variable 
(temperature in Figure 177).  

The simulation results also are saved in an object (the name of the object combines the 
names of the planning values object and the test plan object, but can be modified in the 
box Save results in of the dialog box shown in Figure 175). Then, using this object, 
other evaluations of the results of the simulation (e.g., focused on particular quantities of 
interest) can be done as described in the next section. In addition, the last simulated data 
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set is always saved as the degradation data object last.sim.ADDT.ddd. When in the test 
planning stage, it is sometimes useful to do a more complete analysis of such a data set, 
using the data analysis tools described in Section 16to get a better feeling for the 
characteristics of the results that might follow from a particular experimental program. 

 
Figure 177 Initial default summary of an ADDT plan simulation showing the true 
and estimates   of the .05 quantile from simulated accelerated tests, as a function of 
temperatures. 

17.7  Summarization of ADDT test plan simulation results 
 
The results of the simulations described in Section  17.6 are saved in a destructive 
degradation simulation results object. The results of the simulation can then be used to 
generate various summaries that focus on particular quantities of interest (especially 
characteristics of the failure-time distribution of the product or material under study). 
Using SPLIDA ► Plan a destructive degradation (ADDT) test ► 
Summarize ADDT test plan simulation results will launch a dialog box like the 
one in Figure 178.  In this dialog, one must first choose a simulation results object. Then 
there are various choices for graphical outputs (and in some cases there are 
corresponding tabular summaries are generated). First there are options to get three 
overall summary plots: a particular quantile of the failure-time distribution versus an 
accelerating variable, degradation versus time at the use conditions for the accelerating 
variable, and fraction failing versus time at the use conditions for the accelerating 
variable. The first option is the same plot given when the simulation is actually run (e.g., 
Figure 177), and so is not shown again. Examples of the other two plots, based on a 
simulation like that used in Section 17.6, but with 200 simulation trials, are given in 
Figure 179 and Figure 180, respectively. It is possible to control the axes of these plots 
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with the controls on the Modify plot axes dialog in Figure 178, if just one plot at a time 
is requested. Otherwise the Modify plot axes page of the dialog is inactivated. 

 

Figure 178 Dialog box to request additional evaluation(s) or the results of an ADDT 
simulation. 
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Figure 179 Simulation summarization giving 200 estimates of the relationship 
between strength (in Newtons) versus time (Weeks) at 25 degrees C. 
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Figure 180 Simulation summarization giving 200 estimates of fraction failing versus 
time (Weeks) at 25 degrees C. 

In addition to these summary plots, it is possible to request plots of the joint and/or 
marginal distributions of particular “focus quantities.”  Choose the “Focus quantities” 
page. Two different focus quantities can be chosen. The particular focus quantities can be 
the basic parameters of the model, a particular quantile of the failure-time distribution (at 
specified use conditions) or a probability of failure (for a specified time and use 
conditions). Figure 182, for example, shows the joint distribution and marginal 
distributions of the .05 quantile of the failure-time distribution at use conditions (25 
degrees C) and for a failure definition of 40 Newtons of strength. As with the simple 
summary plots described in Section 17.6, these summary plots allow one to visualize the 
repeated-sampling variability in estimates of quantities of interest and to approximately 
gauge the width of confidence intervals. 
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Figure 181 Focus quantities page of the Summarize ADDT simulation result dialog 
box 
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Figure 182 Simulation summarization giving the joint and marginal distributions of 
200 estimates of the .05 quantile of the failure-time distribution at the use conditions 
(25 degrees C) for the failure definition of 40 Newtons and the degradation path 
acceleration parameter β2. 
 

17.8 Planning an ADDT study with two accelerating variables 
 
This section shows how to use SPLIDA to plan a test for ADDT data with two 
accelerating variables.  Because of the similarity with the test planning methods for a 
single variable ADDT data described in Sections 17.1-17.7, we present an example and 
focus on concepts and tools that differ from those used in the single-variable planning. 
 
 

The Test Plan Problem and Preliminary Information 
 
We evaluate, perturb, and simulate a test plan for a temperature-humidity experiment to 
assess the reliability of an adhesive strength.  This experiment is similar to the 
experiment analyzed in Section 16.6 and the following planning information is available.  
Use the log transformation for the response and the square root transformation for the 
time.  The transformed data can be reasonable modeled with the normal distribution. The 
logarithm of the degradation rates can be modeled with the [Arrhenius, Humidity  (logit)] 
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relationship.  The failure definition is an adhesive strength below 25 Newtons.  There are 
216 units for testing, the test can last up to 32 weeks, but there is interest in evaluating a 
shorter 16 weeks long test. 
 
Specifying ADDT test planning information 
 
 To specify the planning information, use SPLIDA ► Plan a destructive 
degradation test (ADDT) ► Specify ADDT test planning information 
(planning values).  Choose normal for the distribution, Log for the “Transformation 
for the response,” and Square root for “ Transformation for time.”  Type in 2 for the 
“Number of accelerating variables,” Newtons for “Response units,” 25 for “Degradation 
level defining failure,” and 25,50 for “Use condition levels.” Edit the results object name 
in “Save results in” to read  AdhesiveBondD.Normal.ADDTpv.  Click on 
“Relationships” and choose Arrhenius for the  “Relationship 1” and RH for 
“Relationship 2.”  Select the “Parameters” dialog page and type in the parameter 
planning values as shown in Figure 183.   

 

Figure 183 Parameters page of the "Specify ADDT model information (planning 
values)" dialog box. 

In Figure 183, the entry  “ADDT beta2 values” refers to model parameters 2 3( , )β β .  The 
planning values for beta0, beta1, beta2, and sigma are obtained directly from Table 25.  
Similar to Section 17.1, we use as planning values, υ ,W  the slope of the log degradation 
rate at (50 DegreesC, 80% RH) rather than the planning value for 1β .  In this case, 

2 1 3 2υ  = β exp(β β )x x1 +W W W W  with 1x 11605 /(DegreesC 273.15),= − +  and 2x log[RH /(100 RH)]= −  
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where RH is expressed as a percent. For the example, the planning value for the slope at 
50 degrees C and 80% RH  is  equal to –2.0245e+009*exp(-
.6921*35.912+.2105*1.3863) = -0.0435.     
 

Generating an ADDT test plan 
 
To generate a test plan with duration of 32 weeks, use SPLIDA ► Plan a 
destructive degradation (ADDT) test ► Generate an ADDT test plan.  
Specify DegreesC and RH for the “Accelerating variable name(s).”  Click on “Choose 
levels,” enter 50, 60, 70 for “DegreesC” levels and click on “ OK.” Then enter 20, 80 for 
RH levels and click on “ OK” again. Specify Weeks for “Time units.”  Enter 0, 1, 2, 4, 6, 
8, 12, 16, and 32 for “Inspection times.”  Enter 4 for “Number of units per time/level 
combination.” Edit the name of the object under “Save results in” to read   
AdhesiveBondDLong.ADDTplan.   Click on “Apply.”   Then SPLIDA generates the 
plan given in Table 28; observe that the test is 32 weeks long and it has  216 
observations. 
 
                 Weeks0 Weeks1 Weeks2 Weeks4 Weeks6 Weeks8 Weeks12 Weeks16 Weeks32  

50DegreesC;20RH        4      4      4      4      4      4       4       4       4 

60DegreesC;20RH        4      4      4      4      4      4       4       4       4 

70DegreesC;20RH        4      4      4      4      4      4       4       4       4 

50DegreesC;80RH        4      4      4      4      4      4       4       4       4 

60DegreesC;80RH        4      4      4      4      4      4       4       4       4 

70DegreesC;80RH        4      4      4      4      4      4       4       4       4 

Table 28 A 32 week long ADDT test plan for the temperature-humidity study. 
 
Modification, sample size computations, and evaluation of the test plan. 
 
 After the ADDT test planning information AdhesiveBondD.Normal.ADDTpv and the 
test plan AdhesiveBondDLong.ADDTplan for the two accelerating variable have been 
defined, the modification, sample size computations, and evaluation of the test situation 
are very similar to one variable procedures described in Sections 17.3 to 17.5.  For 
example, 
To modify the test plan above such that the new test plan is only 16 weeks long with 4 
observations at each factor level combination, we proceed as in Section 17.3.  Use 
SPLIDA ► Plan a destructive degradation (ADDT) test ► Modify an 
ADDT test plan to open the “Modify accelerated destructive degradation test plan” 
dialog box. Then select AdhesiveDLong.ADDTplan for the “Choose test plan” and edit 
the name in “Save results in” to read something like AdhesiveDShort.ADDTplan.  Go to 
the “Time columns” window and unselect “Week32.” The dialog box should look like 
Figure 184.  Now click on Apply.  SPLIDA generates the modified plan given in Table 
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29.  One can also edit the plan to change the allocations to the different factor level 
combinations, the editing process is exactly as shown in Section 17.3.  
 

 
 

 

Figure 184  ADDT dialog to modify the 32 weeks long temperature-humidity ADDT 
plan 
 
                 Weeks0 Weeks1 Weeks2 Weeks4 Weeks6 Weeks8 Weeks12 Weeks16  
50DegreesC;20RH       4      4      4      4      4      4       4       4 
60DegreesC;20RH       4      4      4      4      4      4       4       4 
70DegreesC;20RH       4      4      4      4      4      4       4       4 
50DegreesC;80RH       4      4      4      4      4      4       4       4 
60DegreesC;80RH       4      4      4      4      4      4       4       4 
70DegreesC;80RH       4      4      4      4      4      4       4       4 

 
Table 29 A 16 weeks long ADDT temperature-humidity study. 
 

 
Simulation of the test plan. 
To simulate and evaluate the specified 32-week test plan , use SPLIDA ► Plan a 
destructive degradation (ADDT) test ► Simulate an ADDT test plan.  
SPLIDA remembers the most recent “Plan values object” and “Test plan object” if they 
were created in the current S-PLUS session.  Make sure that those object names agree 
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with the names you assigned in previous steps.  For this example, they are 
AdhesiveBondD.Normal.ADDTpv  and AdhesiveBondDLong.ADDTplan, respectively.  
Change “Number of simulations” from the default value 20 to 200 and “View detail for 
how many samples” to 0.  SPLIDA keeps the results of the simulation in the object listed 
under “Save results in,” keep track of this name for future reference, but edit the object 
name if you prefer a different name.  Then click Apply.  SPLIDA generates a figure (not 
shown here) similar to Figure 177.  

 

 

Figure 185 Dialog box to request the conditional plots of life versus accelerating 
variables. 
 
Now we use the simulation results to evaluate the test plan.  Use SPLIDA ► Plan a 
destructive degradation (ADDT) test ► Summarize an ADDT plan 
simulation.  Verify that that the name under “Use results in” agrees with the name 
given to the simulation results in a previous step.  Check the “Plot time vs stress” plot 
option.  Click on Apply and SPLIDA generates the conditional plots given in Figure 186 
and Figure 187.  Figure 186 is the conditional plot of life, the .10 quantile, as function of 
DegreesC with RH fixed at 50% according to the use conditions.  Similarly, Figure 187 is 
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the conditional plot of life versus RH when temperature is fixed at the use condition of 25 
Degrees.  These use conditions were specified as inputs for the simulation through the 
plan values object AdhesiveBondD.Normal.ADDTpv  
 

DegreesC
20 30 40 50 60 70

     1

    10

   100

  1000

 10000

100000

W
ee

ks

Accelerated destructive degradation test simulation based on
 AdhesiveBondDLong.ADDTplan AdhesiveBondD.Normal.ADDTpv 

Failure time 0.1 quantile vs DegreesC for failure definition 25 Newtons 
 Resp:Log,Time:Square root,x:Arrhenius ,Humidity 50, Dist:Normal

 

Figure 186 Conditional plot of life versus DegreesC when RH is fixed at 50% 
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Figure 187 Conditional plot of life versus RH versus DegreesC is fixed at 25. 

 
Additional simulation summaries for quantiles, failure probabilities, and model 
parameters estimates can be obtained using the “Focus quantities” page of the 
“Summarize ADDT simulation results” dialog box.  The steps to request those summaries 
are very similar to the ones described in Figure 181 of Section 17.7 and we don’t show 
them here. 
 
 

18 Special Models 
SPLIDA contains a collection of functions that were developed to allow a user who 
knows SPLUS programming to write additional S-PLUS functions that will allow one to 
relatively easily fit special models  to data. Dialogs have been developed to provide an 
interface to some of these models. Some other models are available only at the command 
line. Examples of these models can be found in the files echapter11.q and 
echapter11a.qof the SPLIDA folder. 

18.1 Generalized gamma distribution 
SPLIDA ► Special models ► Generalized gamma distribution launches the 
dialog in Figure 188. Presently, when launching this dialog, you will get a warning 
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message. This is because there is some change, especially with data with heavy 
censoring, that the likelihood will not be well behaved, and that there might be some 
problems with the algorithm that is trying to maximize the likelihood. Also, asking to do 
the profile plot for the lambda parameter will take a large amount of computer time. 

 

 
Figure 188 Dialog for fitting the generalized gamma distribution 

Figure 189 is a Weibull probability plot showing the generalized gamma MLE on 
Weibull probability paper and Figure 190 shows the profile plot for the λ parameter. 
Table 30 shows a summary of the ML estimates, because the confidence interval for λ  
contains the values 0 and 1, the data are consistent with both the Weibull and the 
lognormal distribution. 
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Figure 189 Weibull probability plot showing the ML estimate of the generalized 
gamma distribution fit to the Ball Bearing data. 
 

 

Figure 190 Profile plot of the generalized gamma distribution lambda parameter. 
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Table 30 Summary of the ML of the generalized gamma to the Ball Bearing data. 

18.2 Fit other special distributions 
SPLIDA ► Special models ► Generalized gamma distribution 

 

 
Figure 191 Dialog for requesting a comparison between the Birnbaum-Saunders 
and lognormal distributions on lognormal probability paper. 

 

Lieblein and Zelen Ball Bearing Failure Data   
Response units: Megacycles 
Extended Generalized Gamma Distribution 
Maximum likelihood estimation results 
 
Appears to have converged; relative function convergence   
 
Log likelihood at maximum point: -17.51  
  
              MLE Std.Err. 95% Lower 95% Upper  
    mu 4.2301  0.17705    3.8831    4.5771 
 sigma 0.5100  0.07934    0.3545    0.6655 
lambda 0.3076  0.54861   -0.7676    1.3829 
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Figure 192 Comparison of the ML estimates for the Birnbaum-Saunders and 
lognormal distributions on lognormal probability paper. 

18.3 Limited failure population model 
SPLIDA ► Special models ► Limited failure population model 

(not yet available in theGUI) 

 

18.4 Generalized (two failure modes) limited failure population model 
SPLIDA ► Special models ► Generalized (two failure modes) limited 
failure population model 

(not yet available in the GUI) 

 

18.5 Random fatigue limit model 
SPLIDA ► Special models ► Random fatigue limit model 

(not yet available in the GUI) 
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18.6 Two-dimensional warranty bivariate model 
SPLIDA ► Special models ► Two-dimensional warranty bivariate model 

(not yet available in the GUI) 

19 SPLIDA Tools 
This section describes some special tools that are available in SPLIDA. 

19.1 Delete SPLIDA objects 
 
As one uses SPLIDA, objects of different kinds are saved in the users workspace (folder 
SplidaUser, by default). These include data objects, analysis results objects, simulation 
results objects, etc. The amount of time it takes to launch or refresh some dialogs is 
proportional to the number of objects (because the list of objects must be searched to 
create lists for appropriate objects in the dialogs). Thus, especially if one notices 
bothersome slowdown, it is a good idea to delete unneeded objects from time to time. 
Although the S-PLUS object browser might be used for this purpose, using SPLIDA ► 
Special tools ► Delete SPLIDA objects will launch the dialog in Figure 193, 
allowing the user to choose the object type. This provides a listing of all objects of that 
type, from which the user can choose the particular object or objectss to delete. 
 
 

 
Figure 193 Dialog to allow deletion of selected SPLIDA objects 

19.2 Custom blank probability/relationship paper 
 
SPLIDA has powerful tools for creating special graphics that are useful in reliability data 
analysis. These plots have special nonlinear axes. These include probability plots with 
axes that linearize the cumulative distribution function, and relationship or model plots 
that linearize the relationship between a response (e.g. time to failure) and an explanatory 
variable (like temperature). SPLIDA allows the under to create blank plotting paper with 
these axes. These are useful for making plotting paper on which data can be plotted by 
hand. Alternatively, on could create a blank plotting page and then use S-PLUS 
commands to add additional information (e.g. plotted points) to the plot. Using SPLIDA 
► Special tools ► Custom probability paper will launch a dialog like that in 
Figure 194. 
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Figure 194 Dialog to request a blank Weibull probability plot. 

Several options, including requesting a grid (useful for plotting by hand or reading off numbers from a 
probability plot) and changes in the range of the axes have been exercised.  Clicking on Apply results in 
the plot in Figure 195. 
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Figure 195  Custom blank Weibull probability paper 

20 SPLIDA Setup and Operation 
SPLIDA is distributed as a self-extracting executable file SPLIDA.exe. When 
SPLIDA.exe is executed, a Winzip window like the one in Figure 196 appears and when 
the unzip option is chosen, Winzip creates a folder (c:\Splida by default) that 
contains other folders and files. This is known as the “SPLIDA folder.” A snapshot of the 
inside of this folder is given in Figure 197. 

 
Figure 196 Winzip window to extract SPLIDA 
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Figure 197 View inside the SPLIDA folder 

20.1 Simple setup for  SPLIDA 
To install a new version of SPLIDA over an existing version, you should always delete 
the old SPLIDA folder before unzipping the new SPLIDA folder. Generally, you should 
not have to make any manual changes in any SplidaUser folder (some automatic 
changes are made when a new version of SPLIDA is installed). 

The following description assumes that you are running Splus 6.2 and that it is installed 
in the default location C:\Program Files\Insightful\splus62\cmd. If you are using some 
other version if Splus (6.0 or higher), the approach is similar, but you should use the 
alternate shortcut. 

To install SPLIDA using default locations (the simple recommended setup): 

1. Move the SPLIDA.exe file to some location (like your Desktop) and double-click 
to execute the file. Do not change any defaults, but click on “Unzip” (see Figure 
196) to make the c:\Splida folder shown in Figure 197. You should get a message 
saying that xxx files have been unzipped (where xxx is 147 for the December 
2003 version of SPLIDA). 

2. Make a copy of the SPLIDAUser62 shortcut in a convenient place (e.g., the 
desktop). 
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3. Make a copy of the SPLIDAUser folder to C:\SPLIDAUser. This is the place 
where user-created objects will be stored. 

4. To complete the setup, click on the SplidaUser shortcut. This will bring up the 
warning in Figure 198. Click “OK.” S-PLUS will create a .Prefs folder in the 
SplidaUser folder and SPLIDA will create the SPLIDA menu items (this could 
take a few minutes).  

 

Figure 198 S-PLUS Invalid path warning 

 
When done, SPLIDA will be one of the items on the S-PLUS menu bar. To 
preserve the setup, exit S-PLUS and then again, click on the SplidaUser 
shortcut. 

 

5. SPLIDA is now ready for use. To test SPLIDA, from the S-PLUS menu bar use 
Splida ► Single distribution analysis ► Probability plot with 
parametric ML fit. Then choose life data object BearingCage.ld and 
distribution lognormal. Click "Apply." 

 
It may be desirable (on Windows 2000 and XP, where it is possible) to install SPLIDA in 
a write-protected folder to reduce any chance that files in the installed folder will become 
corrupted. 

 
 

20.2 Installing SplidaUser folders in other places or with other names 
Some S-PLUS users like to use separate startup folders for different projects, so that 
created objects do not get confused from one project to another. Similarly, if different 
users work on the same computer usually they would want to operate using separate S-
PLUS/SPLIDA startup files. If you copy a SplidaUser folder to other than C:\ or use 
a name other than SplidaUser for the folder, then the SplidaUsr62 shortcut 
properties must point to both the location of S-PLUS and the SplidaUser folder 

a. Make a copy of the SplidaUser folder  (do not just move it) in a convenient 
place (e.g., in c:\ or in a project folder elsewhere) and, if desired, give the folder a 
new name, say corresponding to a user’s name or a project name. 
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b. Make a copy of the SplidaUsr62 shortcut (do not just move it) in a convenient 
place (e.g., the desktop) and, if desired, give the shortcut a new name. 

 
c. Right-click on the shortcut, choose properties, and go to the shortcut tab. On the 

right-hand side of the target line, edit the S_PROJ="C:\SplidaUser" so that it 
points to the location of your particular SplidaUser folder (or what ever name 
the folder now has) and its location. 

 

20.3 Installing Splida in another place 
  
In some cases, it may be necessary to install the Splida folder (as it is called now) in a 
place other than C:\. This can be done by changing the Winzip option to some other 
location (e.g., D:\Program Files\Splida). If the SPLIDA folder is installed in a 
place other than the default c:\SPLIDA, the file Path.txt in any SplidaUser folder 
should be modified (e.g., using Notepad) to point to the chosen location of SPLIDA. 
Again, may be desirable to install SPLIDA in a write-protected folder to reduce any 
chance that files in the installed folder will become corrupted. 

 

An alternative to using the Path.txt file to identify the location of SPLIDA is to set an 
environmental variable in Windows. In particular SplidaHome should be set to the 
SPLIDA path (e.g., D:\Program Files\Splida). Doing this is particularly useful 
if you move a SplidaUser folder from one computer to another and have SPLIDA 
located in different places on those computers. 

 

20.4 Modifying the shortcut when S-PLUS is installed in other than the default 
location 

  
If S-PLUS is installed somewhere other than the default location for S-PLUS 6.2 (i.e., 
C:\Program Files\Insightful\splus62\cmd), the SplidaUsr62 shortcut 
provided with the distribution must be modified to point to the actual location of S-
PLUS. Right-click on the shortcut, choose properties, and go to the shortcut tab. Edit the 
target line so that the first part points to S-PLUS (looking at an existing shortcut to S-
PLUS will show how to do this). Make sure that the right-hand side of the target line still 
points to the SplidaUser folder (S_PROJ="C:\SplidaUser"  by default).    
 

 

20.5 Creating a SPLIDA/S-PLUS shortcut from scratch 
 For most purposes, the SplidaUsr62 shortcut (perhaps modified as described in 
Sections 20.2 or 20.4) provided with the SPLIDA distribution should be all that is 
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needed. For completeness, however, we describe how to create such a shortcut from 
scratch.  
 
Copy or create a new shortcut to S-PLUS. Use right-click New ► Shortcut to bring 
up the Windows Shortcut Wizard. Browse to the location of SPLUS and select 
SPLUS.exe (C:\Program Files\Insightful\splus62\cmd\SPLUS.exe for S-PLUS 6.2. Click 
next and choose a name for the shortcut (e.g. SplidaProjX). Then click Finish. This 
creates a standard S-PLUS shortcut. Now to make it into a SPLIDA shortcut, right click 
on the new shortcut and choose "properties" under "shortcut." Set S_PROJ on the 
"Target" command line (note: do this on the "Target" and not"Start in" command line) of 
this shortcut to read:  
 
  " C:\Program Files\Insightful\splus62\cmd\SPLUS.exe "   S_PROJ="c:\SplidaUser" 
 
where " C:\Program Files\Insightful\splus62\cmd\SPLUS.exe " is the existing path to S-
PLUS 6.2 and depends on the version of S-PLUS and the option used when S-PLUS was 
installed. Do not change the first part. Only add the S_PROJ="c:\Splida" to the end 
of the line.  Make sure there is at least one space  before the 
S_PROJ="c:\SplidaUser". After typing the S_PROJ="c:\SplidaUser", click 
on “apply” and “Close.” 
 

20.6 Manually making or remaking the SPLIDA menu structure and startup 
(.Prefs) folder  

SPLUS uses a .Prefs folder to define user preferences and the graphical under 
interface (GUI). When you attempt to use S-PLUS in a target folder that does not contain 
either the .Prefs or the _Data folder, they are generally created automatically by S-
PLUS (S-PLUS first asks if you want to do this). At the time of distribution, the 
SplidaUser folder does not contain .Prefs folders, but it is created in the setup 
described in 20.1. This is because each version/release of SPLUS may have a different 
.Prefs. SPLUS will generate the .Prefs folder automatically, appropriate for your 
version of SPLUS if a .Prefs folder is not detected in your SplidaUser folder. 
When SPLIDA is started, it will make the necessary changes to install or update (after 
you install a new version of SPLIDA over an older version)..   

If you are using the “professional” version of S-PLUS and, for some reason, you would 
like to regenerate the SPLIDA .Prefs folder from scratch, you can follow the 
following steps (you need the Professional version of S-PLUS to do this):  

a. Delete the .Prefs folder in the SPLIDA target folder. 
b. Fire up S-PLUS using a shortcut that points to the target folder (e.g., 

SplidaUser). 
c. When S-PLUS warns you that .Prefs and/or .Data are missing, click OK. 

At the command line, give the command CreateSplidaPrefs(). 

Depending on the speed of your processor, it may take from 1 to 3 or 4 minutes to 
complete and you will see something like the following output: 
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20.7 Comments on using SPLIDA (and S-PLUS) on Windows 
 
a. If S-PLUS seems to be hanging or taking too long to execute, you can sometimes 

type <ESC> to break out of a command. 
b. If graphics window becomes corrupted, kill the graphics window (by clicking the 

x in the upper right-hand corner of the graphics window). A fresh graphics 
window will be started. It is also necessary to do this to make newly-selected 
graphics options (e.g., switching from color to black and white) take effect. 

c. As you use S-PLUS over time, memory usage can build up, and it may be 
necessary (especially if you are only working with 128MB or less memory) to 
restart S-PLUS. The command check.memory( ) will allow you to monitor this. If 
you can afford it, install more memory. We have noticed a big improvement when 
going from 128MB to 512 MB, and now we use 256 MB or better. If you run 
short on memory and are using an old version of Windows (98 or ME), S-PLUS 
may hang, Windows can crash, and it may be necessary to reboot your machine. 

21 Outline of the SPLIDA Menu Structure 
 
The following table contains an outline of the SPLIDA menu structure. The GUI dialogs 
for the items shown in regular-faced type are still in development. 

SPLIDA ►  
Make/summary/view data object ► 

Make a life data object  
Make recurrence (point-process) data object  
Make degradation (repeated measures) data object  
Summary/view a data object  
Edit a life data object 

Plan single distribution study ►  
Specify life test planning information (planning values)  

SPLIDA Version xxx 

Loading advanced SPLIDA life data analysis symbols. 

Advanced SPLIDA life data analysis symbols successfully dyn.loaded.  

Removing the old SPLIDA menu structure. 

SPLIDA menu was not detected---nothing to remove. 

Remaking all of the SPLIDA GUI properties and dialogs---wait. 

Finished remaking all of the SPLIDA GUI properties and dialogs. 

Remaking the SPLIDA menus. 

Done remaking the SPLIDA GUI. 

You should exit and restart S-PLUS now, in order to preserve the changes. 
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Plot life test planning information (planning values)  
Plot of approximate required sample size 
Simulate a life test  
Probability of successful demonstration 

Single distribution life data analyses ►  
Plot nonparametric estimate of cdf and confidence bands 
Probability plot with nonparametric confidence bands  
Probability plot with parametric ML fit  
Compare distribution ML fits on probability plot  
Likelihood contour plot and confidence intervals 
Bootstrap confidence intervals 
Threshold parameter probability plot with parametric ML fit  

Single distribution Bayes analysis life data analyses ►   
Specify a prior distribution 
Make a posterior distribution 
Summarize a posterior distribution  

Multiple failure mode life data analysis ► 
Individual modes 
Combined modes (with one or more omitted) 
Make life data objects for individual modes 

Comparison of distributions life data analysis ► 
Probability plot and ML fit: different shapes (slopes)  
Comparison likelihood contour plot 
Probability plot and ML fit: common shapes (slopes)  
Make life data objects for individual groups  
Probability of correct selection for specified test plans 

 Plan an accelerated life test (ALT) ►  
Specify an ALT model information (planning values)  
Specify an ALT test plan  
Plot, summarize, and evaluate an ALT test plan 
Simulate an ALT test 

Simple regression (ALT) data analysis ►  
Censored data scatter plot 
Probability plot and ML fit for individual conditions  
Prob plot and ML fit for indiv cond: common shapes 

(slopes)  
Probability plot and ML fit of a regression (acceleration)  
Make life data objects for individual groups  

Multiple regression (ALT) life data analysis ►  
Censored data pairs plot  
Censored data scatter plot 
Probability plot and ML fit for individual conditions  
Prob plot and ML fit for indiv cond: common shapes 

(slopes)  
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Probability plot and ML fit of a regression (acceleration)  
Conditional model plot  
Sensitivity analysis plot  
Make life data objects for individual groups  

Regression residual analysis ►  
Residuals versus fitted values  
Residuals  versus possible explanatory variables  
Residuals versus observation order 
Residual probability plot  

Recurrence (point process) data analysis ►  
Recurrence event plot 
Mean cumulative function plot 
Compare two mean cumulative functions plot 
Convert renewal recurrence data to life data 

Degradation (repeated measures) data analysis ►  
Degradation data plot  

   Degradation data trellis plot  
Accelerated degradation cell-average plot 

   Convert/extrapolate degradation data to life data  
   Degradation residual plot 

Destructive degradation data (ADDT) analysis ► 
Scatter plot of ADDT data  
Scatter plot and ML fit for individual conditions 
Scatter plot and ML fit of a regression (acceleration) model 
Residual analysis 

Plan a destructive degradation (ADDT) test ► 
Specify ADDT test planning information (planning values)  
Generate an ADDT test plan 
Modify an ADDT test plan  
Sample size for an ADDT test plan 
Summarize, plot, and evaluate an ADDT test plan 
Simulate an ADDT test plan 
Summarize ADDT test plan simulation results 
 

Special models ►  
Generalized gamma distribution 
Fit other special distributions 
Limited failure population (LFP) model  
Dead on arrival (DOA) population model 
Generalized (two failure modes) limited failure population 

model 
Random fatigue limit (RFL) model 
Two-dimensional warranty bivariate model 

Change SPLIDA default options (preferences) 
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d.  

22 SPLIDA Data Set Index 
 

This Chapter describes the source and, when not included in Meeker and Escobar (1998), 
a little background for some of the data sets supplied with SPLIDA. The first part of the 
file does this by data set name. The second is organized according to the numbered 
Examples and Exercises in Meeker and Escobar (1998, page 684), making it easy to find 
data sets used in that book (if the name is not obvious). 

 

Complete references not given below (e.g. Nelson 1982) are given at the end of Meeker 
and Escobar (1998). Also see the "Examples" entry in the index of Meeker and Escobar 
(1998). 

 

AlloyC.txt  Meeker and Escobar (1998), Example 11.16, page 276. 

 

Appliance01.txt  Nelson (1982) page 121 

 

BearingCage.txt  Abernethy, Breneman, Medlin, and Reinman, (1983) also Meeker 
and Escobar (1998), Example 10.12, 12.10, 14.1, 14.2, 14.3, 14.4, 14.5 

 

Concrete.txt  Holmen (1979), analyzed in Castillo and Hadi (1995) and discussion of 
Pascual and Meeker (1999) 

 

ConnectionStrength.txt  Nelson (1982), page 111. 

 

DeviceA.txt  Hooper and Amster (1990) and also Meeker and Escobar (1998), 
Examples 12.9, 19.1, 19.2, 19.3, 19.4, 19.5, 19.6, 19.7, 19.8, 19.9 

 

DeviceB.txt  Meeker, Escobar, and Lu (1998) also Meeker and Escobar (1998), Chapter 
21 

 

DeviceC.txt  Meeker, Unpublished ALT data use in Meeker and Escobar (1998), 
Exercise 19.2 
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DeviceG.txt  Meeker and Escobar (1998), Example 15.6, page 383 

 

DeviceH.txt  Doganaksoy, Hahn, and Meeker (2000) 

 

DiskBer.txt  Murray (1993) and also Meeker and Escobar (1998), Exercise 13.9 

 

Fan.txt  Nelson (1982), pages 133, 318 and also Meeker and Escobar (1998), 
Examples 7.12, 7.13, 11.3, 11.17 

 

GaAsLaser.txt  Meeker and Escobar (1998), Example 13.10 

 

HeatExchanger.txt  Meeker and Escobar (1998), Example 3.1, 3.2, 3.3, 

3.4, 3.6, 3.11, 6.4, 9.8, 9.9, 9.10, 9.11 

 

LaminatePanel.txt  Shimokawa and Hamaguchi~(1987) and also Pascual and Meeker 
(1999) 

 

LocomotiveControl.txt  Nelson (1982), page 33 

 

MachineH.txt  Meeker and Escobar (1998), Example 16.6 

 

MetalWear.txt  Meeker and Escobar (1998), Example 21.6 

 

NiCdBattery.txt  Brown and Mains (1979) and Meeker and Escobar (1998), 
Example 1.9 

 

NewSpring.txt  Meeker, Escobar, and Zayac  (2003), A factorial experiment to 
compare the life times of springs as a function of a processing temperatire and amount of 
displacement in the spring test (stroke). 

 

PartA.txt  Unpublished Meeker (1999) An experiment to compare the life times of 
units tested by three different operators. 

 

PhotoDetector.txt  Weis et al. (1986), also Meeker and Escobar (1998), Exercise 3.12 
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PrintedCircuitBoard.txt  Meeker and LuValle (1995), and also Meeker and Escobar 
(1998), Examples 1.8 and and 18.7 

 

RepairTimes.txt  Unpublished Meeker (1997) Recorded times to repair a particular 
kind of electronic system, without regard to failure mode. 

 

RocketMotor.txt Olwell, D. H. and Sorell, A. A. (2001) 

 

ShockAbsorber.txt  O'Connor (1985), also Examples 3.8, 3.9, 3.10, 6.3, 8.1, 8.3, 8.4, 
8.5, 8.6, 8.7, 8.8, 8.10, 8.11, 8.12, 8.13, 8.14, 8.15, 9.4, 9.5, 9.6, 9.7, 9.12 from Meeker 
and Escobar (1998) 

 

Snubber.txt  Nelson (1982) also Meeker and Escobar (1998) Examples 

17.13, 17.14, 17.15 

 

TurbineDevice.txt  Unpublished Meeker (1999) 

 

ValveSeat.txt  Nelson, W. (1995a) also Meeker and Escobar (1998), Examples 16.3, 16.4 

 

WorkStation.txt  Meeker and Escobar (1998), Exercise 16.1 

 

ZelenCap.txt  Zelen (1959) also Meeker and Escobar (1998), Example 17.11 

 

at7987.txt  Meeker and Escobar (1998), Examples 6.2, 6.6, 6.7, 11.18 

 

berkson10220.txt  Berkson (1966) also Meeker and Escobar (1998), Examples 7.1-
7.4 

 

berkson20.txt  Berkson (1966) also Meeker and Escobar (1998), Examples 7.1-7.4 

 

berkson200.txt  Berkson (1966) also Meeker and Escobar (1998), Examples 7.1-
7.4 
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berkson2000.txt  Berkson (1966) also Meeker and Escobar (1998), Examples 7.1-
7.4 

 

bkfatigue10.txt  Bogdanoff and Kozin (1985) also Meeker and Escobar (1998), 
Example 11.4 

 

bleed.txt  Abernethy, Breneman, Medlin, and Reinman (1983) also Meeker and 
Escobar (1998), Example 6.9 

 

bulb.txt  Davis (1952) and  Nash (19xx) 

 

cirpack5.txt  Hooper and Amster (1990), Table 8.2 

 

cirpack6.txt  Meeker and Escobar (1998), Table 1.3, Example 1.3, 11.8 

 

comptime.txt  Meeker and Escobar (1998), Example 17.1, 17.3, 17.4, 17.5, 17.6, 17.7 

 

cylinder.txt  Nelson and Doganaksoy (1989) also Meeker and Escobar (1998), 
Example 16.5 

 

doatrun.txt Meeker (1996), unpublished Data are truncated because an unknown 
number of DOA's were removed from the data set. 

 

electro_mech.txt  Hahn and Meeker (1982a) 

 

grampus.txt  Lee (1980) and also Ascher, H., and Feingold, H. (1984) also Meeker and 
Escobar (1998), Examples 16.9, 16.10, 16.11, 16.12 

 

grids1.txt  Doganaksoy, N., and Nelson, W. (1998) also Meeker and Escobar (1998), 
Example 16.7 

 

grids2.txt  Doganaksoy, N., and Nelson, W. (1998) also Meeker and Escobar (1998), 
Example 16.7 
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halfbeak.txt  Ascher, H., and Feingold, H. (1984) also Meeker and Escobar (1998), 
Example 16.7 

 

icdevice02.txt  Meeker and Escobar (1998), Example 19.11 

 

inconel.txt  Shen (1994) also Pascual and Meeker (1999) 

 

lfp1370.txt  Meeker (1987) also Meeker and Escobar (1998), Examples 3.5, 11.5, 11.6, 
11.7 

 

lzbearing.txt  Lieblein and Zelen (1956), also Lawless (1982) and Meeker and Escobar 
(1998), Examples 1.1, 6.8, 8.16, 11.1, 11.2, 12.2, 12.3, 12.4, 12.5, 12.6 

 

muliple_fail_classh.txt  Nelson (1990), page 32 

 

mylarpoly.txt  Kalkanis and Rosso (1989) also Meeker and Escobar (1998),  Examples 
18.5, 19.10 

 

piccioto.txt  Picciotto (1970) 

 

piccioto_sub.txt  subset of data in piccioto.txt 

 

Resistor.txt  Suzuki, Maki, and Yokogawa (1993) also Meeker and Escobar (1998), 
Example 18.2 and Table C.3 

 

 

superalloy.txt  Nelson (1990) also Meeker and Escobar (1998), Examples 17.2, 17.8, 
17.9, 17.10 

 

tantalum.txt  Singpurwalla, Castellino, and Goldschen (1975) also Meeker and Escobar 
(1998), Examples 19.11, 19.12 

 

titanium.txt 
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titanium01.txt  Meeker and Escobar (1998), Exercise 6.7 

 

turbine.txt  Nelson (1982) also Meeker and Escobar (1998), Examples 1.7, 3.x 

 

v7tube.txt  Davis (1952) also Meeker and Escobar (1998), Example 1.6, 6.10 

 

Meeker and Escobar (1998) examples and exercises using data 

 

Example 1.1 lzbearing.txt 
Example 1.2 lfp1370.txt 
Example 1.3 cirpack6.txt 
Example 1.4 Fan.txt 
Example 1.5 HeatExchanger.txt 
Example 1.6 v7tube.txt 
Example 1.7 turbine.txt 
Example 1.8 PrintedCircuitBoard.txt 
Example 1.9 NiCdBattery.txt 
Example 1.10 AlloyA.txt 
Example 3.1 HeatExchanger.txt 
Example 3.2 HeatExchanger.txt 
Example 3.3 HeatExchanger.txt 
Example 3.4 HeatExchanger.txt 
Example 3.5 lfp1370.txt 
Example 3.6 HeatExchanger.txt 
Example 3.7 HeatExchanger.txt 
Example 3.8 ShockAbsorber.txt 
Example 3.9 ShockAbsorber.txt 
Example 3.10 ShockAbsorber.txt 
Example 3.11 HeatExchanger.txt 
Example 3.12 
Example 3.13 turbine.txt 
Example 6.2 at7987.txt 
Example 6.3 ShockAbsorber.txt 
Example 6.4 HeatExchanger.txt 
Example 6.5 turbine.txt 
Example 6.6 at7987.txt 
Example 6.7 at7987.txt 
Example 6.8 lzbearing.txt 
Example 6.9 bleed.txt 
Example 6.10 v7tube.txt 
Example 7.3 berkson20.txt 
Example 7.12 Fan.txt 
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Example 7.14 Fan.txt 
Example 8.1 to 8.16 ShockAbsorber.txt  
Example 8.16 lzbearing.txt 
Example 9.1-9.3  berkson20.txt  
Example 9.4-9.7  ShockAbsorber.txt 
Example 9.5 ShockAbsorber.txt xt 
Example 10.12 BearingCage.txt 
Example 11.1-11.2 lzbearing.txt 
Example 11.3 Fan.txt 
Example 11.4 bkfatigue10.txt 
Example 11.5-11.7 lfp1370.txt  
Example 11.8 cirpack6.txt 
Example 11.9 Life Data? 
Example 11.10 Kalbfleisch and Lawless (1992) 
Example 11.11 cirpack6.txt 
Example 11.16 AlloyC.txt 
Example 11.17 Fan.txt 
Example 11.18 at7987.txt 
Example 12.2-12.8 lzbearing.txt  
Example 12.9 AlloyA.txt 
Example 12.10 BearingCage.txt 
Example 13.1 AlloyA.txt 
Example 13.6 AlloyA.txt 
Example 13.9 AlloyA.txt 
Example 14.1-14.10 BearingCage.txt  
Example 15.3 
Example 15.6 DeviceG.txt 
Example 16.1 grampus.txt 
Example 16.2-16.4 ValveSeat.txt  
Example 16.5 cylinder.txt 
Example 16.6 MachineH.txt 
Example 16.7 grids1.txt, grids2.txt 
Example 16.8 grids1.txt, grids2.txt 
Example 16.9-16.11 grampus.txt  
Example 16.12  halfbeak.txt 
Example 17.1  comptime.txt 
Example 17.2  superalloy.txt 
Example 17.3-17.7 comptime.txt  
Example 17.8-17.10 superalloy.txt  
Example 17.11-17.12 ZelenCap.txt  
Example 17.13-17.14 Snubber.txt  
Example 18.1 
Example 18.2  resistor.txt 
Example 18.5  mylarpoly.txt 
Example 18.7  PrintedCircuitBoard.txt 
Example 19.1-19.12 DeviceA.txt  
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Example 19.10 mylarpoly.txt 
Example 19.11 icdevice02.txt 
Example 19.12 icdevice02.txt 
Example 20.1 
Example 21.1 DeviceB.txt 
Example 21.2 DeviceB.txt 
Example 21.3 DeviceB.txt 
Example 21.4 DeviceB.txt 
Example 21.5 DeviceB.txt 
Exercise 19.2   DeviceC.txt 
 

Data references not in Meeker and Escobar (1998) 
 

1. Doganaksoy N., Hahn, G. J., and Meeker, W. Q. (2000), Product life analysis: a 
case study, Quality Progress, June 2000. 

2. Doganaksoy, N., and Nelson, W. (1998) “A Method to Compare Two Samples of Recurrence 
Data,” Lifetime Data Analysis 4, 51-63. 

3. Pascual, F.G. and Meeker, W.Q. (1999), Estimating Fatigue Curves with the 
Random Fatigue-Limit Model (with discussion). Technometrics 41, 277-302. 

4. Roberto, Picciotto (1970) “Tensile Fatigue Characteristics of a Sized 
Polyester/Viscose Yarn and Their Effect on Weaving Performance. A thesis 
submitted to the Graduate Faculty of North Carolina State University at Raleigh 
in partial fulfillment of the requirements for the Degree of Master of Science. 
Department of Textile Technology. 

5. Shen, C. L. (1994), “Statistical Analysis of Fatigue Data,'” unpublished Ph.D. 
dissertation, University of Arizona, Department of Aerospace and Mechanical 
Engineering. 

6. Shimokawa, T., and Hamaguchi, Y. (1987), ``Statistical Evaluation of Fatigue 
Life and Fatigue Strength in Circular-Holed Notched Specimens of a Carbon 
Eight-Harness Satin/Epoxy Laminate,'' in  Statistical Research on Fatigue and 
Fracture (Current Japanese Materials Research, Vol. 2), eds. T. Tanaka, S. 
Nishijima, and M. Ichikawa, London: Elsevier, pp. 159-176. 

7. Castillo, E. and Hadi, Ali S., (1995) Modeling lifetime data withapplication to 
fatigue models, Journal of the American Statistical Association, 90, 1041-1054 

8. Olwell, D. H. and Sorell, A. A. (2001), Proceedings of the 2001 Annual 
Relaibility and Maintanability Symposium. 
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